
MULTIFUNCTIONAL DIGITAL COLOR SYSTEMS / 
MULTIFUNCTIONAL DIGITAL SYSTEMS

Printing Guide
ES9160 MFP/ES9170 MFP
ES9460 MFP/ES9470 MFP
CX3535 MFP/CX4545 MFP



©2012 Oki Data Corporation All rights reserved
Under the copyright laws, this manual cannot be reproduced in any form without prior written permission of Oki Data.



Preface    1

Preface

Thank you for purchasing Oki Data Multifunctional Digital Systems. Also this guide describes instructions on how to set up 
the printer drivers required for this equipment, and how to print with them. Read this manual before using your 
Multifunctional Digital Systems. Keep this manual within easy reach, and use it to configure an environment that makes 
best use of the OKI MFP's functions.

How to read this manual

 Symbols in this manual
In this manual, some important items are described with the symbols shown below. Be sure to read these items before 
using this equipment.

Other than the above, this manual also describes information that may be useful for the operation of this equipment with 
the following signage:

 Screens and Operation Procedures
 Illustrations for the control panel and the touch panel shown in this manual are those of the ES9460 MFP/ES9470 

MFP/CX3535 MFP/CX4545 MFP. The shape and location of some buttons on the control panel and the dimension of 
the touch panel of the ES9160 MFP/ES9170 MFP differ from those of other series, however, the names and functions 
of the buttons and parts are the same.

 In this manual, the screens and the operation procedures in Windows are described for Windows 7.
The details on the screens may differ depending on how the equipment is used, such as the status of the installed 
options, the OS version and the applications.

 If you use Windows Server 2008 R2, refer to the operation procedure for Windows 7, though the screens or the menu 
names, etc. may differ.

 In this manual, the screens and the operation procedures in Macintosh are described for Mac OS X 10.2.x and Mac 
OS X 10.6.x.
The details on the screens may differ depending on how the equipment is used, such as the status of the installed 
options, the OS version and the applications.

 In this manual, the initial values of the setting items are underlined.

Indicates a potentially hazardous situation which, if not avoided, could result in death, serious 
injury, serious damage, or fire in the equipment or surrounding assets.

Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate 
injury, partial damage to the equipment or surrounding assets, or loss of data.

Indicates information to which you should pay attention when operating the equipment.

Describes handy information that is useful to know when operating the equipment.

Pages describing items related to what you are currently doing. See these pages as required.
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 Trademarks
 The official name of Windows XP is Microsoft Windows XP Operating System.
 The official name of Windows Vista is Microsoft Windows Vista Operating System.
 The official name of Windows 7 is Microsoft Windows 7 Operating System.
 The official name of Windows Server 2003 is Microsoft Windows Server 2003 Operating System.
 The official name of Windows Server 2008 is Microsoft Windows Server 2008 Operating System.
 Microsoft, Windows, Windows NT, and the brand names and product names of other Microsoft products are 

trademarks of Microsoft Corporation in the US and other countries.
 Apple, AppleTalk, Macintosh, Mac, Mac OS, Safari, and TrueType are trademarks of Apple Inc. in the US and other 

countries.
 Adobe, Acrobat, Reader, and PostScript are either registered trademarks or trademarks of Adobe Systems 

Incorporated in the United States and/or other countries.
 Mozilla, Firefox and Firefox logo are trademarks or registered trademarks of Mozilla Foundation in the U.S. and other 

countries.
 IBM, AT and AIX are trademarks of International Business Machines Corporation.
 NOVELL, NetWare, and NDS are trademarks of Novell, Inc.
 Other company and product names given in this manual or displayed in this software may be the trademarks of their 

respective companies.
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Features and Functions

Extensive Client Platform Support
This equipment supports printing from IBM-compatible PC, Macintosh, and UNIX/Linux workstations. Not all features are 
supported on all platforms, however.

Various Port Options
You can map this equipment to print to an SMB, IPP, Raw TCP, WSD, or LPR port.

Multiple Job Types
Job Types refer to the way this equipment handles a print job.
 The Normal mode requires no special handling and is the most frequently used printing mode.
 Scheduled Print lets you specify the time and date at which to print a job.
 The Private Print mode allows you to hold a job in the print queue until you enter a password at the copier touch panel 

to print the job.
 The Hold Print mode allows you to hold a job in the hold queue until you continue the job from the touch panel.
 The Proof Print mode prints the first copy of a multi-copy job and then awaits your approval before printing the 

remaining copies.
 Overlay File prints a document element, such as text or graphics, to a file for superimposing on the background of 

other documents.
 The Store to e-Filing mode allows you to store the printed document in e-Filing.
 The Multiple Job Type feature allows you to print jobs of more than one type together. For example, you can store a job 

in the specified e-Filing and print it at the specified time by combining Scheduled Print and Store to e-Filing. 

Professional Finishing Options
Depending on the type of finishing units you have installed on this equipment, you can choose to sort, group, fold and 
staple your documents (including saddle-stitching) and punch binding holes.

Sophisticated Document Layout and Assembly Options
You can choose whether to print your document as you have set it up in the application, or to impose printer-driven 
document layout options such as printing in Book Format or printing Multiple Pages per Sheet.
Additionally, the printer drivers provide the ability to print selected pages on different media. This includes printing front 
and back covers, inserting sheets at predefined positions within the document, or interleaving pages so that every other 
page is inserted blank or printed on a different type of media.

Various Sizes of Printing Paper Available
You can use paper larger than the standard sizes defined in the custom paper size setting when you print data created 
with applications.

Watermark and Image Overlay Support
Watermarks are a great way to subtly convey useful information about your printed documents. Common watermarks are 
“Confidential,” “Draft,” and “Original.” Several watermarks have been pre-defined for use with your documents, or you can 
create and save your own custom watermarks.
Watermarks consist of text. Image Overlays can be any combination of text, graphics or other document elements.
Printing watermarks consumes fewer resources than using Image Overlays, so you should use watermarks wherever 
possible, particularly when printing speed is an issue.
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About Printer Drivers

Printer drivers required for each OS are included in the Client Utilities CD-ROM. For instructions on how to install them, 
refer to the Software Installation Guide.

 For Macintosh
Printer drivers required for Macintosh OSs are included in the following folders of the Client Utilities CD-ROM:

Macintosh PPD files
 [Client Utilities CD-ROM]: MacPPD: OSX

This includes the PPD files to enable printing from Macintosh on the Mac OS X 10.2.4 to 10.3.X and Mac OS X 10.4 to 
10.7.x, and the plug-in file to enable printing from Mac OS X 10.4 to 10.7.x.

 For UNIX/Linux
Printer drivers required for UNIX/Linux are included in the following folders of the Client Utilities CD-ROM:

Solaris filter
The tar file for Solaris v2.6/2.7/7.8/8/9/10 is included in the following folder:
Choose the appropriate file depending on the model to be used.
 [Client Utilities CD-ROM]/Admin/SolarisFilter/Usa/

HP-UX filter
The tar file for HP-UX ver.10.20/11.x and HP-UX64 ver.11.31 is included in the following folder:
Choose the appropriate file depending on the model to be used.
 [Client Utilities CD-ROM]/Admin/HP-UXFilter/Usa/

AIX filter
The tar file for AIX 4.3.3 is included in the following folder:
Choose the appropriate file depending on the model to be used.
 [Client Utilities CD-ROM]/Admin/AIXFilter/Usa/

Linux filter
The tar file for Red Hat 7.x/8.x/9.x, Red Hat Enterprise WS2, SuSE Linux 7.x/8.x/9.x, Mandrake Linux 7.x/8.x/9.x and 
Turbolinux 8/10 is included in the following folder:
Choose the appropriate file depending on the model to be used.
 [Client Utilities CD-ROM]/Admin/LinuxFilter/Usa/

SCO UNIX filter
The tar file for SCO UnixWare 7 and SCO Open UNIX 8 is included in the following folder:
Choose the appropriate file depending on the model to be used.
 [Client Utilities CD-ROM]/Admin/OpenUnixFilter/Usa/

CUPS PPD file
The PPD file to enable printing from CUPS is included in the following folder:
Choose the appropriate file depending on the model to be used.
 [Client Utilities CD-ROM]/Admin/CUPS/Usa/2-sided_default/

This PPD file enables to set 2-sided printing by default.
 [Client Utilities CD-ROM]/Admin/CUPS/Usa/normal/

This PPD file enables to set 1-sided printing by default.
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Before Using the Printer Driver

Before printing, you have to configure the following options:
 Configuration Settings

To use optional devices such as optional drawers, the Finisher or Hole Punch Unit, you must first configure these 
devices. The features of these optional devices are not available unless you inform the system that the optional 
devices are installed.

Before printing, you can configure the following option if necessary:
 Department Code

You can use department codes to manage each job. For example, a system administrator can check how many sheets 
of copies a certain department has made. When the Department code is enabled, you are prompted to enter a 
department code before printing. If you enter the department code in the corresponding field in advance, you can print 
without having to do this every time. Ask your administrator about the codes. When SNMP communication between 
the equipment and your computer is enabled, you are also prompted to enter the code before printing.

Configuring the options
To use this equipment properly, you need to save the configuration of the options installed on the [Device Settings] tab 
menu after you installed the printer drivers. In the default setting, you can obtain the configuration data of options installed 
automatically by opening the [Device Settings] tab menu. If SNMP communication between this equipment and your 
computer is not available, or you want to configure options manually, see the following page:

 P.11 “Configuring options manually”

When SNMP communication between this equipment and your computer is enabled, you can retrieve the option 
configuration information by clicking [Update Now].
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Configuring options manually
If SNMP communication between this equipment and your computer is not available:

Setting the [Device Settings] tab manually

You need to log in to Windows with the “Administrator” privilege.

1 Click [Start] menu and select [Devices and Printers].
The Printers folder appears.

 For Windows Vista or Windows Server 2008
Click [Start] menu, [Control Panel], [Hardware and Sound] and select [Printers].

 For Windows XP or Windows Server 2003
Click [Start] menu and select [Printers and Faxes].

2 Select the printer driver for this equipment, and then click [Printer properties] in the 
[File] menu.
The printer driver properties dialog box appears.

 For Windows XP / Windows Vista / Windows Server 2003 / Windows Server 2008, click [Properties] in the [File] 
menu and select the printer driver for this equipment.

 If the [File] menu is not displayed, press [Alt].
 If the dialog box displayed does not allow the printer driver properties to be changed, follow the procedure 

below.
- For Windows Vista, click [Run as administrator] and [Properties] in the [File] menu.

If the password entry screen appears, enter the administrator password.
The [User Account Control] dialog box appears. Click [Continue].

- For Windows 7, some tab menus have a  button in the printer driver properties. To change the 
properties, click on it. If the properties cannot be changed, ask your system administrator.

 To change a network-installed printer driver, the administrator privilege is necessary. Ask your system 
administrator for details.
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3 Display the [Device Settings] tab menu, and set the following options.

Model Selection — This sets the model type. The setup items of the printer driver are changed according to the 
model selected.

If you select [PCL], you can narrow down the setup items of the printer driver to those used commonly in all of 
the OKI MFP series. It is convenient in such cases as when you are using a printer driver already installed to 
other OKI MFP.

Option — This option sets whether the following optional devices are installed.
 Drawers — This sets whether the optional drawers or the Large Capacity Feeder (optional) (not available for 

some countries or regions) are installed.
 Finisher — This sets whether or not the Finisher (optional) is installed.
 Hole Punch Unit — This sets whether or not the Hole Punch Unit (optional) is installed.
 External LCF — This sets whether or not the External Large Capacity Feeder (optional) is installed.
 Inserter Unit — This sets whether or not the Inserter Unit (optional) is installed.

The Large Capacity Feeder (optional) is not available for some countries or regions.

 Setup items differ depending on the model and the option configuration.
 For more information about each item, see the descriptions about the [Device Settings] tab.
 P.69 “[Device Settings] tab”

4 Click [Drawer Settings].
The [Drawer Settings] dialog box appears.
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5 Set the following options and click [OK].

Drawer 1 — Select the size and type of paper that is loaded in the 1st Drawer.
Drawer 2 — Select the size and type of paper that is loaded in the 2nd Drawer.
Drawer 3 — Select the size and type of paper that is loaded in the 3rd Drawer (optional) when it is installed.
Drawer 4 — Select the size and type of paper that is loaded in the 4th Drawer (optional) when it is installed.
LCF — Select the size and type of paper that is loaded in the Large Capacity Feeder (optional) when it is installed.
External LCF — Select the size and type of paper that is loaded in the External Large Capacity Feeder (optional) 
when it is installed.
Bypass Tray — Select the type of paper that is loaded in the Bypass Tray.
Override Application Paper Source Settings — Select this check box to use the paper source setting in the 
printer driver rather than the application setting.

 Setup items differ depending on the model and the option configuration.
 For more information about each item, see the descriptions about the Drawer Settings.
 P.71 “Drawer Settings”

6 Click [Apply] or [OK] to save settings.
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 Setting the department code
When this equipment is managed by department codes, you have to enter yours on the printer driver.
This allows a network administrator to check the number of copies printed by specific department members. Also users 
can check who submitted the print jobs, by touch panel display and monitoring tools.
Please ask your administrator whether you should enter the Department Code.

 When the User Management setting is enabled, it is used to manage a print job instead of the Department Code 
Management setting. In this case, a user name that has been entered to log in to your computer is used for the 
authentication of the print job. Therefore, you do not need to set your department code to the printer driver but you 
must register your user name in advance. If your user name is not registered, the print job is processed as an 
invalid one according to the User Authentication Enforcement setting. Also if a print job is sent in RAW format, it is 
processed according to the RAW Print Job setting. For more information about the User Authentication 
Enforcement setting or the RAW Print Job setting, refer to the TopAccess Guide.

 If the No Limit Black function is enabled, you do not have to specify the department code when you print a 
document with [Black and White] selected for the [Color] option in the [Basic] tab of printer driver.

 How the equipment performs printing for an invalid department code print job, for which an invalid department code 
is specified, varies depending on the Invalid Department Code Print Job setting that can be set in the TopAccess 
Administrator mode and whether SNMP communication is enabled or not. 
- When SNMP communication is enabled and Invalid Department Code Print Job is set to [Store to invalid job 

list], an error message will be displayed when an invalid department code is entered. 
- When SNMP communication is disabled and Invalid Department Code Print Job is set to [Store to invalid job 

list], the invalid department code print job will be stored in the invalid department code print job list without 
printing. 

- When the Invalid Department Code Print Job is set to [Print], the invalid department code print job will be 
printed.

- When the Invalid Department Code Print Job is set to [Delete], the invalid department code print job will be 
deleted. 

 A department code needs to be entered every time you begin printing. If you have to use a different department 
code for each print job, enter it when you begin printing.

Entering department code

1 Click [Start] menu and select [Devices and Printers].
The Printers folder appears.

 For Windows Vista or Windows Server 2008
Click [Start] menu, [Control Panel], [Hardware and Sound] and select [Printers].

 For Windows XP or Windows Server 2003
click [Start] menu and select [Printers and Faxes].
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2 Select the printer driver of this equipment, and then click [File] menu and select 
[Printing Preferences].

 If the [File] menu is not displayed, press [Alt].
 The printing preferences dialog box appears.

3 Display the [Others] tab menu and enter your department code in the [Department 
Code] box.

In the [Department Code] box, you can enter a department code within 63 characters.

A department code must consist of one-byte characters such as numbers from 0 to 9, letters of the alphabet 
from A to Z (both capital and small ones), a hyphen (-), an underscore (_), and a period (.).

4 Click [Apply] or [OK] to save the settings.

Copying the PPD file for Windows
The Client Utilities CD-ROM contains a printer description file for popular Windows applications. For applications not 
allowing the automatic installation of PPD files, copy the PPD file to a proper directory in order to enable printer-specific 
settings in the [Print] dialog box or the [Page] Setup dialog box.
For more information about copying PPD files, refer to the Software Installation Guide.
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Printing From Application

This section describes how to print a document from application.
 P.16 “Considerations and limitations”
 P.16 “How to print”

Considerations and limitations
 When the User Management setting is enabled, it is used to manage a print job instead of the Department Code 

Management setting. In this case, a user name that has been entered to log in to your computer is used for the 
authentication of the print job. Therefore, you do not need to set your department code to the printer driver but you 
must register your user name in advance. If your user name is not registered, the print job is processed as an invalid 
one according to the User Authentication Enforcement setting. Also if a print job is sent in RAW format, it is processed 
according to the RAW Print Job setting. For more information about the User Authentication Enforcement setting or the 
RAW Print Job setting, refer to the TopAccess Guide.
When the Windows Domain Authentication is used for the User Management Setting, your computer must log in the 
domain.

 If the No Limit Black function is enabled, you do not have to specify the department code when you print a document 
selecting [Black and White] in the [Color] option in the [Basic] tab of printer driver.

 Some print options can be set from both the application and the printer driver, such as collation. If the collation is set 
from the application, documents may not be properly printed. If that happens, use the printer driver to set the collation. 
Depending on the application, some print options such as the orientation need to be set from the application. For print 
options that can be set from both the application and the driver, refer to the manual of the application.

Cautionary points when using a PS printer driver
 When printing with a PS printer driver from Adobe Acrobat, this option is disabled. To use this option with PostScript, 

use a PCL Printer driver, click [Customization] on the [Device Settings] tab, and select [PostScript] in the [Output PDL] 
box of the [PDL Settings] tab.

 When any of the following functions is set in a PS printer driver, the print function will work appropriately even if print 
data are generated in the application side since this happens in the printer driver side by ignoring the pass-through 
printing of the application.
- Print to Overlay file
- Print Overlay Image
- Nin1
- Booklet
- Interleave (Duplicate)
- Templates printing
- Print Paper Size
- Image Scale
- Poster Print
- Tandem Print

How to print
Once you have installed the printer driver and configured it properly, you can print directly from most Windows 
applications. Simply choose the Print command from your application.
You can print using the various functions by setting print options on the printer driver.

Printing from Windows applications

The following describes an example for printing from Notepad on Windows 7.

1 Open a file and select [Print] from the [File] menu of the applications.
The [Print] dialog box appears.
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2 Select the printer driver of the equipment to be used and click [Preferences].

The printing preferences dialog box appears.

The procedures for displaying the properties dialog for the printer driver may be different depending on the application 
that you are using. See your application’s manual about displaying the printer properties dialog box.

3 Setting the print options on each tab according to how you want to print.

 Setting the print options varies depending on how you want to print a document.
 P.26 “Print options”

 You can also set the print options using setting profiles.
 P.20 “Setting print options using profiles”

4 Click [OK] to save the settings.
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5 Click [Print] to print a document.
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Setting Up Print Options

Print Options are the attributes you set to define the way a print job is processed. For example, the private print and proof 
print options determine how the copier manages your print job.

To find the printing instructions for your specific needs, see the procedures in the following section.
 P.78 “Printing With Best Functions for Your Needs”

How to set up
There are several ways to set print options. How the settings affect printing varies depending on the way you set the 
options. The tabs displayed also vary depending on how you display the printer properties.

 Setting initial values of print options
Setting the print options by displaying the printer properties from the Printers folder within the Windows Start menu will 
establish the initial values of the options. For example, the paper size setting you most commonly use, optional device 
settings, user information settings, etc., are settings you will not want to change every time you print. It is convenient to set 
these options as initial values.

How to display: Windows 7

1 Click the [Start] menu and select [Devices and Printers].

2 Select the printer driver of your equipment, click the [File] menu and select [Printing 
Preferences].
If the [File] menu is not displayed, press [Alt].

How to display: Windows Vista / Windows Server 2008

1 Click [Start], [Control Panel], [Hardware and Sound] and select [Printers].

2 Select the printer driver for the equipment, click the [File] menu and select [Printing 
Preferences].
If the [File] menu is not displayed, press [Alt].

How to display: Windows XP / Windows Server 2003

1 Click [Start] menu and select [Printers and Faxes].

2 Select the printer driver for the equipment, click the [File] menu and select [Printing 
Preferences].

 Setting print options for each print job
The print options that are set in properties dialog box, which can be accessed from the [Print] dialog box of the application, 
are only applied to the current print job, so once you close the application, the options will be invalid.

How to display:

1 Click the [File] menu and select [Print] on application.

2 Select the printer driver of the equipment to be used and click [Preferences].
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 Setting print options using profiles
Using profiles, you can save the print settings or apply the saved settings to a print job.

There are 5 factory default profiles.
- BW, Duplex, Staple & 2in1
- Color Booklet
- Duplex & Staple
- Duplex, Staple & 2in1
- Duplex, Staple & Punch

In order to print a document using profiles, you must first create the saved profile.
 P.20 “Saving profile”
Once you save a profile, you can apply its settings to a print job.
 P.21 “Loading profile”
You can also delete unnecessary profiles.
 P.22 “Deleting profile”

Saving profile

You can register up to 20 profiles (including 5 default profiles) for each printer driver.

You can delete the default profile or overwrite it by changing its contents and saving it under the same name.

1 Configure the print options on each tab.
Setting the print options varies depending on how you want to print a document.
 P.26 “Print options”

2 Click [Save Profile] in the Profile group.

The [Profile Name] dialog box appears.
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3 Enter the profile name and click [OK].

The file name must be up to 63 characters long.

 If you enter an existing profile name, you are prompted to confirm whether you want to overwrite it. If you 
want, click [OK].

 If you try to save more than 20 profiles, a dialog box notifying you that no more can be saved appears, then 
the 21st profile is saved as a temporary profile. If you want to register this temporary profile, delete 
unnecessary profiles first, and then select [Temporary Profile] to recall this profile and click [Save Profile] to 
save it.

 You cannot specify [None] for the profile name.

4 The profile is saved.

Loading profile

1 Select a profile in the [Profile] box.

The setting options in the profile are reflected on each tab.

To restore the default settings after you select the profile, click [Restore Defaults] on each tab. Selecting [None] 
on the [Profile] box will not restore them. To restore the default settings on any tab other than the [Device 
Settings] tabs, click [Restore All Defaults] on the [Others] tab.
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Deleting profile

1 Select the profile that you want to delete in the [Profile] box, and click [Delete].

The [Confirm Delete] dialog box appears.

2 Click [Yes] to delete the selected profile.
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 Setting up print options with Template Buttons
Once you save a profile to a Template Button, the [Templates] dialog box automatically appears upon printing, and you 
can immediately apply the saved profile to a print job only by selecting this Template Button.

5 factory default profiles are registered in a Template Button.
- BW, Duplex, Staple & 2in1
- Color Booklet
- Duplex & Staple
- Duplex, Staple & 2in1
- Duplex, Staple & Punch

To use a Template Button, you must first save a profile to this button. Also you must set a dialog box for selecting Template 
Buttons to appear automatically upon printing.
 P.23 “Saving a profile to the Template Button”
You can apply the saved profile to a print job by selecting the Template Button upon printing. 
 P.24 “Printing with profiles in a Template Button”
You can delete a Template Button if it is no longer required.
 P.25 “Deleting a profile saved in a Template Button”

Saving a profile to the Template Button

You can create up to 6 Template Buttons, including 5 default buttons.

You can delete any of the default Template Buttons.

1 Save the desired print options as a profile.
 P.20 “Saving profile”

2 Select the [Templates] tab.

3 Select the [Templates Dialog Box] check box.

The [Templates] dialog box appears automatically in printing.

4 Click [Edit].
The [Edit Templates] dialog box appears.
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5 Select a profile to be saved in the [Profile] box.

6 Select a Template Button to which the chosen profile is saved.

If you select a Template Button that is already registered, the profile saved in this button is replaced with a new 
one.

7 Click [Save] and then [OK].
The chosen profile is saved in the selected Template Button.

8 Click [OK] on the [Template] tab.
The saved profile is registered.

Printing with profiles in a Template Button

1 The [Templates] dialog box appears automatically when printing is started.

2 Select a Template Button to be applied.
Printing is performed with the profile saved in the selected Template Button.

 To set the number of copies, select the [Number of Copies] check box.
 To print without applying profiles, click [Skip].
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Deleting a profile saved in a Template Button

1 Select the [Templates] tab.

2 Click [Edit].

The [Edit Templates] dialog box appears.

3 Select a Template Button whose profile needs to be deleted.

4 Click [Delete] and then [OK].
The profile in the selected Template Button is deleted. The Template Button is left blank.
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 Print options
This section describes print options in each tab of the printer driver. This section will help you to find the description of 
specific print options, or understand their individual functions.

The following tabs are the setting items which depend on the OS. For their setting procedures and details, refer to the 
Operator's Manual or the Help of the OS to be used.
- [General] tab
- [Sharing] tab
- [Ports] tab
- [Advanced] tab
- [Color Management] tab
- [Security] tab

How to display:

1 Click [Start] menu and select [Devices and Printers].
The Printers folder appears.

 For Windows Vista or Windows Server 2008
Click [Start] menu, [Control Panel], [Hardware and Sound] and select [Printers].

 For Windows XP or Windows Server 2003
Click [Start] menu and select [Printers and Faxes].

2 Select the printer driver of this equipment, and then click [File] menu and select 
[Printing Preferences].
 If the [File] menu is not displayed, press [Alt].
 The printing preferences dialog box appears.

1) Printer Name
Displays the name given to the printer driver when it was installed, or the name it displays on the icon in the Printer 
folder.
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2) Menu Tabs
The menu items of the printer driver are displayed as tabs. Clicking on a tab will display the contents of the selected 
tab. The tabs displayed vary depending on the way the print properties are displayed.
- [Basic] tab

The [Basic] tab contains basic print operation settings, such as original paper size, print paper size, paper source, 
paper type, destination, number of copies, orientation, and so on.
 P.29 “[Basic] tab”

- [Finishing] tab
The [Finishing] tab allows you to enable sort printing, 2-sided printing, N-up printing, stapling and punching.
 P.35 “[Finishing] tab”

- [Paper Handling] tab
The [Paper Handling] tab contains Cover page printing.
 P.43 “[Paper Handling] tab”

- [Image Quality] tab
The [Image Quality] tab allows you to select how images are printed. You can easily select appropriate image 
quality depending on the type of job being printed.
 P.49 “[Image Quality] tab”

- [Effect] tab
The [Effect] tab contains print options that add the effects to your print jobs such as Watermarks, Overlay Image 
printing and so on.
 P.57 “[Effect] tab”

- [Others] tab
The [Others] tab contains special features such as toner save, custom pager size, and so on.
 P.63 “[Others] tab”

- [Templates] tab
The [Templates] tab allows you to register print options frequently used as a template, or recall the registered print 
options.
 P.76 “[Templates] tab”

- [Device Settings] tab
The [Device Settings] tab allows you to configure the options. When any optional unit is installed in this equipment, 
set the configuration of the machine on this tab. This tab is only displayed when the printer properties are accessed 
from the Printers folder.
 P.69 “[Device Settings] tab”

The [Paper Handling] tab, [Image Quality] tab, [Effect] tab and [Templates] tab appear only when each setting is 
enabled with the Plug-in feature.
 P.73 “Customization: [Plug-in] tab”

3) Print Job
This sets the type of print job.
- Normal Print

Select this to print a job normally.
- Scheduled Print

Select this to print a job on a specified date and time.
When this is selected, click the [...] on the right of the [Print Job] box to set the date and time to print a job.

- Private Print
Select this option to print a private job. When you select this option, enter a password using the alphanumeric 
characters and symbol characters (ASCII code characters between 0x21 to 0x7E) in the [Password] box that is 
displayed after the print settings have been made and the print job is sent. The password must be between 1 and 
63 characters.
The print job, sent as a private job, is saved in the private job queue on this equipment, and is not printed until you 
activate printing from the touch panel display. This option is useful when you want to print a confidential document 
that is secured by a password. The user has to enter the password to print the private job when activating printing 
from the touch panel display.

- Hold Print
The print job, sent as a hold job, is saved in the hold job queue on this equipment. To perform printing, select the 
desired job on the touch panel display and press [PRINT]. This option is useful to prevent you from forgetting to 
remove printed sheets.

- Proof Print
Select this to print the first copy of a multicopy job and then wait for approval before printing the remaining copies. 
If a print job is sent as a proof job, one copy of the job is printed and the remaining copies are saved in the proof job 
queue on this equipment, which are not printed until you activate printing from the touch panel display. This option 
allows you to check a job’s output before printing the remaining copies and thereby reduce paper waste.
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When you want to print multiple copies, each of which is to be sent as an individual print job by your application, all 
the copies, not just one copy, will be printed even if you set Proof Print. In such a case, print just one trial copy first, 
and then specify the required number of copies on the touch panel display.

- Print to Overlay File
Select this to save the print job as an overlay file that is imposed on other documents. When you select this, click 
the button on the right and enter the file name.
For example, if you want to print a master page image on the background of a document, you can create an 
overlay file of the master merge image using this option. Then you can print a document using this overlay by 
specifying this file as an overlay image in the [Overlay Image] option of the [Effect] tab.

 If the print job has several pages in the document, only its first page will be saved as an overlay file.
 Both the overlay file and the documents on which you superimpose the overlay image must be created with the 

same size and color mode.

- Store to e-Filing
Select this to save a job to e-Filing. When this is selected, select the box from the box after the print setting has 
been finished. When the SNMP communication is enabled, it detects the available box numbers and Box name in 
the box. If not, all box numbers are listed in the box.
If you select a user box, you may be required to enter the appropriate password for the selected box. The job saved 
to a box can be printed from the touch panel display at a later time. It can also be composed with other documents 
using the e-Filing web utility.
You can also print a job and save it to a box by checking on the [Print] option.

 Documents stored in e-Filing are retained with the best image quality for printing. If you want to download them 
into your computer with a higher image quality, scan the original documents and store them in e-Filing.

 When you store a document in e-Filing using the printer driver, the printing image (not the original document in 
your computer) will be stored in e-Filing.

- Multiple Job Type
The Multiple Job Type feature allows you to combine any of Scheduled Print, Private Print, Hold Print, Proof Print, 
Proof Private Print and Proof Hold Print, with Store to e-Filing. 
For example, you can store a job in the specified e-Filing of this equipment and print it at the specified time by 
combining Scheduled Print with Store to e-Filing.
To use this feature, click [...] on the right of the [Print Job] box and select the job types to be combined.

 For more information about e-Filing operations, refer to the e-Filing Guide.
 For the detailed instructions on how to print with the [Print job] setting, see the following page:
 P.78 “Printing various print job types”

4) Preview window
In the Preview window, you can preview how a document will be printed under the current settings of the printer driver. 
The image of a page to which the set print options are applied is displayed.

5) [Settings]
The set print options and their details are displayed in a list.

6) Profile
Print option settings can be saved on your hard disk. You can save print option settings by clicking [Save Profile] and 
easily load a setting file by selecting a profile name in the box.
 P.20 “Setting print options using profiles”

There are 5 factory default profiles.

7) [Restore Defaults]
Click this to restore the settings to the original factory defaults.

8) [OK]
Click this to enter the input settings and complete the print option settings.
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9) [Cancel]
Click this to cancel the input settings and exit the print option settings.

10) [Apply]
Click this to enter the input settings without closing the print option settings. This button is only displayed when the 
printer properties are accessed from the Printers folder. This button remains grayed out until a setting is changed.

11) [Help]
Click this to browse Help for the printer driver.

 [Basic] tab
The [Basic] tab contains basic print operation settings, such as the original paper size, print paper size, paper source, 
paper type, destination, number of copies, orientation, and so on.

1) Original Paper Size
This selects the size of a document to be printed.

Available original paper sizes are listed below:

 A4 (210 x 297 mm)
 A5 (148 x 210 mm)
 A3 (297 x 420 mm)
 B4 (257 x 364 mm)
 B5 (182 x 257 mm)
 Folio (210 x 330 mm)
 305 x 457 mm
 12 x 18"
 A6 (105 x 148mm)
 Letter (8 1/2 x 11") 
 Legal (8 1/2 x 14") 
 Ledger (11 x 17") 
 Statement (5 1/2 x 8 1/2") 

 Computer (10 1/8 x 14") 
 13"LG (8 1/2 x 13") 
 8.5"SQ (8 1/2 x 8 1/2") 
 16K (195 x 270 mm)
 8K (270 x 390 mm)
 320 x 450 mm
 320 x 460 mm
 Env-Com10 (4 1/8 x 9 1/2")
 Env-Mornarch (3 7/8 x 7 1/2")
 Envelope DL (110 x 220 mm)
 Envelope Cho-3 (120 x 235 mm)
 Envelope You-4 (105 x 235 mm)
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 There are also 20 custom paper sizes in the [Original Paper Size] box. You can set the custom paper sizes in 
the [Others] tab.
 P.63 “[Others] tab”

 The default paper size will be [Letter] or [A4] according to the regional setting in the Windows.
 [305 x 457 mm] is displayed only for the European version, and [12 x 18"] is displayed only for the US version.
 [305 x 457 mm], [12 x 18"], [320 x 450 mm], and [320 x 460 mm] is enabled only when the ES9460 MFP/

ES9470 MFP/CX3535 MFP/CX4545 MFP is used.
 [Env-Com10 (4 1/8 x 9 1/2")], [Env-Mornarch (3 7/8 x 7 1/2")], [Envelope DL (110 x 220 mm)], [Envelope Cho-3 

(120 x 235 mm)], and [Envelope You-4 (105 x 235 mm)] is enabled only when the ES9160 MFP/ES9170 MFP is 
used.

 Setup items differ depending on the model.

2) Print Paper Size
Select this to enlarge or reduce a page image to fit exactly in the selected paper size. If you do not wish to enable 
enlarge or reduce printing, select [Same as Original Size].
Also when you want to enable Tab printing, select [Letter Tab] or [A4 Tab] here. When you select [Letter Tab] or [A4 
Tab], the [Primary Tab Dialog] dialog box appears.
 P.33 “Primary Tab Dialog”

There are also 20 custom paper sizes in the [Print Paper Size] box. You can set the custom paper sizes in the 
[Others] tab.
 P.63 “[Others] tab”

3) Image Scale
Select this check box to enter the scale manually to enlarge or reduce an image. The ratio can be set at between 25 
and 400%.

For detailed instructions on how to print with the [Image Scale] setting, see the following page:
 P.90 “Fitting images within paper size”

4) Paper Source
This selects a paper source to print a job in the most suitable paper size. The figure on the right indicates the paper 
size set for each paper source. When you select a paper source, the chosen one is indicated with a green square in 
the figure.

You can select a paper source by directly clicking on the figure on the right.

- Auto — Automatically selects the paper set in this equipment according to the printed document size.
- Drawer 1 — Paper is fed from the 1st Drawer.
- Drawer 2 — Paper is fed from the 2nd Drawer.
- Drawer 3 — Paper is fed from the 3rd Drawer.
- Drawer 4 — Paper is fed from the 4th Drawer.
- LCF — Paper is fed from the Large Capacity Feeder (optional). This cannot be selected if the Large Capacity 

Feeder (optional) is not installed.
- Bypass Tray — Paper is fed from the Bypass Tray. When this is selected and print a job, [JOB STATUS] on the 

touch panel will blink. Press [JOB STATUS] and check the paper size of the job. Then set the paper and press the 
[START] button to print a job.

- External LCF — Paper is fed from the External Large Capacity Feeder (optional). This cannot be selected if the 
External Large Capacity Feeder (optional) is not installed.
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 When you select the bypass tray as a paper source but the orientations of the original and the paper on the 
bypass tray differ, the data in the original are rotated for 90 degrees and printed in the same orientation as that 
of the original, as long as their paper sizes are the same (this is available only for A4, B5, LT and 16K). For 
example, when an original is A4 in a portrait direction but the paper on the bypass tray is A4-R, the data of the 
original are printed in A4 in a portrait direction.

 The selectable values vary depending on the optional devices installed on this equipment and their 
configuration on the [Device Settings] tab.

 When paper such as special or tab paper that needs to be fed from the bypass tray is set, [Bypass Tray] may be 
automatically selected in the [Paper Source] box, and then a confirmation dialog box may appear.

 When the paper size settings on the [Device Settings] tab differ from those in the equipment, the paper source 
setting is ignored and the equipment may prompt to set the paper in the bypass tray.

 The Large Capacity Feeder (optional) is not available for some countries or regions.

5) Paper Type
This sets the media type of the paper.
- Plain (Auto) — Select this when printing on plain paper.
- Plain — Select this when printing on plain paper.
- Recycled — Select this when printing on recycled paper.
- Thick1 — Select this when printing on thick 1 paper.
- Thick2 — Select this when printing on thick 2 paper.
- Thick3 — Select this when printing on thick 3 paper.
- Thick4 — Select this when printing on thick 4 paper.
- Special 1 — Select this when printing on special 1 paper.
- Special 2 — Select this when printing on special 2 paper.
- Transparency — Select this when printing on transparent sheets.
- Plain1 — Select this when printing on plain 1 paper.
- Plain2 — Select this when printing on plain 2 paper.
- Thick1 (Back) — Select this when printing on the back side of thick 1 paper.
- Thick2 (Back) — Select this when printing on the back side of thick 2 paper.
- Thick3 (Back) — Select this when printing on the back side of thick 3 paper.
- Thick4 (Back) — Select this when printing on the back side of thick 4 paper.
- Special 1 (Back) — Select this when printing on the back side of special 1 paper.
- Special 2 (Back) — Select this when printing on the back side of special 2 paper.
- Thin — Select this when printing on the back side of thin paper.

 The applicable paper weight for each paper type differs depending on the model. For details of the paper 
weight, refer to the corresponding Quick Start Guide.

 When [A4 Tab] or [Letter Tab] is selected at the [Print Paper Size] box, [Tab] will be displayed and you cannot 
change the paper type.

 Setup items differ depending on the model.

For more information about the paper types that are available for this equipment, refer to the Quick Start Guide.
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6) Destination
This selects the tray to which the print job is made to exit. The figure on the right indicates the destination currently set 
with an arrow.
- Exit Tray — Select this to have paper exit to the exit tray.
- Upper Exit Tray — Select this to have paper exit to the upper exit tray.
- Job Separator Upper — Select this to route the upper exit tray of the Job Separator (optional).
- Job Separator Lower — Select this to route the lower exit tray of the Job Separator (optional).
- Side Exit Tray — Select this to route the output to the side exit tray of this equipment.
- Tray 1 — Select this to route the output to the upper tray of the Finisher (optional).
- Tray 2 — Select this to route the output to the lower tray of the Finisher (optional).
- Saddle Tray — Select this to route the output to the saddle tray of the Saddle Stitch Finisher (optional).

 The selectable items differ depending on the model and the option configuration.
 The destination is limited to [Saddle Tray] when you perform folding print or saddle stitch print with the Saddle 

Stitch Finisher (optional) installed.

 You can select the tray by directly clicking on the figure on the right.
 Select [Tray 1] if you want to reduce the initialization period if the Finisher (optional) is installed.

7) Number of Copies
This sets the number of printed copies. This can be set at between 1 and 9999.

The selectable range of the number of copies:
1 copy to 999 copies

8) Orientation
This sets the paper printing direction.
- Portrait — The document is printed in the portrait direction.
- Landscape — The document is printed in the landscape direction.

9) Color
This sets whether a print job is printed in the color or black mode.
- Auto — Select this to determine the color mode automatically. When a print job is a black and white document, the 

system automatically prints the document in the black mode. When a print job is a color document, it prints the 
document in the color mode.

- Color — Select this to print a document in the color mode.
- Black and White — Select this to print a document in the black mode.
- Twin Color — Select this to print a document in the twin color mode. When this is selected, click [Details] to specify 

the color that the non-black part of document will be printed in. You can select either [Red], [Green], [Blue], [Cyan], 
[Magenta], [Yellow], or [White].

For instructions on how to print color images with the [Black and White] or [Twin Color] setting, see the following page:
 P.91 “Printing color documents in gray scale”
 P.92 “Printing color documents in twin colors”

[Color] is enabled only when the ES9460 MFP/ES9470 MFP/CX3535 MFP/CX4545 MFP is used.
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Primary Tab Dialog

1) Tab Manufacturer
Select the product name of the tab paper that you use. This equipment supports following tab paper.

If you use tab papers other than those above, select [Custom]. When you select [Custom], you must specify the tab 
extension manually.

2) Tab Extension
Enter the width of the tab extension. This must be set only when [Custom] is selected in the [Tab Manufacturer] option.

3) Image Shift Width
Enter the width to shift the printed image.
For example, if you want to print text on the tab extension of Letter Tab paper, create a Letter sized document and 
input the text on the right side. Specify the distance the printed image is shifted in printing on tab paper.

 When creating a document for tab printing, you must place the text at the exact height to fit the tab extension.
 The selectable range of the edge margin differs depending on the model. See the following for setting this 

option:
- For the ES9460 MFP/ES9470 MFP/CX3535 MFP/CX4545 MFP

The margin between the shifted text and right edge of the tab extension must have at least 0.17 inches (4.2 
mm) of space because any data in this space are not printed. Enter the same value in the [Tab Extension] 
box and the [Image Shift Width] box.

- For the ES9160 MFP/ES9170 MFP
The margin between the shifted text and right edge of the tab extension must have at least 0.08 inches (2.0 
mm) of space because any data in this space are not printed. Enter the same value in the [Tab Extension] 
box and the [Image Shift Width] box.

For models other than the above, refer to the corresponding Printing Guide.

For Letter Tab: Blanks USA copy Tabs (5 Banks) LT + 1/2" Tab
Blanks USA copy Tabs (8 Banks) LT + 1/2" Tab

For A4 Tab: KOKUYO A4-S (5 Banks)
King JIM A4-S (5 Banks)
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4) Units
Select the unit for the Tab Extension and Image Shift option. The default unit varies depending on the regional setting 
of the client computer.

 Tab paper must be fed from the bypass tray. Make sure to place it with its tab outside. The shape of the bypass tray 
differs depending on the model.

 The tab paper cannot be fed from the Large Capacity Feeder (optional) and drawers.
 If the document for tab printing is not created properly or the [Image Shift Width] is not set properly, the image will 

not be printed in the correct position within the tab extension. Please make sure to create the document and set the 
[Image Shift Width] correctly.

 If misprinting occurs while multiple tab pages are printed continuously, dirt may adhere to the reverse side of paper. 
To avoid this, it is recommended to print tab paper as a separate job for each page so that this equipment performs 
cleaning before printing the next tab paper.

 When printing tab paper, the tab paper may be caught in the exit in the inner tray because the roller to deliver the 
tab extension does not exit. In that case, remove the tab paper before printing a next job.

For the detailed instructions on how to print on tab paper, see the following page:
 P.108 “Printing on tab paper”

Place the tab paper

with the tab outside.
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 [Finishing] tab
The [Finishing] tab allows you to enable sort printing, 2-sided printing, N-up printing, poster printing, stapling and 
punching.

1) Copy Handling
This sets how to sort the printed sheets when numerous copies are made for printing.
- Sort Copies — Select this for sort-printing (1, 2, 3... 1, 2, 3...).

- Group Copies — Select this for group-printing (1, 1, 1... 2, 2, 2... 3, 3, 3...).

- Rotated Sort Copies — Select this for rotate sort-printing.

 [Group Copies] and [Rotated Sort Copies] can be selected only when more than 1 copy is entered at the 
Number of Copies option.

 [Rotated Sort Copies] can be selected only when [Letter], [A4], [B5], or [16K] is selected at the Print Paper Size 
option. When you use the “Rotated Sort Copies” option, place copy paper of a desired size in two drawers 
(portrait and landscape directions) before you start printing. Select one paper size from [Letter], [A4], [B5] and 
[16K], and then place the selected paper in two drawers, the Large Capacity Feeder (optional) trays or the 
External Large Capacity Feeder (optional) tray in different directions (e.g. A4 and A4-R) in advance.
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For the detailed instructions on how to print with the [Copy Handling] setting, see the following page:
 P.92 “Sort printing”

2) 2-Sided Printing
This sets printing on both sides of paper. Select this check box and then the position of the margin for 2-sided printing.
- Long Edge — Select this to print on both sides of the paper with a margin on the long edge.

- Short Edge — Select this to print on both sides of the paper with a margin on the short edge.

- Booklet — Select this to print a properly paginated booklet or magazine-style publication. When this is selected, 
click [Details] to specify the details of the Booklet printing.
 P.41 “Booklet Details”

 2-Sided printing cannot be set when the following paper size is selected at the [Print Paper Size] box in the 
[Basic] tab.
- A6
- A4 Tab
- Letter Tab
- Custom Paper Size

 2-Sided printing cannot be set when the following paper type in selected at the [Paper Type] box in the [Basic] 
tab.
- Transparency
- Thick4
- Thick4 (Back)

 To staple or punch holes on the 2-sided printed sheets, set each option separately.
 P.98 “Stapling”
 P.98 “Hole punching”

 For detailed instructions on how to print with the [2-Sided Printing] setting, see the following page:
 P.94 “Printing on both sides of a sheet”

Portrait Landscape
1 2 1
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3) Number of pages per Sheet
This sets the printing of multiple pages on one sheet. The pages are reduced to fit the selected paper size 
automatically and printed.
- 2 pages — Select this to print images from 2 pages arranged on one sheet.
- 4 pages — Select this to print images from 4 pages arranged on one sheet.
- 6 pages — Select this to print images from 6 pages arranged on one sheet.
- 8 pages — Select this to print images from 8 pages arranged on one sheet.
- 9 pages — Select this to print images from 9 pages arranged on one sheet.
- 16 pages — Select this to print images from 16 pages arranged on one sheet.

Direction of Print
This sets how the pages are arranged on one sheet.
- Left to Right — Select this to arrange pages horizontally from the left and printed top to bottom on one sheet.
- Right to Left — Select this to arrange pages horizontally from the right and printed top to bottom on one sheet.
- Left to Right by column — Select this to arrange pages vertically from the top and printed left to right on one 

sheet.
- Right to Left by column — Select this to arrange pages vertically from the top and printed right to left on one 

sheet.

Draw Borders Around Pages
Select this check box to print borders around each page.

 When you select [Booklet] in the [2-Sided Printing] box, only [2 pages] can be selected.
 For the detailed instructions on how to print with the [Number of pages per Sheet] setting, see the following 

page:
 P.97 “Printing several pages on one sheet”

4) Staple
This sets whether a print job is printed with staples.
- Upper Left — Select this to staple the printed document in the upper left.

- Upper Right — Select this to staple the printed document in the upper right.

- Center Top — Select this to double staple the printed document along the top edge.

- Middle Left — Select this to double staple the printed document along the left side.
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- Center Double — Select this to fold and double-staple the printed document in the center. When you select this, 
the pages will be printed on the sheets according to the print option settings, and then simply fold and double-
staple in the center of the sheets.

[Center Double] can be used to create a saddle-stitching for a document that has already been made as a 
paginated booklet. To create a paginated booklet from a normal document, perform the booklet printing in the 2-
Sided Printing option. When [Center Double] is used, select the [Staple Down the Center] check box in the [Booklet 
Details] dialog box.

 The selectable options vary depending on the paper size.
 The “Staple” option is available only when the Finisher (optional) is installed.
 [Center Double] can be selected only when the Saddle Stitch Finisher (optional) is installed.
 The “Staple” option is not available when the Group Copies / Magazine sort function is selected.
 Stapling cannot be set when the following paper sizes are selected in the [Print Paper Size] box in the [Basic] 

tab.
- A5
- A6
- 305 x 457 mm
- Statement
- 12 x 18"
- A4 Tab
- Letter Tab
- 320 x 450 mm
- 320 x 460 mm
- 13 x 19"
- Custom Paper Size

 Stapling cannot be set when the following paper types are selected at the [Paper Type] box in the [Basic] tab.
- Thick 4
- Special 1
- Special 2
- Transparency
- Thick 4 (Back)
- Special 1 (Back)
- Special 2 (Back)

For detailed instructions on how to print with the [Staple] setting, see the following page:
 P.98 “Stapling”
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5) Hole Punch
This sets whether a print job is printed with hole punches.
- Center Top — Select this to create holes along the top edge and print.

- Middle Left — Select this to create holes along the left side and print.

 Hole punching can be selected only when a Hole Punch Unit (optional) is installed.
 The “Hole Punch” option is not available when the Magazine sort function is selected.
 The selectable options vary depending on the paper size.

For the detailed instructions on how to print with the [Hole Punch] setting, see the following page:
 P.98 “Hole punching”

6) Folding
Select this check box if you want to have the printed paper folded when it exits. If this option is selected, the job is 
printed according to the other print options set, and then exits with its center folded.

The Folding option is used when the Booklet option is selected in advance. If you apply the Booklet option in a 
normal page order, select [Booklet] in the [2-Sided Printing] box. 
If you apply the Folding option, set [Booklet] in the [2-Sided Printing] box, click [Details], open the [Booklet Details] 
dialog box and then select the [Folding] check box.

The Folding option is available only when the Saddle Stitch Finisher (optional) is installed in either the ES9460 
MFP/ES9470 MFP/CX3535 MFP/CX4545 MFP, or the Saddle Stitch Finisher MJ-1106 (optional) is installed in the 
ES9160 MFP/ES9170 MFP.

For detailed instructions on how to print with the Folding option, see the following page:
 P.94 “Making a booklet”
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7) Use Custom Margin
Select this check box to set the margin on the printed pages. When this box is selected, click [Details] to set the 
margins in the [Custom Margin] dialog box.
The selectable range of the margin width differs depending on the model.
- The selectable range of the margin width:

 0.17 inch to 3.94 inches / 4.2 mm to 100 mm (The margin width cannot be smaller than 0.17 inches / 4.2 mm.)

For models other than the above, refer to the corresponding Printing Guide.

 If [Booklet] is selected on [2-Sided Printing], this option will be disabled.
 Enable this function to add the margins if the application does not support the margin function. When the 

application has a margin function, use the application’s function rather than this option.
 This cannot specify the binding margin for Booklet printing.

8) Poster Print
You can divide a print job onto more than one sheet of paper, so you can create one large image, such as a poster, by 
connecting the divided images. If this option is enabled, click [Details] and set the Output number of Sheets.

 The Poster Print option is not available when any of the Custom Paper Size, Number of pages per sheet, 2-
Sided Printing, Watermark, Overlay Image and Sheet Insertion options is set.

 The Poster Print option is available only when any of the sizes below is selected for [Print Paper Size] box on 
the [Basic] tab.
A4, A3, LT, LG

 [1x2] is selectable only when A4 or A3 is chosen for [Print Paper Size].

For detailed instructions on how to print with the Poster Print option, see the following page:
 P.99 “Dividing one image into multiple sheets (Poster Print)”

1x2 2x2 4x43x3
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Booklet Details

In the [Booklet Details] dialog box, you can specify how Booklet printing is performed.

1) Output Document Layout
Select the booklet size to be made.
- A5 on A4 — Select this to print an A5 size booklet. Every 2 pages are printed on A4 paper to fit on half a sheet 

(A5).
- A4 on A3 — Select this to print an A4 size booklet. Every 2 pages are printed on A3 paper to fit on half a sheet 

(A4).
- B5 on B4 — Select this to print a B5 size booklet. Every 2 pages are printed on B4 paper to fit on half a sheet (B5).
- B6 on B5 — Select this to print a B6 size booklet. Every 2 pages are printed on B5 paper to fit on half a sheet (B6).
- 1/2 Folio on Folio — Select this to print a 1/2 Folio size booklet. Every 2 pages are printed on Folio paper to fit on 

half a sheet.
- A6 on A5 — Select this to print an A6 size booklet. Every 2 pages are printed on A5 paper to fit on half a sheet 

(A6).
- Letter-Half on Letter — Select this to print a 1/2 Letter size booklet. Every 2 pages are printed on Letter paper to 

fit on half a sheet.
- LT on LD — Select this to print a Letter size booklet. Every 2 pages are printed on Ledger paper to fit on half a 

sheet (Letter).
- 1/2 LG on LG — Select this to print a 1/2 Legal size booklet. Every 2 pages are printed on Legal paper to fit on half 

a sheet.
- 1/2 Statement on Statement — Select this to print a 1/2 Statement size booklet. Every 2 pages are printed on 

Statement paper to fit on half a sheet.
- 1/2 Comp on Comp — Select this to print a 1/2 Computer size booklet. Every 2 pages are printed on Computer 

paper to fit on half a sheet.
- 1/2 13LG on 13LG — Select this to print a 1/2 13 inch LG size booklet. Every 2 pages are printed on 13 inch LG 

paper to fit on half a sheet.
- 1/2 8.5SQ on 8.5SQ — Select this to print a 1/2 8.5 inch SQ size booklet. Every 2 pages are printed on 8.5 inch SQ 

paper to fit on half a sheet.
- 32K on 16K — Select this to print a 32K size booklet. Every 2 pages are printed on 16K paper to fit on half a sheet.
- 16K on 8K — Select this to print a 16K size booklet. Every 2 pages are printed on 8K paper to fit on half a sheet.

2) Page Order
Select this to print the pages from left to right or right to left.

3) Margin - Center
This sets the gutter in the center of a two-sided page. You can enter the value between 0 and 0.67 inches (0 and 16.90 
mm). The printed images will be reduced according to the margin setting.

4) Margin - Outer
This sets the gutter on the right side and left side on the paper. You can enter the value between 0.17 and 1.17 inches 
(4.20 and 29.60 mm). The printed images will be reduced according to the margin setting.

5) Margin - Units
Select the unit for the Center Margin and Outer Margin option. The default unit varies depending on the regional 
setting in the Windows.

6) Booklet without Center Margin
Select this to set the center margin of the paper to 0 inch (mm).
In this case the value set for [Margin - Center] becomes invalid. 
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7) Folding
Select this to have the paper folded at its center when it exits.

 The Folding option is available only when any of the finishing sizes below is selected.
[A5 on A4], [A4 on A3], [B5 on B4], [Letter - Half on Letter], [LT on LD], [1/2 LG on LG], [16K on 8K]

 The Folding option is available only when the Saddle Stitch Finisher (optional) is installed in either the ES9460 
MFP/ES9470 MFP/CX3535 MFP/CX4545 MFP, or the Saddle Stitch Finisher MJ-1106 (optional) is installed in 
the ES9160 MFP/ES9170 MFP.

8) Staple Down the Center
Select this check box to double-staple in the center.

[Staple Down the Center] is available only when [A5 on A4], [A4 on A3], [B5 on B4], [Letter - Half on Letter], [LT on 
LD], [1/2 LG on LG], or [16K on 8K] is selected at the [Output Document Layout] box and the Saddle Stitch Finisher 
(optional) is installed.

9) [Restore Defaults]
Click this to restore the settings displayed in the [Booklet Details] dialog box to the original factory defaults.

For detailed instructions on how to print with the [Booklet] setting, see the following page:
 P.94 “Making a booklet”



2.PRINTING FROM WINDOWS

Setting Up Print Options    43

2 PRINTING FROM WINDOWS

 [Paper Handling] tab
The [Paper Handling] tab allows you to enable Front Cover printing, Back Cover printing, Inserting Pages, and Interleaving 
Pages.

 “Use Front Cover”, “Use Back Cover”, “Insert Pages” and “Interleave Pages” are not available when the Tab 
printing function is set. 

 When the size of covers or sheets to be inserted is the same as that of the copy paper, change the media type or 
specify “Paper Source” on the [Basic] tab menu; otherwise all data will be printed from the insertion drawer.

 If you select [Store to e-Filing] in the [Print job] box, [Use Front Cover], [Use Back Cover], [Insert Pages] and 
[Interleave Pages] are unselectable. 

1) Use Front Cover
This sets front cover printing which allows you to insert or print a cover on a sheet fed from a different Drawer or 
Bypass tray other than the Paper Source option selected on the [Basic] tab.
To enable cover printing, select the check box and select the location from where a cover sheet is to be fed and the 
print style to be used.

For detailed instructions on how to print with the [Use Front Cover] setting, see the following page:
 P.100 “Inserting different types of paper”

Source
Select the location from where a front cover sheet is to be fed. When [Auto] is selected, the paper is automatically 
selected according to the printed document size.

The selectable values in the [Source] box vary depending on the optional devices installed on this equipment and 
their configuration on the [Device Settings] tab.
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Print Style
This selects how you want to print a front cover.
- Do not print on page — Select this to insert a blank cover.
- Print one side of the page — Select this to print the first page image on the front side of a cover.
- Print both sides of page — Select this to print the first two page images on both sides of a cover. This is available 

only when the 2-Sided Printing option is enabled on the [Finishing] tab.

If [Print one side of the page] is selected while 2-Sided Printing is performed, the first page is printed on the front 
side of the cover sheet and the back side of the cover will be blank.

2) Use Back Cover
This sets back cover printing which allows you to insert or print a back cover on a sheet fed from a different Drawer or 
Bypass tray other than the Paper Source option selected on the [Basic] tab.
To enable back cover printing, select the check box and select the location from where a back cover sheet is to be fed 
and the print style to be used.

For detailed instructions on how to print with the [Use Back Cover] setting, see the following page:
 P.100 “Inserting different types of paper”

Source
Select the location from where a back cover sheet is to be fed. When [Auto] is selected, the paper is automatically 
selected according to the printed document size.

The selectable values in the [Source] box vary depending on the optional devices installed on this equipment and 
their configuration on the [Device Settings] tab.

Print Style
This selects how you want to print a back cover.
- Do not print on page — Select this to insert a blank cover.
- Print one side of the page — Select this to print the last page image on the front side of a cover.
- Print both sides of page — Select this to print the last two page images on both sides of a cover. This is available 

only when the 2-Sided Printing option is enabled on the [Finishing] tab.

 If [Print one side of the page] is selected while 2-Sided Printing is performed, the last page is printed on the 
front side of the cover sheet and back side of the cover will be blank.

 If [Print both sides of page] is selected but there is only one page printed on the back cover, the last page is 
printed on the front side of the cover sheet and back side of the cover will be blank.

3) Insert Pages
This sets sheet insertion printing which allows you to insert a sheet between pages, or print a specific page on a sheet 
fed from a tray other than the Paper Source option selected on the [Basic] tab.
This option is useful when you want to insert a blank sheet between chapters, or when you want to print chapter cover 
pages on the different paper.
To enable sheet insertion printing, select the check box and click [Edit] to set how the pages are inserted in the [Insert 
Pages] dialog box.
 P.46 “Insert Pages”

 This option cannot be set when the [Interleave Pages] option is enabled.
 Up to 50 pages can be inserted.

For detailed instructions on how to print with the [Insert Pages] setting, see the following page:
 P.100 “Inserting different types of paper”
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4) Interleave Pages
This sets the interleaving page feature that is useful when you want to insert paper of a different type (or from another 
source) between every page of your print job. For example, you can use this option to insert blank, colored sheets 
between overhead transparencies.
To enable interleaving pages, select the check box and select the location from where sheets are to be fed.

 When this option is enabled as well as the [Use Front Cover] and [Use Back Cover] options enabled, no page is 
inserted after the front cover and back cover.

 This option cannot be set when [Insert Pages] option is enabled.

For detailed instructions on how to print with the [Interleave Pages] setting, see the following page:
 P.102 “Interleaving pages”

Source
Select the location from where the interleaving sheet is to be fed. When [Auto] is selected, the paper is automatically 
selected according to the printed document size.

The selectable values in the [Source] box vary depending on the optional devices installed on this equipment and 
their configuration on the [Device Settings] tab.

Duplicate
When you select this check box, you can print previous page images on the inserted sheet.
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Insert Pages

1) Page
Enter the page number where the sheet is to be inserted.
When [Blank] is selected from the [Print Style] box, the blank sheet is inserted before the entered pages.
When [1 Side] is selected from the [Print Style] box, the entered page will be printed on the inserted sheet.

2) Print Style
This selects how you want to print on insertion sheets.
- Blank — Select this to insert blank sheets.
- 1 Side — Select this to print the specified page on the front side of the insertion sheets.
- 2 Sides — Select this to print the specified page and the next page on both sides of the insertion sheets.

3) Paper Source
Select the location from where the insertion sheets are to be fed. When [Auto] is selected, the paper is automatically 
selected according to the printed document size.

The selectable values in the [Paper Source] box vary depending on the optional devices installed on this 
equipment and their configuration on the [Device Settings] tab.

4) Paper Type
Select the paper type to be inserted.

5) Use Tab Paper
Select this check box when you insert a sheet of tab paper between two specified pages or print the data of the 
specified page in the originals on the inserted tab paper.
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6) Tab Manufacturer
Select the product name of the tab paper that you use. This equipment supports the following tab paper.

If you use tab paper other than those above, select [Custom]. When you select [Custom], you must specify the tab 
extension manually.

7) Number of tabs per Bank
Enter the number of tabs for each tab set. This must be set only when [Custom] is selected in the [Tab Manufacturer] 
option.

8) Tab Extension
Enter the width of the tab extension. This must be set only when [Custom] is selected in the [Tab Manufacturer] option.

9) Image Shift Width
Enter the width to shift the printed image.
For example, if you want to print text on the tab extension of Letter Tab paper, create a Letter sized document and 
input the text on the right side. Specify the distance the printed image is shifted in printing on tab paper.

 When creating a document for tab printing, you must place the text at the exact height to fit the tab extension.
 The selectable range of the edge margin differs depending on the model. See the following for setting this 

option:
- For the ES9460 MFP/ES9470 MFP/CX3535 MFP/CX4545 MFP

The margin between the shifted text and right edge of the tab extension must have at least 0.17 inches (4.2 
mm) of space because any data in this space are not printed. Enter the same value in the [Tab Extension] 
box and the [Image Shift Width] box.

- For the ES9160 MFP/ES9170 MFP
The margin between the shifted text and right edge of the tab extension must have at least 0.08 inches (2.0 
mm) of space because any data in this space are not printed. Enter the same value in the [Tab Extension] 
box and the [Image Shift Width] box.

For models other than the above, refer to the corresponding Printing Guide.

For Letter Tab: Blanks USA copy Tabs (5 Banks) LT + 1/2" Tab
Blanks USA copy Tabs (8 Banks) LT + 1/2" Tab

For A4 Tab: KOKUYO A4-S (5 Banks)
King JIM A4-S (5 Banks)
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10) Units
Select the unit for the Tab Extension and Image Shift option. The default unit varies depending on the regional setting 
of the client computer.

 Tab paper must be fed from the bypass tray. Make sure to place it with its tab outside. The shape of the bypass tray 
differs depending on the model.

 The tab paper cannot be fed from the Large Capacity Feeder (optional) and drawers.
 If the document for tab printing is not created properly or the [Image Shift Width] is not set properly, the image will 

not be printed in the correct position within the tab extension. Please make sure to create the document and set the 
[Image Shift Width] correctly.

 If misprinting occurs while multiple tab pages are printed continuously, dirt may adhere to the reverse side of paper. 
To avoid this, it is recommended to print tab paper as a separated job for each page so that this equipment 
performs cleaning before printing the next tab paper.

 When printing tab paper, the tab paper may be caught in the exit in the inner tray because the roller to deliver the 
tab extension does not exit. In that case, remove the tab paper before printing the next job.

 If [Blank] is selected while 2-sided printing is performed, and you enter an even numbered page (printed on the 
back side of the paper: Page 4 in the following example figure) for the [Page] box, the specified page will be blank. 
The desired blank sheet is inserted next and the 2-sided printing continues from the next page.

 If [1 Side] is selected while 2-sided printing is performed, the specified page (Page 3 in the following example 
figure) is printed on the front side of the sheet and back side of the sheet will be blank.

 If [1 Side] is selected while 2-sided printing is performed, and you enter an even numbered page (printed on the 
back side of the paper: Page 4 in the following example figure) for the [Page] box, the specified page will be blank. 
The page is printed on the front side of the inserted sheet and the 2-sided printing continues from the next page.

 If [2 Sides] is selected while 2-sided printing is performed, and you enter an even numbered page (printed on the 
back side of the paper: Page 4 in the following example figure) for the [Page] box, the specified page will be blank. 
The specified page and the next page are printed on the inserted sheet and the 2-sided printing continues from the 
next page.

Place the tab paper

with the tab outside.
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 [Image Quality] tab
The [Image Quality] tab allows you to select how images are printed. You can easily select the appropriate image quality 
depending on the type of document.

The available setup items for this option differ depending on which MFP is used, color or black and white.

For multifunctional digital color system (Color MFP)

For multifunctional digital system (Black and White MFP)
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1) Image Quality Type
This sets how colors are printed by selecting the job type. The printer driver automatically applies the proper image 
quality for the selected job type. You can select a pre-defined image quality type, or you can select a custom image 
quality type that you created. The custom image quality type can be created or modified by clicking [Setting].
- General — Select this to apply the proper image quality for printing a general color document.
- Photograph — Select this to apply the proper image quality for printing photos.
- Presentation — Select this to apply the proper image quality for printing a vivid document.
- Line Art — Select this to apply the proper image quality for printing a document contain a lot of characters or line 

art.
- Advanced — Select this to apply a profile which can adjust color space. The [Advanced] option is available only for 

the PS/XPS Printer driver.

 This option is available only when your equipment is a multifunctional digital color system. 
 The Image Quality type option is not available when [Black and White] or [Twin Color] is selected at the [Color] 

box on the [Basic] tab.

2) [Setting]
Click this to customize an image quality setting. When this is clicked, the [Setting] dialog box appears. You can set up 
to 20 custom image quality settings.
 P.51 “Setting: [Basic] tab”
 P.54 “Setting: [Color Balance] tab”
 P.55 “Setting: [Image Attribute] tab”
 P.56 “Setting: [Advanced] tab”

 This option is available only when your equipment is a multifunctional digital color system. 
 In order to create a new custom image quality setting, you must access the printer driver properties from the 

[Devices and Printers] folder (Windows Vista / Windows Server 2008: [Printer], Windows XP / Windows Server 
2003: [Printers and Faxes]), but not from the [Print] dialog box in the application.

3) [Delete]
Click this to delete the custom image quality setting. When you click this, the confirmation dialog box appears. Click 
[Yes] to delete the setting.

This option is available only when your equipment is a multifunctional digital color system. 

4) Halftone
This sets how halftones are printed.
- Auto — Select this to print using proper halftone depending on the contents in the document automatically.
- Detail — Select this to print halftone in detail.
- Smooth — Select this to print halftone smoothly.

 This option is available only when your equipment is a multifunctional digital system. 
 When the PCL Printer driver is used, [Auto] cannot be selected in the ES9160 MFP/ES9170 MFP. The default 

is [Detail].

5) Smoothing
Select this check box to print texts and graphics smoothly.

This option is available only when your equipment is a multifunctional digital system. 

6) Distinguish Thin Lines
Select this check box to print thin lines clearly.

This option is available only when your equipment is a multifunctional digital system. 
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7) Use Black for All Text
Select this check box to print all texts in 100% black except white texts.

This option is available only when your equipment is a multifunctional digital system. 

Setting: [Basic] tab

In the [Basic] tab of the [Setting] dialog box, you can specify the following functions.

The print options in the [Basic] tab are available only when your equipment is a multifunctional digital color system. The 
setup items differ depending on the model. For setup items other than below, refer to the corresponding Printing 
Guide. 

[Basic] tab for PCL/XPS Printer

[Basic] tab for PS Printer
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1) Save Current Settings as
Select this check box to save the settings as the different setting. When this box is cleared, the Image Quality Type that 
you selected will be undefined. Up to 20 custom image quality types can be created.

This check box is available only when you display printer driver properties from the [Devices and Printers] folder 
(Windows Vista / Windows Server 2008: [Printer], Windows XP / Windows Server 2003: [Printers and Faxes]).

Name
Enter the Image Quality type name to be created. This must be entered when [Save Current Settings as] is selected.

 When you edit an existing custom Image Quality Type, the settings of this Image Quality Type will be 
overwritten regardless of whether or not this Image Quality Type is renamed.

 Even if you enter any of the default Image Quality Type names ([General], [Photograph], [Presentation], [Line 
Art] or [Advanced]) registered as default settings, these default Image Quality types will not be overwritten. The 
Image Quality Type is saved as a new custom Image Quality Type under the name you have specified. 

Original Image Quality Type
Select the image quality type to be applied as the based image quality.

2) Halftone
This sets how halftones are printed.
- Auto — Select this to print using proper halftone depending on the contents in the document automatically.
- Smooth — Select this to print halftone smoothly.
- Detail — Select this to print halftone in detail.

3) Resolution
- 600 dpi (Fixed)

4) Use Black for All Text
Select this check box to print all text in 100% black except white texts.

The [Use Black for All Text] option is available only for the PCL Printer/XPS printer driver.

5) Distinguish Thin Lines
Select this check box to print thin lines clearly.

6) Pure Black
Select this check box to print the black contents using black toner. When this box is selected, please select how this 
function applies in the [Apply to] box.

7) Pure Gray
Select this check box to print the gray scale contents using black toner. When this box is selected, please select how 
this function applies in the [Apply to] box.

The Pure Gray option is not available when [Pure Black] is not enabled.
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8) Apply to
Select how the Pure Black and Pure Gray functions apply.
- Auto — Select this to automatically select areas to be printed using black toner when you want to print the black 

(or black and gray scale) contents using its toner. When this option is selected, appropriate areas are printed using 
black toner according to the Image Quality Type option.

- Text — Select this to print only black text or black-and-gray text using black toner.
- Text & Graphic — Select this to print only black text and graphics, or black-and-gray text and graphics using black 

toner.
- Text, Graphic & Image — Select this to print all black areas or all black-and-gray areas using black toner.

9) Black Overprint
Select this check box when printing background content that has black text overlaid on it. If this is enabled, the gap 
between the text and the background is minimized and color deviation is prevented. If this is not enabled, the 
background of the black content will not be printed.

The [Black Overprint] option is available only for the PS printer driver.

10) Apply to
Select how the Black Overprint functions apply.
- Text — Select this to print all the full-color background and then print black text on the color background.
- Text & Graphic — Select this to print all the full-color background and then print black text and graphics on the 

color background. 

The [Apply to] option is available only for the PS printer driver.

11) PostScript Overprint
Select this to enable overprint an object that has been set so on an application.

This print option is selectable only when a PS printer driver is used.

12) [Restore Defaults]
Click this to restore all the image quality setting details displayed in the [Basic] tab menu to the original factory defaults.
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Setting: [Color Balance] tab

In the [Color Balance] tab of the [Setting] dialog box, you can specify the following functions. Adjust the density level by 
moving the scroll bar, or pressing buttons on the right and left of the scroll bar.

This option is available only when you have a multifunctional digital color system. The setup items differ depending on 
the model. For setup items other than those below, refer to the corresponding Printing Guide.

1) All Colors
Adjust the density of all the colors.

2) Each Color
Adjusts the density of each color for printing. You can set from -4 to 4.

3) Detail
Select this check box to adjust the density of each color separately in details. When this box is selected, click [Edit] to 
display the [Color Balance Detail] dialog box and specify the density of each color.

— Color Balance Detail
In the [Color Balance Detail] dialog box, you can specify the density of low, middle, and high colors for each color.
- Low — Change this density to adjust the density of light color.
- Middle — Change this density to adjust the density of half color.
- High — Change this density to adjust the density of deep color.
- Restore Defaults — Click this to restore all the image quality setting details displayed in the [Color Balance Detail] 

dialog box to the original factory defaults.

4) [Restore Defaults]
Click this to restore all the image quality setting details displayed in the [Color Balance] tab menu to the original factory 
defaults. 
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Setting: [Image Attribute] tab

In the [Image Attribute] tab of the [Setting] dialog box, you can specify the following functions. Adjust the density level by 
moving the scroll bar, or pressing buttons on the right and left of the scroll bar.

This option is available only when you have a multifunctional digital color system. The setup items differ depending on 
the model. For setup items other than those below, refer to the corresponding Printing Guide.

1) Contrast
Adjust the contrast for printing. You can set from -4 (lowest) to 4 (highest).

2) Brightness
Adjust the brightness for printing. You can set from -4 (darkest) to 4 (lightest).

3) Background Adjustment
Adjust the background adjustment for printing. You can set from -4 (lightest) to 4 (darkest).

4) Saturation
Adjust the saturation for printing. You can set from -4 (low clear) to 4 (high clear).

5) Use Sharpness Filter
Select this check box when you use a sharpness filter. You can set from -4 (softest) to 4 (sharpest).

6) [Restore Defaults]
Click this to restore all the image quality setting details displayed in the [Image Attribute] tab menu to the original 
factory defaults. 
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Setting: [Advanced] tab

In the [Advanced] tab of the [Setting] dialog box, you can set the functions below.
The color profile data of this equipment may be updated. If the SNMP communication between this equipment and your 
computer is available, open the [Advanced] tab menu and then click [Update Now] to obtain the updated color profile data.

 This option is available only when you have a multifunctional digital color system. The setup items differ depending 
on the model. For setup items other than below, refer to the corresponding Printing Guide.

 The [Advanced] tab menu is displayed when [Advanced] is selected in [Image Quality]. The [Advanced] option is 
available only for the PS/XPS Printer driver.

Color profiles can also be set from the TopAccess menu. For the detailed instructions on how to set color profiles from 
the TopAccess menu, refer to the TopAccess Guide.

1) RGB Source Profile
This selects the RGB source profile. When you obtained color profile data from this equipment, the RGB source profile 
data of this equipment appear.

2) CMYK Source Profile
This selects the CMYK source profile. When you obtained color profile data from this equipment, the CMYK source 
profile data of this equipment appear.

3) Apply to Device Color Only
Select this check box when you give priority to color profiles embedded in the image.

4) Destination Profile
This selects the destination profile. When you obtained color profile data from this equipment, the destination profile 
data of this equipment appear.

5) Rendering Intent
This selects the method for color space conversion when you print images.
- Printer’s Default — Color space conversion is performed according to the default profile.
- Perceptual — This is recommended for photo images.
- Relative Colorimetric — More original colors can be retained than those when you select [Perceptual].
- Saturation — This is recommended when the vividness of colors is more important than their correct reproduction. 

It is useful for graphic charts.
- Absolute Colorimetric — Original colors can be retained even on colored paper.

6) [Restore Defaults]
Click this to restore all the image quality setting details displayed in the [Advanced] tab menu to the original factory 
defaults. 

7) [Update Now]
Click this to obtain the latest color profile data set for this equipment and update the existing color profile data. This is 
enabled only when SNMP communication with this equipment is enabled.
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[Printer’s Default] is a default setting for RGB Source Profile, CMYK Source Profile, Destination Profile and 
Rendering Intent. When you select [Printer’s Default], color space conversion is performed according to the default 
profile (that set as a default profile in the [ICC Profile] submenu of the [Setup] menu in the TopAccess administrator 
mode).

 [Effect] tab
The [Effect] tab contains print options that add effects to your print jobs such as Watermarks, Overlay Image printing, 
Rotate printing, Mirror printing, and Negative/Positive printing.

[Effect] tab for PCL Printer

[Effect] tab for XPS Printer
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[Effect] tab for PS

1) Watermark
This selects the watermark to be used or edited. The following values except [None] are the default watermarks that 
have been registered in the printer driver. Up to 15 new watermarks can be added in this box.
- None — Select this if no watermark is desired.

The following default watermarks are also displayed in the box:
- TOP SECRET
- CONFIDENTIAL
- DRAFT
- ORIGINAL
- COPY

For the detailed instructions on how to print with the [Watermark] setting, see the following page:
 P.103 “Printing with watermarks”

[Add]
Click this to create a new watermark. The [Watermark] dialog box appears when you click on this.
 P.60 “Add/Edit Watermark”

[Edit]
Select a watermark from the [Watermark] box and click it to edit the watermark. The [Watermark] dialog box appears 
when you click on this.
 P.60 “Add/Edit Watermark”

[Delete]
Select a watermark from the [Watermark] box and click it to delete a watermark.
 P.105 “Deleting a watermark”

 The default watermarks can be deleted but, once deleted, they cannot be restored.
 [None] cannot be deleted.

Print on First Page Only
Select this check box to print a watermark on the first page only. This setting will become available when any 
watermark is selected from the [Watermark] box.

1

2

3
5



2.PRINTING FROM WINDOWS

Setting Up Print Options    59

2 PRINTING FROM WINDOWS

2) Overlay Image
This selects an overlay image to be used. This feature allows you to print an image on the background of a print job, 
although the watermark allows only text.

 When [Overlay Image] is selected together with the N-up printing, 1 overlay image will be printed on the entire 
page, regardless of the number of images set in 1 page.

 Both the overlay file and the documents on which you superimpose the overlay image must be created in the 
same size, color mode and orientation.

 If you want to use an overlay image in your job, you must first create an overlay file. To do this, create an 
overlay image with most applications and print it as an overlay file. You can enable creating an overlay file on 
the [Print Job] box.
 P.83 “Printing a document as an overlay file”

 For the detailed instructions on how to print with the [Overlay Image] setting, see the following page:
 P.106 “Printing with an overlay file”

[Details]
Click this to set which overlay image is applied to which page, such as changing the type of overlay image for odd 
pages and that for even pages or applying an overlay image only to the specified pages. 
If you click this when [Multiple Overlays] is selected in the [Overlay Image] box, the [Multiple Overlays] dialog box 
appears.
 P.61 “Multiple Overlays”

[Delete]
Click this to delete the overlay image that you select in the box.
 P.107 “Deleting an overlay image”

[None] and [Multiple Overlays] cannot be deleted.

Print Over the Document
Select this check box to print an overlay image over the document.

Print on Each Page
This selects whether overlay images are printed for each page or paper when multiple pages are printed on one sheet 
with options such as Number of pages per sheet or Booklet. Select this check box when overlay images are printed for 
each page.

3) Rotate 180 Degrees
Select this check box to perform rotation printing of an image.

4) Mirror
Select this check box to perform mirror printing of an image.

This print option is not displayed for the PCL/PS printer driver.

5) Negative/Positive
Select this check box to perform negative printing of an image.

 This print option is disabled for the PCL printer driver.
 The Negative/Positive option is available only when [Black and White] is selected at the [Color] box on the 

[Basic] tab.
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Add/Edit Watermark

When you click [Add] or [Edit], the [Watermark] dialog box appears and you can create new watermark or edit selected 
watermarks.

1) Position
Select this to adjust the position of the watermark. Click the arrow button or [+] located at the center to adjust it.

2) Caption
Enter the text of a watermark. You can enter up to 63 alphanumeric characters. 
When you are editing a watermark, the selected watermark text is displayed in the box.
The entered text is displayed as the sample image on the left.

3) Font Name
Select the font to be used for the watermark text.

4) Style
Select the font style for the watermark text.
- Regular — Select this to set the regular style to the text.
- Bold — Select this to set the bold style to the text.
- Italic — Select this to set the italic style to the text.
- Bold Italic — Select this to set the bold and italic style to the text.

5) Font Size
Enter the font size for the watermark text. The font size can be set from 6 to 300 pt in units of 1 pt.

6) Color
Select the color of the watermark text. If the color that you require is not listed in the box, click [Browse] to add new 
color.

 This option is available only when your equipment is a multifunctional digital color system. 
 When [Black and White] is selected at the [Color] box on the [Basic] tab, this option will be disabled.

7) Angle
Enter the degree of angle for rotating the watermark text. The angle can be set from -90 to 90 degrees in units of 1 
degree. You can also set the degree of the angle by moving the scroll bar.

8) Solid
Select this to print a solid type of watermark.

9) Draw as Outline
Select this to print a outline type of watermark.

10) Transparency
Select this to print a transparent watermark. When you select this, set the brightness from 0 (darker) to 100% (lighter) 
in units of 1%. You can also set the brightness using the scroll bar.

11) [Restore Defaults]
Click this to restore the settings displayed in the [Watermark] dialog box to the original factory defaults.
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Multiple Overlays

If you click [Details] when [Multiple Overlays] or the desired overlay is selected in the [Overlay Image] box, the [Multiple 
Overlays] dialog box appears. Set which overlay image is applied to which page in this dialog box.

1) Overlay Images
The registered overlay images are displayed in a thumbnail. Select the desired overlay image.

You can drag and drop an overlay image in the thumbnail to the desired overlay group (Master Setting 1/2 or 
Setting 1/2/3/4/5/6) to set directly. If another overlay image is already set in the selected group, the overlay image 
is overwritten.

2) [ ↓ ] (Master Setting)
This sets the overlay image selected in the [Overlay Images] box in the [Master Setting] field. Selection is switched in 
the order of [Master Setting 1] to [Master Setting 2] every time you click this.

3) [ ↓ ] (Setting)
This sets the overlay image selected in the [Overlay Images] box in the [Setting] field. Selection is switched in the order 
of [Setting 1], [Setting 2], [Setting 3], [Setting 4], [Setting 5] and [Setting 6] every time you click this.

4) Master Setting 1/2
This sets if the selected overlay image is applied to all, even or odd pages. 
- All — Select this to apply the chosen overlay image to all pages.
- Even — Select this to apply the chosen overlay image only to even pages.
- Odd — Select this to apply the chosen overlay image only to odd pages.

  If the specified pages are overlapped among multiple master settings, the setting of [Even] or [Odd] has priority 
over that of [All].

 If the specified pages are overlapped in both settings of [Master Setting] and [Setting], the setting of [Setting] 
has priority over that of [Master Setting].

5) Setting 1/2/3/4/5/6
This sets pages to which the selected overlay image is applied by page number. To specify more than one page, 
delimit with commas such as “1, 3, 5”. To specify pages in a range, use a hyphen between the first and the last pages, 
such as “6-10”.
- Page — Select this to apply the selected overlay image only to the specified pages.

If the specified pages are overlapped among multiple settings, the newer setting has priority.
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6) Select setting to clear
This selects the overlay image setting to be cleared.

7) [Clear]
This clears the overlay image setting selected in the [Select setting to clear].

8) [Restore Defaults]
Click this to restore the settings displayed in the [Multiple Overlays] dialog box to the original factory defaults.
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 [Others] tab
The [Others] tab contains print options such as toner saving, custom paper size and so on.

1) Default Menu Setting
Select the default tab that is displayed when you open the printing preferences of the printer driver. Set frequently used 
functions as a default menu setting for your convenience.

If you made settings on the [Others] tab menu from the print setting page of the application, they are restored to the 
defaults when you close the printer driver.
If you want to resume the settings, set the printer driver from the [Devices and Printers] folder.
 P.19 “Setting initial values of print options”

2) TopAccess (Link)
Click this to start a web browser and display the TopAccess menu.

3) Toner Save
Select this check box to print in the toner save mode.

When the toner save mode is enabled, printing may become lighter.

4) Do not Print Blank Pages
Select this check box to ignore blank pages for printing. 
If the Watermark feature is enabled, all pages will be printed even when the content is blank. 

The pages having a header or footer will be printed even if the content is blank.

5) Letterhead Print Mode
Select this check box to perform duplex printing on paper whose sides need to be distinguished, such as paper with 
illustrations on one side.
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6) SNMP Communication
This enables SNMP communication between this equipment and your computer to retrieve the option configuration 
information.

If you disable SNMP Communication, Local Discovery notification also will be disabled.

7) [SNMP Settings]
Click this button when you need to verify or change the SNMP settings.
 P.66 “SNMP Settings”

In order to set [SNMP Settings], you must access the printer driver properties from the [Devices and Printers] folder 
(Windows Vista / Windows Server 2008: [Printer], Windows XP / Windows Server 2003: [Printers and Faxes]), but 
not from the [Print] dialog box in the application.

8) [Output Devices]
This switches the equipment to be used for printing or splits one print job between two pieces of equipment (Tandem 
Printing).
 P.113 “Switching equipment to print jobs”
 P.115 “Splitting a print job across two pieces of equipment (Tandem Printing)”

9) [Add Printer]
This discovers the OKI MFP series equipment over a network and adds it on [Printer Folder].
 P.67 “Add Printer”

10) [Custom Paper Size]
Click this to specify the custom paper size. The [Custom Paper Size] dialog box appears when you click this.
 P.68 “Custom Paper Size”

 In order to set [Custom Paper Size], you must access the printer driver properties from the [Devices and 
Printers] folder (Windows Vista / Windows Server 2008: [Printer], Windows XP / Windows Server 2003: 
[Printers and Faxes]), but not from the [Print] dialog box in the application.

 The [Custom Paper Size] can be set only by an operation with the administrator privilege.

11) User name (Alias)
Enter a nickname as required, which is displayed on the Private Print job list and Hold Print job list. You can specify the 
desired name so that you can easily find the target job from the job list when releasing it from the equipment’s touch 
panel.

 Up to 31 characters can be entered for the [User name (Alias)] box.
 The user name that is entered to log in to your computer is initially used for [User name (Alias)]. If the user 

name is not changed, the log-in user name is displayed on the Private Print job list and Hold Print job list.
 The nickname entered for the [User name (Alias)] box is applied only to the Private Print job list and Hold Print 

job list. On other job list screens (Scheduled Print jobs / Invalid jobs) and the Print Log screen, the log-in user 
name is always displayed.
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12) Department Code
Enter the user’s department code if the system is managed with department codes. Please ask your administrator for 
your department code.

 When the User Management setting is enabled, it is used to manage a print job instead of the Department 
Code Management setting. In this case, a user name that has been entered to log in to your computer is used 
for the authentication of the print job. Therefore, you do not need to set your department code to the printer 
driver but you must register your user name in advance. If your user name is not registered, the print job is 
processed as an invalid one according to the User Authentication Enforcement setting. Also if a print job is sent 
in RAW format, it is processed according to the RAW Print Job setting. For more information about the User 
Authentication Enforcement setting or the RAW Print Job setting, refer to the TopAccess Guide.

 If the No Limit Black function is enabled, you do not have to specify the department code when you print a 
document with selecting [Black and White] in the [Color] option in the [Basic] tab of the printer driver.

 If the number of the printed sheets for a print job exceeds the output limitation for the entered department code, 
the print job is stored in the invalid department code print job list without printing. When you want to print the 
print job, perform printing from [JOB STATUS] on the touch panel by entering another department code for 
which the output limitation is more than the number of printed sheets.

 In the [Department Code] box, you can enter a department code within 63 characters.

How the equipment performs printing for an invalid department code print job, for which an invalid department code 
is specified, varies depending on the Invalid Department Code Print Job setting that can be set in the TopAccess 
Administrator mode and whether SNMP communication is enabled or not. 
- When SNMP communication is enabled and Invalid Department Code Print Job is set to [Store to invalid job 

list], an error message will be displayed when an invalid department code is entered. 
- When SNMP communication is disabled and Invalid Department Code Print Job is set to [Store to invalid job 

list], the invalid department code print job will be stored in the invalid department code print job list without 
printing. 

- When the Invalid Department Code Print Job is set to [Print], the invalid department code print job will be 
printed.

- When the Invalid Department Code Print Job is set to [Delete], the invalid department code print job will be 
deleted. 

13) Hide Department Code
Select this check box to display a department code in the blank symbols.

14) Server Name
Enter the desired LDAP server if needed.

Up to 64 characters (excluding #   ;   \   =) can be entered for the [Server Name] box.

15) [Import]
Click this to import custom settings (e.g. template, watermark, overlay, image quality type, custom paper size, profiles) 
to the printer driver.

How to import custom settings
- Click [Import]. A dialog box to select a file appears. Select a file (*cfu for PCL Printer, *cfp for PS, *cfv for XPS) to 

be imported.
- Click [Open]. A dialog box to confirm if you overwrite the file appears. Then click [OK].

In order to set and perform [Import], you must access the printer driver properties from the [Devices and Printers] 
folder (Windows Vista / Windows Server 2008: [Printer], Windows XP / Windows Server 2003: [Printers and 
Faxes]), but not from the [Print] dialog box in the application.
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16) [Export]
Click this to export custom settings (e.g. template, watermark, overlay, image quality type, custom paper size, profiles) 
from the printer driver.

How to export custom settings
- Click [Export].
- The [Save as] dialog box appears. Specify a file name and a directory. Then click [Save].

In order to set and perform [Export], you must access the printer driver properties from the [Devices and Printers] 
folder (Windows Vista / Windows Server 2008: [Printer], Windows XP / Windows Server 2003: [Printers and 
Faxes]), but not from the [Print] dialog box in the application.

17) [Restore All Defaults]
Click this to return settings in all the tab menus other than the [Device Settings] tab menus to the default ones. A 
confirmation dialog box appears as you click this, and if you click [OK], print settings in all the tab menus will return to 
the default ones.

If you want to change the settings in the [Font] and [Device Settings] tab menus, you need to access with the 
administrator privilege from the Printers folder. For the details, see the following page:
 P.69 “[Device Settings] tab”

18) [Version Information]
Click this to display the [Version Information] dialog box.

SNMP Settings

1) Version
Be sure to have the correct SNMP version set for your OKI MFP and select from the following options:
- V1/V2 — Select this option to enable SNMP V1 and V2.
- V3 — Select this option to enable SNMP V3.
- V1/V2/V3 (for [Discovery Settings] dialog box only) — Select this option to enable SNMP V1, V2, and V3.

2) SNMP V1/V2
Community Name—If a community name other than “private” (default) is set for the SNMP community name for your 
OKI MFP, enter its community name.

 To find your OKI MFP under the SNMP V1/V2 environment, the community names set for the target OKI MFP 
must be specified correctly. For help, consult your administrator.

 To change the community name, the administrator privilege is necessary. You must log in with the 
“Administrator” privilege and open the printer driver properties.

 Up to 31 characters including the following symbols can be entered for the Community Name.
! " # $ % & ' ( ) * + , - / : ; < = > ? @ [ \ ] ^ _ ` { | } ~
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3) SNMP V3
If SNMP V3 is enabled, select one of the following items to set how users are authenticated.
User ID File — Select this option when you want to use a user ID file. Click [Browse] and specify the user ID file.
User Name/Password — Select this option when you want to use the user name and password. When this option is 
selected, use the keyboard to select the following items:
- User Name
- Authentication Protocol
- Authentication Password
- Privacy Protocol
- Privacy Password

 If you select to enable SNMP V3, consult your network administrator for preliminary advice on how to 
authenticate users.

 Up to 31 characters including the following symbols can be entered for each of the User Name, Authentication 
Password and Privacy Password.
! $ % & ' ( ) - , < > @ [ ] ^ _ ` { } ~

4) [Restore Defaults]
Click this button when you want to reset all the settings back to the defaults.

Add Printer

1) Discovered Printers
This displays the OKI MFP series discovered over a network. You can check its name, installation site, model name 
and status.

The OKI MFP series to be discovered differ depending on the settings on the [Device Settings] tab or the type of 
your printer driver.
 If any of the models below is selected in the [Model Selection] box on the [Device Settings] tab, only they can 

be discovered and other OKI MFP series models are not.
- ES9160 MFP
- ES9170 MFP
- ES9460 MFP
- ES9470 MFP
- CX3535 MFP
- CX4545 MFP

 If [PCL] is selected in the [Model Selection] box on the [Device Settings] tab, any OKI MFP series model to 
which your printer driver can be applied is discovered.

2) [Add]
This adds the printers selected in the [Discovered Printers] box to [Printer Folder].
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3) [Information]
This indicates the basic information of the printer selected in the [Discovered Printers] box. You can check the 
availability of color printing, 2-sided printing or stapling, its copying speed, resolution and the type of paper placed.

4) Available Printer List
This indicates the OKI MFP series printers registered in [Printer Folder].

Custom Paper Size

In the [Custom Paper Size] dialog box, up to 20 custom paper sizes can be defined. The custom page size that you specify 
can be selected in the [Original Paper Size] and [Print Paper Size] box on the [Basic] tab.

The defined custom paper size setting can be used in common for the PCL/PS/XPS printer drivers.

1) Paper Size List
Select the custom paper size that you want to modify.

2) Name
Enter the custom paper size name. You can enter up to 63 characters. This name will be displayed in the [Original 
Paper Size] and [Print Paper Size] box on the [Basic] tab.

3) Paper Size
Enter A (Length) and B (Width) to specify the paper size.

The selectable range of A (length) and B (width) differs depending on the model. Select values within the range 
shown on the right of each.

4) Units
Select the unit for the paper size. The default unit varies depending on the regional setting in the Windows.

5) [Add]
Click this to save the settings over the selected custom paper size that you selected in the [Paper Size List].

If you click [Add], a dialog box prompting you to confirm that the custom paper size differs depending on the model. 
Select the custom paper size that your equipment supports.

6) [Delete]
Click this to clear and restore the default settings of the selected custom paper size that you selected in the [Paper 
Size List]. When you click this, the confirmation dialog box appears. Click [Yes] to delete the setting.
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 To register a custom paper size, either A (Length) or B (Width) should differ by more than 0.3 inches (7 mm) from 
the standard paper size. If not, the created custom paper size is considered as the standard paper size.

 You cannot create a custom paper size with A (Length) longer than B (Width). If you want to print such a document, 
do so by selecting [landscape] for the [Orientation].

 There are some precautions when you use paper larger than the standard sizes. For details, see the following 
page:
 P.111 “Printing on paper larger than standard sizes”

 [Device Settings] tab
The [Device Settings] tab allows you to configure options. When any optional unit is installed in this equipment, set the 
configuration of the machine on this tab. The [Device Settings] tab can be displayed only from the Printers folder (and not 
when displaying the properties from the application’s print dialog box).

In order to set the [Device Settings] tab, you must access the printer driver properties from the [Devices and Printers] 
folder (Windows Vista / Windows Server 2008: [Printer], Windows XP / Windows Server 2003: [Printers and Faxes]). 
For detailed instructions on how to set the [Device Settings] tab, see the following page:
 P.11 “Configuring options manually”

1) Model Selection
This sets the model type.

If you select [PCL], you can narrow down the setup items of the printer driver to those used commonly in all of the 
entire OKI MFP series. It is convenient in such cases as when you are using a printer driver already installed to 
other OKI MFP models.

2) Option
This option sets whether the following optional devices are installed.

Drawers
This sets the installation of drawers according to the configuration.
- Drawer1 — Select this when only Drawer 1 is installed.
- Drawer 1 & LCF — Select this when Drawer 1 and the LCF (optional) are installed.
- Drawer 1 & Drawer 3 — Select this when Drawers 1 and 3 are installed.
- Drawer 1 & Drawer 3, 4 — Select this when Drawers 1, 3 and 4 are installed.
- Drawer 1 & Drawer 2 — Select this when Drawers 1 and 2 are installed.
- Drawer 1, 2 & Drawer 3 — Select this when Drawers 1, 2 and 3 are installed.
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- Drawer 1, 2 & Drawer 3, 4 — Select this when Drawers 1, 2, 3 and 4 are installed.
- Drawer 1, 2 & LCF — Select this when Drawers 1, 2 and the LCF are installed.

The Large Capacity Feeder (optional) is not available for some countries or regions.

3. Finisher
This sets whether or not the Finisher (optional) is installed.
- None — Select this when a Finisher (optional) is not installed.
- Hanging Finisher — Select this when a Hanging Finisher (optional) is installed.
- Finisher — Select this when a Finisher (optional) is installed.
- Saddle Stitch Finisher — Select this when a Saddle Stitch Finisher (optional) is installed.
- Job Separator — Select this when a Job Separator (optional) is installed.
- Offset Tray — Select this when a Offset Tray (optional) is installed.

4) Hole Punch Unit
This sets whether or not the Hole Punch Unit (optional) is installed.
- None — Select this when a Hole Punch Unit (optional) is not installed.
- 2 Holes — Select this when a 2 Hole Punch Unit (optional) is installed.
- 2/3 Holes — Select this when a 2/3 Hole Punch Unit (optional) is installed.
- 4 Holes (F) — Select this when a 4 hole (F) punch unit (optional) is installed.
- 4 Holes (S) — Select this when a 4 hole (S) punch unit (optional) is installed.

5) External LCF
This sets whether or not the External Large Capacity Feeder (optional) is installed.
- None — Select this when an External Large Capacity Feeder (optional) is not installed.
- External LCF — Select this when an External Large Capacity Feeder (optional) is installed.

6) Inserter Unit
Select this check box when the Inserter (optional) is installed.

This setting is selectable only when [PCL] is selected in the [Model Selection] box.

7) [Drawer Settings]
Click this to set the paper size and paper type of each drawer. The [Drawer Settings] dialog box appears by clicking 
this.
 P.71 “Drawer Settings”

8) [Account Settings]
Click this button to set whether the user management setting is enabled or not. You can also set whether the Private 
Print Restriction function and Hold Print Restriction function are enabled or not. The [Account Settings] dialog box 
appears upon clicking this button.
 P.72 “Account Settings”

9) [Customization]
This sets options specific to PCL, or changes the Plug-in settings or the printer driver language. When you click this, 
the [Customization] dialog box appears.
 P.73 “Customization: [Plug-in] tab”
 P.74 “Customization: [Language] tab”
 P.75 “Customization: [PDL Settings] tab”

The Printer Language setting is available only when a PCL printer driver is used.

10) [Version Information]
Click this to display the [Version Information] dialog box.

11) Device Settings Retrieval
This enables SNMP communication between this equipment and your computer to retrieve the option configuration 
information.

Update Automatically
Select this check box to update the option configuration information automatically every time you open the [Device 
Settings] tab. 

[Update Now]
Click this to obtain the configuration information from this equipment immediately.
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If the connection to the equipment has not been configured correctly, the message “The address of your printer 
could not be located. Would you like to find it?” will be displayed when you click [Update Now]. If it is displayed, 
click [Yes] and search for the equipment using the [Local Discovery] dialog box. After searching for the equipment, 
SNMP communication will be enabled. For the instructions on how to search for the equipment, refer to the 
instructions of Local Discovery.

If you disable SNMP Communication, Local Discovery notification also will be disabled.

12) [Restore Defaults]
Click this to restore the configuration of this equipment displayed in the [Device Settings] tab menu to the original 
factory defaults.

Drawer Settings

1) Paper Size
Select the paper size set in each drawer.

2) Paper Type
Select the paper type set in each drawer.

3) Attribute
Select the attribute of the paper. When you set the attribute, the drawer will be selected preferentially according to the 
print settings.

4) Override Application Paper Source Settings
Select this check box to use the paper source setting in the printer driver rather than the application setting.

5) [Restore Defaults]
Click this to restore the settings displayed in the [Drawer Settings] dialog box to the original factory defaults.

Drawers selectable differ depending on the model and the option configuration.
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Account Settings

When SNMP communication is enabled, the following account information is automatically obtained from the 
equipment.

1) Use User Authentication
Select this check box to enable the user management function.

2) User Name
The user name that is entered to log in to your computer is displayed.

3) Domain Name
The domain name on which the equipment belongs is displayed.

4) Private Print Restriction
Select this check box to enable the Private Print Restriction function.

5) Hold Print Restriction
Select this check box to enable the Hold Print Restriction function.

 For details and setting of the Private Print Restriction function and Hold Print Restriction function, refer to the 
TopAccess Guide.

 After you adjust settings in the [Account Settings] dialog box, make sure to confirm that the settings have been 
changed as specified in the printing preferences dialog box, accessing from the [File] menu > [Printing 
Preferences]. You can also confirm that the settings have been changed as specified on the properties page of the 
printer driver when you print documents from applications.
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Customization: [Plug-in] tab

You can enable or disable the Plug-in setting.

1) Paper Handling
Select this check box to enable the [Paper Handling] tab.
 P.43 “[Paper Handling] tab”

2) Image Quality
Select this check box to enable the [Image Quality] tab.
 P.49 “[Image Quality] tab”

3) Effect
Select this check box to enable the [Effect] tab.
 P.57 “[Effect] tab”

4) Templates
Select this check box to enable the [Templates] tab.
 P.76 “[Templates] tab”

5) Add Printer
Select this check box to enable [Add Printer] on the [Others] tab.
 P.63 “[Others] tab”
 P.67 “Add Printer”

6) Tandem Print
Select this check box to enable [Output Devices] on the [Others] tab.
 P.63 “[Others] tab”
 P.113 “Switching equipment to print jobs”
 P.115 “Splitting a print job across two pieces of equipment (Tandem Printing)”

7) [Restore Defaults]
Click this to restore the factory defaults on the [Plug-in] tab.
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Customization: [Language] tab

You can switch printer driver language.

1) Language
This selects the language to be used.
- Auto / Chinese (Simplified) / Chinese (Traditional) / Danish / Dutch / English (UK) / English (US) / Finnish / French 

/ German / Italian / Japanese / Norwegian, Bokmål / Polish / Russian / Spanish / Swedish

[Auto] is selected by default. When [Auto] is selected, the most appropriate printer driver language is automatically 
set according to the regional and language settings in Windows OS.

2) [Restore Defaults]
Click this to restore the factory defaults on the [Language] tab.

1

2



2.PRINTING FROM WINDOWS

Setting Up Print Options    75

2 PRINTING FROM WINDOWS

Customization: [PDL Settings] tab

The Printer Driver setting is available only for a PCL printer driver.

1) Output PDL
This setting is available only for PCL6.

2) Output Format
This setting is not available for this model.

3) Print Error Information
This setting is not available for this model.

4) Compress Bitmap
This sends the compressed bitmaps to this equipment.

5) JPEG Compression
This sends compressed JPEG data to this equipment.

6) [Restore Defaults]
Click this to restore the factory defaults on the [PDL Settings] tab.
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 [Templates] tab
You can register print options that you frequently use as a profile. On the [Templates] tab you can save this profile in a 
Template Button. Also you can display a dialog box for selecting Template Buttons automatically upon printing, enabling 
easy printing with profiles.
 P.23 “Setting up print options with Template Buttons”

To use a Template Button, you must first save a profile in this button. For instructions on how to save profiles, see the 
following page:
 P.20 “Setting print options using profiles”

1) Number of Copies
This sets the number of copies.

The selectable range of the number of copies:
1 copy to 999 copies

2) Template Button
Click this to apply the profile saved in a Template Button to each setting of the printer driver. 
On the Template Button, the name of the profile saved and the print image of the job appear. 5 factory default profiles 
below are saved in a Template Button. You can save up to 6 profiles, including 5 default ones.
- BW, Duplex, Staple & 2in1
- Color Booklet
- Duplex & Staple
- Duplex, Staple & 2in1
- Duplex, Staple & Punch

3) Templates Dialog Box
Select this check box to display the [Templates] dialog box automatically upon printing. You can select any of the 
Template Buttons displayed on the [Templates] dialog box. This saves you the effort of opening the printer driver menu 
and setting up profiles each time you print, in such cases as when you use profiles frequently.

4) [Edit]
This edits the Template Buttons. Click this to display the [Edit Templates] dialog box. 
 P.77 “Edit Templates”
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Edit Templates

You can edit the settings of the Template Buttons.

1) Profile
This selects the profile to be saved in a Template Button.

2) Template Button
This selects the Template Button to be edited.

3) [Save]
This saves the chosen profile in the selected Template Button. 

4) [Delete]
This deletes the settings of the selected Template Button.

The print options registered in each profile are not deleted even if you click [Delete].
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Printing With Best Functions for Your Needs

In this section, procedures are given to print various types of print jobs, using the layout and finishing options. Read this 
section before starting printing and select the procedure best suited for your needs.
 P.78 “Printing various print job types”
 P.90 “Layout and finishing options in [Basic] tab menu”
 P.92 “Layout and finishing options in [Finishing] tab menu”
 P.100 “Finishing options in [Paper Handling] tab menu”
 P.103 “Finishing options in [Effect] tab menu”
 P.108 “Using various types of paper”
 P.113 “Switching equipment to print jobs”
 P.115 “Splitting a print job across two pieces of equipment (Tandem Printing)”

 Printing various print job types
The printer drivers provide various ways to handle such jobs as Scheduled Print, Private Print, Hold Print, Proof Print, 
Overlay Image file, Store to e-Filing, and Multiple Job Type.
 P.79 “Printing scheduled print jobs”
 P.80 “Printing private print jobs”
 P.81 “Printing hold print jobs”
 P.82 “Printing proof print jobs”
 P.83 “Creating an overlay file”
 P.84 “Storing to e-Filing”
 P.87 “Multiple Job Type”
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 Printing scheduled print jobs
The Print Scheduling feature allows you to specify the date and time to print your job. This is especially useful for delaying 
your print job until the off-peak hours.

Time of the System and MFP should be the same.

Printing on a specified date and time

1 Display the [Basic] tab menu.

2 Select [Scheduled Print] in the [Print Job] box.

3 Click [...] on the right of the [Print Job] box.
The [Scheduled Print] dialog box appears.

4 Click the arrow button at the [Date] box to display the Calendar window, and select the 
desired date for your print job.

5 Select the [Time] box and click the spin button to change the time.

 To change the hour, select the hour number and click the spin button.
 To change the time, select the time number and click the spin button.

6 Click [OK].

7 Set any other print options you require and click [OK].

8 Click [OK] or [Print] to send the print job.
The document will be queued to be printed at the specified time and date.
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 Printing private print jobs
When you want to print private documents, use this feature.

Printing confidential documents

1 Display the [Basic] tab menu.

2 Select [Private Print] in the [Print Job] box.

3 Set any other print options you require and click [OK].

4 Click [OK] or [Print] to send the print job.
The print job is stored in the Private Print job list in the touch panel display.

5 Enter a password in the [Password] box and click [OK].

The print job is stored in the Private Print job list in the touch panel display.

 Enter a password using the alphanumeric characters and symbol characters (ASCII code characters 
between 0x21 to 0x7E) in the [Password] box. The password must be between 1 and 63 characters.

 When you enter this password on the touch panel display, confidential documents will be printed. If you 
forget it, you will not be able to print them.

6 Press the [PRINT] button on the control panel.
The print job list is displayed.

7 Select [PRIVATE] on the touch panel.

If the Private print job list is not displayed, select [PRIVATE] from the box of the job types.

8 Select the desired user name and press [OK].

When you enter the nickname for the [User name (Alias)] box on the [Others] tab, and send the job to the 
equipment, its nickname will be displayed on the Private Print job list. If not, the user name that is entered to log 
in to your computer will be displayed on the Private Print job list.
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9 Enter the password for the Private Print job, which has previously been set via the 
computer, and then press [OK].
 When the user name that is entered to log in to your computer is used for [User name (Alias)]:

The displayed list contains the Private Print jobs for which the same password has been set.
 When the nickname is entered for [User name (Alias)]:

The displayed list contains the Private Print jobs for which the same nickname and the same password have 
been set.

10 Select the desired job (desired document name) on the private print job list and press 
[PRINT].
For the detailed instructions on how to use the control panel, see the following page:
 P.194 “Private Print jobs”

 Printing hold print jobs
When you want to print Hold Print documents, use this feature.

Printing hold print documents

1 Display the [Basic] tab menu.

2 Select [Hold Print] in the [Print Job] box.

3 Set any other print options as required and click [OK].

4 Click [OK] or [Print] to send the print job.
The print job is stored in the Hold Print job list in the touch panel display.

5 Press the [PRINT] button on the control panel.

6 Select [HOLD] on the touch panel.

7 Select the desired user name.

When you enter the nickname for the [User name (Alias)] box on the [Others] tab, and send the job to the 
equipment, its nickname will be displayed on the Hold Print job list. If not, the user name that is entered to log in 
to your computer will be displayed on the Hold Print job list.

8 Select the desired job on the Hold Print job list and press [PRINT].
For detailed instructions on how to use the control panel, see the following page:
 P.198 “Hold Print jobs”

 When the user name that is entered to log in to your computer is used for [User name (Alias)]:
The displayed list contains the Hold Print jobs which have been registered by the selected user.

 When the nickname is entered for [User name (Alias)]:
The displayed list contains all the Hold Print jobs which have been registered by users having the same 
nickname.
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 Printing proof print jobs
You can print out one proof copy as a trial first. This helps to prevent wasting paper. After you proof it, you are prompted to 
specify whether you want to continue the print job or delete it.

When you want to print multiple copies, each of which is to be sent as an individual print job by your application, all the 
copies, not just one copy, will be printed even if you set Proof Print. In such a case, print just one trial copy first, and 
then specify the required number of copies on the touch panel display.

Printing a proof copy

1 Display the [Basic] tab menu.

2 Select [Proof Print] in the [Print Job] box.

3 Set any other print options you require and click [OK].

4 Click [OK] or [Print] to send the print job.
One copy of the document is printed and remaining sets of job is stored in the Proof Job list in the touch panel 
display.

5 Press the [PRINT] button on the control panel. 

6 Select [PROOF] on the touch panel.

7 Select the desired job on the proof print job list and press [PRINT].
For detailed instructions on how to use the control panel, see the following page:
 P.191 “Proof Print jobs”
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Creating an overlay file
You can save up to 20 documents as overlay files using printer driver. You can print an overlay on the foreground or 
background of a document. To do that, you must first create an overlay file.
 P.106 “Printing with an overlay file”

 If you save a multi-page document as an overlay file, only the first page of the document will be saved as an 
overlay file.

 Both the overlay file and the documents on which you superimpose the overlay image must be created in the same 
size, color mode, and orientation.

Printing a document as an overlay file

1 Display the [Basic] tab menu.

2 Select [Print to Overlay File] in the [Print Job] box.

3 Click [...] on the right of the [Print Job] box.
The [Overlay Image Name] dialog box appears.

4 Enter an overlay image name and then click [OK].

You can enter up to 63 characters.

5 Set any other print options you require and click [OK].

6 Click [OK] or [Print] to send the print job.
The document is saved as an overlay file.

You can use a created overlay file when you want to print a document.
 P.106 “Printing with an overlay file”
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 Storing to e-Filing
The Store to e-Filing feature allows you to send print jobs to e-Filing on this equipment. The job stored to e-Filing can then 
be printed from the touch panel display at a later time. It can be also composed with other documents using the e-Filing 
web utility.
You can select either a [public] or [user] box to store print jobs. You can also specify a folder in which the print job is to be 
stored in these boxes. The public box is shared by all users who can see the jobs stored in this box. User boxes are boxes 
that users can create as desired. Access to user boxes can be restricted with a password.

 When the following paper sizes are selected for the originals or the print paper, [Store to e-Filing] is not available.
Additionally, when paper of those sizes is also included in a part of the documents, the printing job cannot be stored 
in e-Filing either.
- Custom paper
- Non-standard size paper (bypass tray)
- TAB paper

 When you store a document in e-Filing using the printer driver, the printing image (not the original document in your 
computer) will be stored in e-Filing.

 Documents stored in e-Filing are retained in the best image quality for printing. If you want to download them into 
your computer in a higher image quality, scan the original documents and store them in e-Filing.

 You can manage the files within a box from the touch panel display. Refer to the e-Filing Guide to manage files in 
a box.

 You can also manage the files within a box using the e-Filing web utility. Refer to the e-Filing Guide.

Saving a print job to a public box

1 Display the [Basic] tab menu.

2 Select [Store to e-Filing] in the [Print Job] box.

3 Set any other print options you require and click [OK].

4 Select [Public Box].
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5 When you specify a folder in which the print job is to be stored in a Public Box, enter 
the folder name in the [Box Folder] box.

 If the entered folder name is not found, a new folder is created under this box.
 Enter the folder name within 64 characters.
 If the number of folders has reached 100, you cannot create any more.

6 If you print the job as well as save it to the Public Box, select the [Print] check box.

7 Click [OK].

8 Click [OK] or [Print] to send the print job.
The print job is saved to the public box.

Saving a print job to a user box

1 Display the [Basic] tab menu.

2 Select [Store to e-Filing] in the [Print Job] box.

3 Set any other print options you require and click [OK].

4 Select a user box to save a print job and enter the password (maximum 20-digit) for the 
user box in the [Password] box if required.
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5 When you specify a folder in which the print job is to be stored in a user box, enter the 
folder name in the [Box Folder] box.

 If the entered folder name is not found, a new folder is created under this box.
 Enter the folder name within 64 characters.
 If the number of folders has reached 100, you cannot create any more.

6 If you print the job as well as saving to a box, select the [Print] check box.

7 Click [OK].

8 Click [OK] or [Print] to send the print job.
The print job is saved to the specified user box.
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Multiple Job Type
The Multiple Job Type feature allows you to combine any of Scheduled Print, Private Print, Hold Print, Proof Print, Proof 
Private Print and Proof Hold Print, with Store to e-Filing. 
For example, you can store a job in the specified e-Filing of this equipment and print it at the specified time by combining 
Scheduled Print and Store to e-Filing.
To use the Multiple Job Type feature, click [...] on the right of the [Print Job] box and select the job types to be combined.

 Before performing Scheduled Print, make sure the date and time of this equipment and your computer are the 
same.

 When you print multiple copies, each of which is to be sent as an individual print job by your application, all of the 
copies are printed even if you set Proof Print. In this a case, perform Proof Print of only one copy first, and then 
change the number of copies on the touch panel to print the rest.

 Documents stored in e-Filing are retained with the optimal image quality for printing. If you want to download them 
into your computer with a higher image quality, scan the original documents and store them in e-Filing.

 When you store a document in e-Filing using the printer driver, it is stored as an image. This is not stored in e-Filing 
in the same way as the original document is stored in your computer.

 You can manage files in e-Filing on the touch panel. For instructions on how to manage them, refer to the e-Filing 
Guide.

 You can also manage files in e-Filing using the e-Filing web utility. For instructions on how to manage them with the 
e-Filing web utility, refer to the e-Filing Guide.

Printing with the Multiple Job Type feature

1 Display the [Basic] tab menu.

2 Select [Multiple Job Type] in the [Print Job] box.

3 Click [...] on the right of the [Print Job] box.
The [Multiple Job Type] dialog box appears.
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4 Select a job type in the [Print Job] box.
The setup screen is switched according to the selected job type.
 Set [Date] and [Time] if you select [Scheduled Print].

 Enter a password if you select [Private Print] or [Proof Private Print].

 Enter a password using the alphanumeric characters and symbol characters (ASCII code characters 
between 0x21 to 0x7E) in the [Password] box. The password must be between 1 and 63 characters.

 When you enter this password on the touch panel display, confidential documents will be printed. If you 
forget it, you will not be able to print them.

5 If you want to store a print job in this equipment, select the [Store to e-Filing] check 
box.
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6 Select where the print job is stored at the [Store to] box.
 If you store the print job in a user box, enter a password if required.

7 When you specify a folder in which the print job is to be stored in the selected e-Filing, 
enter its folder name in the [Box Folder] box.

 If the entered folder name is not found, a new folder is created in the selected e-Filing under this name.
 Enter a folder name within 64 characters.
 If the number of folders has reached 100, you cannot create any more.

8 Click [OK].

9 Click [OK] or [Print] to send the print job.
 If you select [Scheduled Print], the job is printed at the specified date and time.
 If you select [Private Print] or [Proof Private Print], the job is stored in this equipment as a Private Print job. Print 

this job on the touch panel. 
 P.80 “Printing private print jobs”

 If you select [Hold Print] or [Proof Hold Print], the job is stored in this equipment as a Hold Print job. Print this 
job on the touch panel.
 P.81 “Printing hold print jobs”

 If you select [Proof Print], [Proof Private Print] or [Proof Hold Print], one sample copy is printed and the rest is 
stored in this equipment as a Proof Print job. Print this job on the touch panel.
 P.82 “Printing proof print jobs”

 If you select the [Store to e-Filing] check box, the print job is stored in the specified e-Filing.
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 Layout and finishing options in [Basic] tab menu
Using the printer driver, you can set various layout options to suit your preferences. In this section various printing 
functions enabled with the [Basic] tab menu are explained.
 P.90 “Fitting images within paper size”
 P.91 “Printing color documents in gray scale”
 P.92 “Printing color documents in twin colors”

 Fitting images within paper size
You can automatically enlarge or reduce an image to fit into a specified paper size, or manually set the scale to enlarge or 
reduce it. Also you can combine the desired paper size and reproduction ratio.

Printing enlarged or reduced image to fit the specified paper size

1 Display the [Basic] tab menu.

2 Select the document size on the [Original Paper Size] box. Then select the paper size 
that you want to print at the [Print Paper Size] box.

The document image is automatically enlarged or reduced depending on the original paper size and print paper 
size.

3 Set any other print options you require and click [OK].

4 Click [OK] or [Print] to send the print job.
The enlarged or reduced image is printed to fit the specified paper size.

Printing an enlarged or reduced image by specifying the scale manually

1 Display the [Basic] tab menu.

2 Check the [Image Scale] box. Then enter the scale.

The scale can be set from 25% to 400% in units of 1%.

3 Set any other print options you require and click [OK].

4 Click [OK] or [Print] to send the print job.
An enlarged or reduced image is printed in the specified scale.
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Combining a paper size and a reproduction ratio

You can combine the desired paper size and reproduction ratio, for example, printing an A4 original to A3 copy paper at a 
reproduction ratio of 100%.

1 Display the [Basic] tab menu.

2 Select the document size on the [Original Paper Size] box. Then select the paper size 
that you want to print at the [Print Paper Size] box.

The document image is automatically enlarged or reduced depending on the original paper size and print paper 
size.

3 Check the [Image Scale] box. Then enter the scale.

The scale can be set from 25% to 400% in units of 1%.

4 Set any other print options you require and click [OK].

5 Click [OK] or [Print] to send the print job.
The image is printed on paper of the specified size at the specified reproduction ratio.

 Printing color documents in gray scale
This equipment can print in color as well as black and white. The printer driver automatically detects whether the 
document uses only color or only black and white, and it prints the document accordingly. Additionally, you can select the 
black and white mode manually to print a color document in the gray scale to reduce the print cost and consumption of 
color toners.

Printing a color document in gray scale

1 Display the [Basic] tab menu.

2 Select [Black and White] at the [Color] box.

3 Set any other print options you require and click [OK].

4 Click [OK] or [Print] to send the print job.
The print job is printed in the gray scale.
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 Printing color documents in twin colors
This equipment can print in the twin color mode.
When the document is printed in the twin color mode, the black parts of the document are printed in black and the colored 
parts of the document are printed in a specified color.

Printing a color document in twin color mode

1 Display the [Basic] tab menu.

2 Select [Twin Color] at the [Color] box.

3 Click [Details].
The [Twin Color] dialog box appears.

4 Select a color in which the color parts of the document are to be printed at the [Color] 
box and click [OK].

5 Set any other print options you require and click [OK].

6 Click [OK] or [Print] to send the print job.
The print job is printed in the twin color mode.

 Layout and finishing options in [Finishing] tab menu
Using the printer driver, you can set various layout options to suit your preferences. In this section various printing 
functions enabled with the [Finishing] tab menu are explained.
 P.92 “Sort printing”
 P.94 “Printing on both sides of a sheet”
 P.94 “Making a booklet”
 P.97 “Printing several pages on one sheet”
 P.98 “Stapling”
 P.98 “Hole punching”
 P.99 “Dividing one image into multiple sheets (Poster Print)”

 Sort printing
You can select how multiple copies of a document to be output, such as separately for each copy, grouping each page, 
and alternating the paper direction for each copy.

Sorting printed documents according to the copies

1 Display the [Basic] tab menu.

2  Enter the number of copies to be printed at the [Number of Copies] box.

3 Display the [Finishing] tab menu.
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4 Select [Sort Copies] icon at [Copy Handling].

5 Set any other print options you require and click [OK].

6 Click [OK] or [Print] to send the print job.
The printed documents are sorted according to the copies.

Sorting printed documents according to the pages

For example, assume that you have a three-page job (A, B, C) and you want three copies of each page in this order (AAA, 
BBB, CCC).

1 Display the [Basic] tab menu.

2 Enter the number of copies to be printed at the [Number of Copies] box.

3 Display the [Finishing] tab menu.

4 Select [Group Copies] icon at [Copy Handling].

5 Set any other print options you require and click [OK].

6 Click [OK] or [Print] to send the print job.
The printed documents are sorted according to the pages.

Sorting printed documents horizontally and vertically for each copy

 Rotated Sort Copies can be enabled only when printing on Letter, A4, B5, or 16K.
 To make Rotated Sort Copies, sheets to be used must be placed both horizontally and vertically (example: A4 and 

A4-R).

1 Display the [Basic] tab menu.

2 Enter the number of copies to be printed at the [Number of Copies] box.

3 Display the [Finishing] tab menu.

4 Select the [Rotated Sort] icon at [Copy Handling].

5 Set any other print options you require and click [OK].

6 Click [OK] or [Print] to send the print job.
The printed documents are alternately sorted horizontally and vertically for each copy.
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 Printing on both sides of a sheet
You can print on both sides of the paper.

Printing on both sides of paper

1 Display the [Finishing] tab menu.

2 Select the [2-Sided Printing] check box and select the direction to be printed.

Long Edge — Select this to print on both sides of the paper with a margin on the long edge.
Short Edge — Select this to print on both sides of the paper with a margin on the short edge.

You can also set booklet printing at the [2-Sided Printing] option by selecting the [Booklet] icon. For instructions 
on how to perform booklet printing, see the following section.
 P.94 “Making a booklet”

3 Set any other print options you require and click [OK].

4 Click [OK] or [Print] to send the print job.
The print job is printed on both sides of paper in the specified direction.

Making a booklet
You can create a document in a book- or magazine-style publication by selecting the Booklet option. Also you can create 
a folded booklet by automatically stapling (saddle-stitching) and folding the center of a printed document.
For example, if you create a document on Letter-size paper (8½ x 11 inches) and then print in booklet mode, the yield is a 
5½-x-8½- inch booklet. Each page has been scaled to fit on half a sheet and reordered so that the booklet is properly 
paginated when folded.
To retain your original document size when printing booklets, select the booklet size to be the same as your original 
document size. Then your 8½-inch document is printed on Ledger size paper (11 x 17 inches) and reordered so that, when 
folded, the yield is an 8½-x-11-inch booklet. You can select from the following page-size options when printing a booklet:
 Letter Booklet on Ledger
 A4 Booklet on A3
 B5 Booklet on B4

Creating a booklet

1 Display the [Finishing] tab menu.

2 Select the [2-Sided Printing] check box and select the [Booklet] icon.

3 Click [Details].
The [Booklet Details] dialog box appears.
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4 Select the booklet size at the [Output Document Layout] box.

A5 on A4 — Select this to print an A5 size booklet. Every 2 pages are printed on A4 paper to fit on half a sheet 
(A5).
A4 on A3 — Select this to print an A4 size booklet. Every 2 pages are printed on A3 paper to fit on half a sheet 
(A4).
B5 on B4 — Select this to print a B5 size booklet. Every 2 pages are printed on B4 paper to fit on half a sheet (B5).
B6 on B5 — Select this to print a B6 size booklet. Every 2 pages are printed on B5 paper to fit on half a sheet (B6).
1/2 Folio on Folio — Select this to print a 1/2 Folio size booklet. Every 2 pages are printed on Folio paper to fit on 
half a sheet.
A6 on A5 — Select this to print an A6 size booklet. Every 2 pages are printed on A5 paper to fit on half a sheet 
(A6).
Letter-Half on Letter — Select this to print a 1/2 Letter size booklet. Every 2 pages are printed on Letter paper to 
fit on half a sheet.
LT on LD — Select this to print a Letter size booklet. Every 2 pages are printed on Ledger paper to fit on half a 
sheet (Letter).
1/2 LG on LG — Select this to print a 1/2 Legal size booklet. Every 2 pages are printed on Legal paper to fit on half 
a sheet.
1/2 Statement on Statement — Select this to print a 1/2 Statement size booklet. Every 2 pages are printed on 
Statement paper to fit on half a sheet.
1/2 Comp on Comp — Select this to print a 1/2 Computer size booklet. Every 2 pages are printed on Computer 
paper to fit on half a sheet.
1/2 13LG on 13LG — Select this to print a 1/2 13 inch LG size booklet. Every 2 pages are printed on 13 inch LG 
paper to fit on half a sheet.
1/2 8.5SQ on 8.5SQ — Select this to print a 1/2 8.5 inch SQ size booklet. Every 2 pages are printed on 8.5 inch SQ 
paper to fit on half a sheet.
32K on 16K — Select this to print a 32K size booklet. Every 2 pages are printed on 16K paper to fit on half a sheet.
16K on 8K — Select this to print a 16K size booklet. Every 2 pages are printed on 8K paper to fit on half a sheet.

5 Select the page order for booklet in the [Page Order] option.
From Left to Right — Select this to print the pages from left to right.
From Right to Left — Select this to print the pages from right to left.

6 If you want to add a margin space between facing pages, enter a width in the [Center] 
box, and if you want to add a margin on the outside edge, enter a width in the [Outer] 
box.
 You can change the unit of the margin at the [Units].
 The center margin can be set from 0.00 inch to 0.67 inches in units of 0.01 inch when the unit is inches, and 

from 0.00 mm to 16.90 mm in units of 0.10 mm when the unit is mm.
The printed images will be reduced according to the margin setting.

 The outer margin can be set from 0.17 inch to 1.17 inches in units of 0.01 inch when the unit is inches, and from 
4.20 mm to 29.60 mm in units of 0.10 mm when the unit is mm.
The printed images will be reduced according to the margin setting.

If you select the [Booklet without Center Margin] check box, the value in [Center] becomes invalid and the 
center margin becomes 0 mm (inches).
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7 Select the [Folding] check box if you want to fold the document at its center.

The Folding option is available only when the Saddle Stitch Finisher (optional) is installed in either the ES9460 
MFP/ES9470 MFP/CX3535 MFP/CX4545 MFP, or the Saddle Stitch Finisher MJ-1106 (optional) is installed in 
the ES9160 MFP/ES9170 MFP.

8 If you want to double-staple the center, select the [Staple Down the Center] check box.

[Staple Down the Center] is available only when the Saddle Stitch Finisher (optional) is installed and configured 
on the [Device Settings] tab.

9 Click [OK] to close the [Booklet Details] dialog box.

10 Set any other print options you require and click [OK].

11 Click [OK] or [Print] to send the print job.
The print job is printed as a booklet.

If the Saddle Stitch Finisher (optional) is installed, the printed document is folded at its center when the 
[Folding] check box is selected. If this is not installed, fold the printed document manually.
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 Printing several pages on one sheet
The N-up feature allows you to print several pages of a document on one sheet of paper. This feature is very useful for 
browsing a large number of pages for appearance or page order.
For example, to check the navigation path of a number of web pages or review the narrative of a slide presentation, using 
N-up is not only convenient but conserves paper as well.

When [Overlay Image] is selected together with the N-up feature, the overlay images are printed per sheet, not per 
page. If you want to print them on each page, select the [Print on Each Page] check box in [Overlay Image] on the 
[Effect] tab.
 P.57 “[Effect] tab”

Printing multiple pages per sheet

1 Display the [Finishing] tab menu.

2 Select how many pages you want to print on a single sheet at the [Number of pages per 
Sheet] box.

2 pages — Select this to print images from 2 pages arranged on one sheet.
4 pages — Select this to print images from 4 pages arranged on one sheet.
6 pages — Select this to print images from 6 pages arranged on one sheet.
8 pages — Select this to print images from 8 pages arranged on one sheet.
9 pages — Select this to print images from 9 pages arranged on one sheet.
16 pages — Select this to print images from 16 pages arranged on one sheet.

3 Select how the pages are arranged on one sheet in the [Direction of print] option.

Left to Right — Select this to arrange pages horizontally from the left and printed top to bottom on one sheet.
Right to Left — Select this to arranged pages horizontally from the right and printed top to bottom on one sheet.
Left to Right by column — Select this to arrange pages vertically from the top and printed left to right on one 
sheet.
Right to Left by column — Select this to arrange pages vertically from the top and printed right to left on one 
sheet.

Items that can be selected in [Direction of print] may vary depending on the number of pages selected at the 
[Number of pages per Sheet] box.

4 If you want to draw a line around each page, select the [Draw Borders Around Pages] 
check box.

5 Set any other print options you require and click [OK].

6 Click [OK] or [Print] to send the print job.
Multiple pages are printed per sheet.
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 Stapling
You can staple sets of paper to exit from the equipment.

Stapling is not available if a Finisher (optional) is not installed.

Stapling the paper

1 Display the [Finishing] tab menu.

2 Select the [Staple] check box. Select a stapling option.

Upper Left — Select this to staple the printed document at the upper left.
Upper Right — Select this to staple the printed document at the upper right.
Center Top — Select this to double-staple the printed document along the top edge.
Middle Left — Select this to double-staple the printed document along the left side.
Center Double — Select this to fold and double-staple the printed document in the center.

 The selectable options vary depending on the paper size.
 [Center Double] can be selected only when the Saddle Stitch Finisher (optional) is installed and configured 

on the [Device Settings] tab.

3 Set any other print options you require and click [OK].

4 Click [OK] or [Print] to send the print job.
The output is stapled for each copy.

Hole punching
Select this to punch holes on printed sheets of paper to exit from the equipment.

Hole punching is not available if a Hole Punch Unit (optional) is not installed.

Punching holes

1 Display the [Finishing] tab menu.

2 Select the [Hole Punch] check box. Select a hole punch option.

Center Top — Select this to punch holes along the top edge.
Middle Left — Select this to punch holes along the left side.

3 Set any other print options you require and click [OK].

4 Click [OK] or [Print] to send the print job.
Holes are punched.
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Dividing one image into multiple sheets (Poster Print)
You can print one large image into more than one sheet of paper by dividing it. The divided images on the multiple sheets 
of paper are then reconnected, so that you can create a large publication such as a poster.

 The Poster Print option is not available when any of the Custom Paper Size, Number of pages per sheet, 2-Sided 
Printing, Watermark, Overlay Image and Sheet Insertion options is set.

 The Poster Print option is available only when any of the sizes below is selected for [Print Paper Size] on the 
[Basic] tab.
A4, A3, LT, LD

Performing Poster Print

1 Display the [Finishing] tab menu.

2 Select the [Poster Print] check box and then click [Details].

The [Poster Print] dialog box appears.

3 Select the number of sheets on which the image is printed, and then click [OK].

1x2 — Select this to divide the image into 2 sheets.
2x2 — Select this to divide the image into 4 sheets.
3x3 — Select this to divide the image into 9 sheets.
4x4 — Select this to divide the image into 16 sheets.

 [1x2] is selectable only when A4/A3 is selected for [Print Paper Size].
 When you use the Poster Print option, disable the [Do not Print Blank Pages] option on the [Others] tab. If 

you use the Poster Print option while [Do not Print Blank Pages] is left ON, blank pages in the divided image 
are not printed. 

4 Set any other print options you require and click [OK].

5 Click [OK] or [Print] to send the print job.
The image is divided and printed into the specified number of sheets of paper.
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 Finishing options in [Paper Handling] tab menu
Using the printer driver, you can set various layout options to suit your preferences.   In this section various printing 
functions enabled with the [Paper Handling] tab menu are explained.
 P.100 “Inserting different types of paper”
 P.102 “Interleaving pages”

 Inserting different types of paper
You can insert a different type of sheet into a specified location in the printed documents. This is useful when you want to 
add front and back covers, or sheets between chapters. Both printed and blank sheets can be inserted.

Printing or inserting a front cover and back cover

1 Display the [Paper Handling] tab menu.

2 To print or insert a front cover, select the [Use Front Cover] check box and select the 
drawer where the cover paper is loaded at the [Source] box. Then select whether you 
are inserting a blank cover or printed front cover at the [Print Style] box.

Do not print on page — Select this to insert a blank front cover.
Print one side of the page — Select this to print the first page of the document on a front side of a cover.
Print both sides of page — Select this to print the first two pages of the document on both sides of a cover.

 When [Auto] is selected in the [Source] box, the paper is automatically selected according to the printed 
document size.

 To insert thick paper, select Bypass Tray and set Thick for [Paper Type] for [Bypass Tray] in the [Drawer 
Settings] dialog box of the [Device Settings] tab in the printer driver.

 [Print both sides of page] is available only when 2-Sided printing is enabled at the [Finishing] tab.

3 To print or insert a back cover, select the [Use Back Cover] check box and set the 
[Source] and [Print Style] options that you require.

How to set the Source and Print Style options is the same as for the [Use Front Cover] option.

4 To print or insert sheets between the pages, select the [Insert Pages] check box and 
click [Edit].

The [Insert Pages] dialog box appears.

Up to 50 pages can be inserted.
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5 Enter the page numbers to which you want to insert the sheet in each [Page] box and 
select the [Print Style], [Paper Source], and [Paper Type] options as you require.

6 Set any other print options you require and click [OK].

7 Click [OK] or [Print] to send the print job.
A front cover and back cover are inserted into the printed document.
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 Interleaving pages
This feature is useful when you want to insert a different type of paper, or from another source, between every page of 
your print job. For example, you could use this option to insert blank or color sheets between overhead transparencies.

Inserting sheets between every page of a print job

1 Display the [Paper Handling] tab menu.

2 To insert sheets between every page, select the [Interleave Pages] check box and 
select the drawer where the desired paper is loaded at the [Source] box.

 When [Auto] is selected in the [Source] box, the paper is automatically selected according to the printed 
document size.

 To insert thick paper, select Bypass Tray and set Thick for [Paper Type] for [Bypass Tray] in the [Drawer 
Settings] dialog box of the [Device Settings] tab in the printer driver.

3 To print the previous page on interleaved sheets, select the [Duplicate] check box.
This equipment prints every previous page on interleaved sheets which are inserted after the page so that you can 
duplicate a document.

4 Set any other print options you require and click [OK].

5 Click [OK] or [Print] to send the print job.
The sheets are interleaved between every page.
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 Finishing options in [Effect] tab menu
Using the printer driver, you can set various layout options to suit your preferences. In this section various printing 
functions enabled with the [Effect] tab menu are explained.
 P.103 “Printing with watermarks”
 P.106 “Printing with an overlay file”

 Printing with watermarks
Watermarks overprint your document with useful information, such as [TOP SECRET,] [CONFIDENTIAL,] [DRAFT,] 
[ORIGINAL,] or [COPY.]. You can choose from several predefined watermarks or you can create and save your own 
custom watermarks.
Watermarks are text only. To add graphics or other document elements, use image overlays instead.

Printing a watermark

1 Display the [Effect] tab menu.

2 Select the watermark to be printed at the [Watermark] box.

You can create a new watermark if there is none you want to apply on the box.
 P.104 “Creating or editing a watermark”

3 If you want to print the watermark on only the first page, select the [Print on First Page 
Only] check box.

4 Set any other print options you require and click [OK].

5 Click [OK] or [Print] to send the print job.
The print job is printed with the watermark.
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Creating or editing a watermark

1 Click [Add] to create a new watermark, or select one that you want to edit and click 
[Edit] to edit a watermark.

The [Watermark] dialog box appears.

2 Enter the watermark text in the [Caption] box.
You can enter up to 63 characters for the [Caption] box. However, if too many characters are entered, the 
watermark may not be printed correctly.

3 Select the position of the watermark in [Position].
Select the desired icon for the position.

4 Select a font for the watermark at the [Font Name] box.

5 Select a font style for the watermark at the [Style] box.

6 Enter the font size in the [Font Size] box.
You can enter any integer between 6 and 300pt in units of 1pt.

7 Select a color for the watermark at the [Color] box.
If your preferred color is not listed in the box, click [Browse] to display the color palette and add your color.

 This option is available only when your equipment is a multifunctional digital color system. 
 When [Black and White] is selected at the [Color] box on the [Basic] tab, the [Color] box is not available.

8 To rotate the watermark, enter the number of degrees in the [Angle] box.
 You can enter from -90 degrees to 90 degrees in units of 1 degree in the [Angle] box.
 You can also set the angle using the scroll bar.

9 Select how the watermark text is printed from [Solid], [Draw as Outline], and 
[Transparency].
Solid — Select this to print a solid type of watermark.
Draw as Outline — Select this to print an outline type of watermark.
Transparency — Select this for a transparent watermark. Set the transparent ratio from 0 to 100% in units of 1%. 
You can also set the transparent ratio using the scroll bar.

10 Click [OK] to save the watermark settings.
The watermark is added or edited.
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Deleting a watermark

You can delete the default watermarks. However, they cannot be restored by clicking [Restore Defaults].

1 Select the watermark that you want to delete at the [Watermark] box.

2 Click [Delete].
The [Confirm Delete] dialog box appears.

3 Click [Yes].

The watermark is deleted.
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 Printing with an overlay file
Using image overlays ensures that widely-used images are readily available and consistently reproduced. Image overlays 
are independent documents that are merged into other documents during printing and thereby increase the time required 
to print a job. To superimpose text on your document, it may be faster to use watermarks.
To print with an overlay file, you must first create an overlay file.
 P.83 “Creating an overlay file”

 When [Overlay Image] is selected together with the N-up feature, the overlay images are printed per sheet, not per 
page. If you want to print them on each page, select the [Print on Each Page] check box in [Overlay Image] on the 
[Effect] tab.
 P.57 “[Effect] tab”

 Both the overlay file and the documents on which you superimpose the overlay image must be created in the same 
size, color mode, and orientation.

Printing an overlay image as a print job

1 Display the [Effect] tab menu.

2 Select the overlay image name to be used in the [Overlay Image] box.

If you use different overlay images for odd/even pages or use overlay images only for the specified pages, 
select [Multiple Overlays] and set them in its dialog box.
 P.61 “Multiple Overlays”

3 If you want to print the overlay image over the document, select the [Print Over the 
Document] check box.

4 Set any other print options you require and click [OK].

5 Click [OK] or [Print] to send the print job.
 The print job is printed with the overlay image.
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Deleting an overlay image

1 Select an overlay image that you want to delete at the [Overlay Image] box.

2 Click [Delete].
The [Confirm Delete] dialog box appears.

3 Click [Yes].

The overlay image is deleted.
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Using various types of paper
This equipment allows you to print on various types of paper. The procedure below is for print jobs which require 
precautions before you place the paper.
 P.108 “Printing on tab paper”
 P.111 “Printing on paper larger than standard sizes”

 Printing on tab paper
This equipment supports tab printing, which can be done in the tab extension of the tab paper. The job will be output in the 
inner tray.

 This equipment can print only on the Letter-sized or A4-sized tab paper.
 If misprinting occurs while multiple tab pages are being printed continuously, toner may adhere to the reverse side 

of the second and subsequent sheet of paper. To avoid this, it is recommended to print tab paper as a separate job 
for each page so that this equipment performs cleaning before printing the next sheet.

 When printing tab paper, it may be caught in the exit of the inner tray because the roller failed to deliver the tab 
extension to the exit. In that case, remove the tab paper before printing the next job.

Printing a document on tab paper

1 Create a Letter sized or A4 sized document and place the text or object that should 
appear on the tab extension as described below.
When you create a document for tab printing, place the text or object that should appear on the tab extension on 
the right side of the document. You must place the text in the height that exactly fits the tab extension. 

The selectable range of the edge margin differs depending on the model. See the following for setting this 
option:
- For the ES9460 MFP/ES9470 MFP/CX3535 MFP/CX4545 MFP

The margin between the shifted text and right edge of the tab extension must have at least 0.17 inches (4.2 
mm) of space because any data in this space are not printed. Enter the same value in the [Tab Extension] 
box and the [Image Shift Width] box.

- For the ES9160 MFP/ES9170 MFP
The margin between the shifted text and right edge of the tab extension must have at least 0.08 inches (2.0 
mm) of space because any data in this space are not printed. Enter the same value in the [Tab Extension] 
box and the [Image Shift Width] box.

For models other than the above, refer to the corresponding Printing Guide.
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2 Place the tab paper with the tab outside.

3 When printing a document, display the [Basic] tab menu of the printer driver 
properties, select the document size in the [Original Paper Size] box and either [Letter 
Tab] or [A4 Tab] (according to the document size) in the [Print Paper Size] box.

The [Primary Tab Dialog] dialog box appears.

4 In the [Tab Manufacturer] box, select the product name of the tab paper that you use, or 
select [Custom] when you use other manufactured tab paper.

5 When you select [Custom] in the [Tab Manufacturer] option, enter the width of the tab 
extension in the [Tab Extension] box.

Place the tab paper

with the tab outside.
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6 Enter the width to shift the printed image in the [Image Shift Width] box.
If you created a document as described in Step 1, enter the width of the tab extension here.

The selectable range of the edge margin differs depending on the model. See the following for setting this 
option:
- For the ES9460 MFP/ES9470 MFP/CX3535 MFP/CX4545 MFP

The margin between the shifted text and right edge of the tab extension must have at least 0.17 inches (4.2 
mm) of space because any data in this space are not printed. Enter the same value in the [Tab Extension] 
box and the [Image Shift Width] box.

- For the ES9160 MFP/ES9170 MFP
The margin between the shifted text and right edge of the tab extension must have at least 0.08 inches (2.0 
mm) of space because any data in this space are not printed. Enter the same value in the [Tab Extension] 
box and the [Image Shift Width] box.

For models other than the above, refer to the corresponding Printing Guide.

7 Click [OK].

8 Set any other print options you require and click [OK].

9 Click [OK] or [Print] to send the print job.

10 Press [JOB STATUS] on the touch panel.
The print job list appears.

11 Select the desired job in the print job list and then press the [START] button on the 
control panel.
 The print job is printed on the tab paper.
 For the detailed instructions on how to use the control panel, see the following page:
 P.186 “Monitoring the Print Job Status”



2.PRINTING FROM WINDOWS

Printing With Best Functions for Your Needs    111

2 PRINTING FROM WINDOWS

 Printing on paper larger than standard sizes
The procedure below is for printing on paper larger than standard sizes defined in the custom paper size setting. 
(Example: Largest size: 12.34 x 47.24 inches (313.4 x 1200 mm))
Custom paper sizes can be defined in the [Other] tab menu.
 P.68 “Custom Paper Size”

Printing on paper larger than standard sizes

1 Display the properties of the printer driver and select the custom paper size in [Print 
Paper Size] of the [Basic] tab menu before starting printing.

2 Set any other print options you require and click [OK].

3 Click [OK] or [Print] to send the print job.

4 Place paper larger than the standard sizes on the bypass tray.

 Do not mix it with other sizes.
 Print one sheet by one from the bypass tray even if you have set the number of copies as more than one.

5 Press [JOB STATUS] on the touch panel.
The print job list appears.

6 Select the desired job in the print job list and then press the [START] button on the 
control panel.
 The print job is printed on paper larger than the standard sizes.
 For the detailed instructions on how to use the control panel, see the following page:
 P.186 “Monitoring the Print Job Status”
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Inserting from the bypass tray

When the paper is being fed into the equipment

 Do not mix paper of different sizes.
 Place one sheet at a time on the bypass tray even if you wish to print multiple copies.
 Slightly curl the paper. Hold it gently as it is being fed into the equipment.

 Be careful not to cut your fingers on the edge of paper when you hold it.
 Make sure that the trailing edge of the paper will not be fed into the equipment while you are holding it.

 The paper will be printed with a resolution of 300 dpi.

When the paper is coming out of the equipment

 Hold the paper gently as it is coming out of the equipment.

 Be careful not to cut your fingers on the edge of paper when you hold it.
 Do not pull out the paper forcibly as it is exiting from the equipment.
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 Switching equipment to print jobs
When more than one piece of OKI MFP series equipment exists over a network, you can switch it to another one on the 
printer driver menu.
If the equipment that you intended to use is busy with a large number of print jobs, for example, you can send your job to 
another piece of OKI MFP series equipment that is currently holding no print jobs and have it printed.

Switching equipment to print jobs

1 Display the [Others] tab menu.

2 Click [Output Devices].

The [Output Devices] dialog box appears.

3 Select [Print Job to Selected Devices].

4 Select the desired equipment in the [Selected Devices] boxes.

 You can select more than one piece of equipment in the [Selected Devices] boxes. In this case, the same 
number of copies is printed from all of the pieces of equipment you selected.

 When you select the equipment in the [Selected Devices] boxes, make sure to select that which supports 
features enabling all the print options of the job.
- Select equipment which enables stapling if the job needs that.
- Select equipment which enables hole punching if the job needs hole.
- Select equipment with the External Large Capacity Feeder (optional) installed if the job needs it.
- Select color equipment if the job needs full- or twin-color printing.

 If you select the [Always Use This Setting] check box, you can omit the setting of the [Output Devices] 
dialog box from the next time.

 Equipment selected in the [Selected Devices] boxes must be registered in [Printer Folder]. If you want to 
use equipment not registered in [Printer Folder], add it in [Add Printer] on the [Others] tab of printer driver.
 P.67 “Add Printer”

5 Click [OK] to close the [Output Devices] dialog box.

6 Set any other print options you require and click [OK].
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7 Click [OK] or [Print] to send the print job.
A job is printed on the selected equipment.

 If the selected equipment does not support features enabling the print options of the job, printing may not be 
performed properly. 

 Department code confirmation for the selected equipment is not performed when the job is printed from the 
selected one. If a department code specified in the [Department Code] box on the [Others] tab is not 
recognized on it, Department Management for this print job is not performed.
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 Splitting a print job across two pieces of equipment (Tandem Printing)
This feature splits one print job across two pieces of equipment to print it by means of copies. 
If you have to print documents with a large number of pages in a large number of copies, for example, you can have two 
pieces of OKI MFP series equipment on a network share this job to print by copies simultaneously, so that it can be done 
in a shorter time.

Splitting a print job across two pieces of equipment (Tandem Printing)

1 Display the [Others] tab menu.

2 Click [Output Devices].

The [Output Devices] dialog box appears.

3 Select [Split Job across Selected Devices].

4 Select two pieces of equipment in the [Selected Devices] boxes and then specify the 
number of copies for each one.

 If you select the [Auto] check box, the number of copies set in the [Total Copies] box is automatically and 
equally allocated to two pieces of equipment.

 When you select the equipment in the [Selected Devices] boxes, make sure to select that which supports 
features enabling all the print options of the job.
- Select equipment which enables stapling if the job needs that.
- Select equipment which enables hole punching if the job needs hole.
- Select equipment with the External Large Capacity Feeder (optional) installed if the job needs it.
- Select color equipment if the job needs full- or twin-color printing.

 If you select the [Always Use This Setting] check box, you can omit the setting of the [Output Devices] 
dialog box from the next time.

 Equipment selected in the [Selected Devices] boxes must be registered in [Printer Folder]. If you want to 
use equipment not registered in [Printer Folder], add it in [Add Printer] on the [Others] tab of printer driver.
 P.67 “Add Printer”

5 Click [OK] to close the [Output Devices] dialog box.

6 Set any other print options you require and click [OK].
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7 Click [OK] or [Print] to send the print job.
A job is printed on the selected equipment.

 If the selected equipment does not support features enabling the print options of the job, printing may not be 
performed properly. 

 Department code confirmation for the selected equipment is not performed when the job is printed from the 
selected one. If a department code specified in the [Department Code] box on the [Others] tab is not 
recognized on it, Department Management for this print job is not performed.
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Printing From Application on Mac OS X 10.2.4 to Mac OS X 10.7.x

Once you have installed the PPD file as described in “Installing the Printer on Mac OS X 10.2.4 to Mac OS X 10.7.x” of the 
Software Installation Guide, you can print directly from most of the Mac OS X applications.

Considerations and limitations
 If you print a PDF file with “Preview” application on Mac OS X 10.2.x, the page order will be incorrect. Please use 

Adobe Reader.
 If any double-byte character is included in the user name or document name when printing is performed, the printing 

job is displayed with [OSX User] or [OSX Document] on the touch panel display of the equipment. The user name and 
document name are displayed as they are only for one-byte characters.

 The Cover Pages option of the Printer Features menu is available for Mac OS X 10.3.x or later.
 The Cover Pages option of the Printer Features menu and the booklet printing cannot be used at the same time.
 The Cover Pages option of the Printer Features menu and the N-up printing (multiple pages per sheet) cannot be used 

at the same time.
 The Cover Pages option of the Printer Features menu and the Cover Page option for sending a print job with a banner 

page cannot be used at the same time.
 The e-Filing function cannot be used together with Custom Paper Size, Magazine Sort, Twin Color, Hold Print, Proof 

Print, or Private Print.
 When the stapling or hole punching option is used in the e-Filing function, the following settings cannot be used. Even 

when any of these options is selected, it will be cleared.
- Stapling

[Middle Right (Portrait) / Middle Bottom (Landscape)], [Lower Right (Portrait) / Lower Left (Landscape)], 
[Middle Bottom (Portrait) / Middle Left (Landscape)]

- Hole Punch
[Long Edge Punch with 180 degree rotation], [Short Edge Punch with 180 degree rotation]

 To perform proof printing, private printing, hold printing, scheduled printing or e-Filing on Mac OS X 10.5, use LPR, 
AppleTalk or Bonjour.

 To perform proof printing, private printing, hold printing, scheduled printing or e-Filing on Mac OS X 10.6.x to Mac OS 
X 10.7.x, use LPR or Bonjour.

 To use the user authentication function on Mac OS X 10.3.x to Mac OS X 10.4.x, perform the domain settings on 
[Applications] > [Utilities] > [Directory Access] > [Services] > [BSD Flat and NIS].

 To use the user authentication function on Mac OS X 10.5.x, perform the domain settings on [Applications] > [Utilities] 
> [Directory Utilities] > [Services] > [BSD Flat and NIS].

 To use the user authentication function on Mac OS X 10.6.x to Mac OS X 10.7.x, perform the domain settings on 
[Accounts] > [Login Option] > [Network Account Server] > [Open the Directory Utility] > [Services] > [BSD Flat and 
NIS].
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How to print from Mac OS X 10.2.4 to Mac OS X 10.7.x
You do not need to switch printers before starting printing because they are all managed under the setting of [Print & Fax] 
of [System Preferences]. Once a printer is added to the Printer List, you can select any printer directly from the [Page 
Setup] dialog box or the [Print] dialog box.

 Setting options and printing from Macintosh Computers
In Mac OS X applications, print options are set from both the [Page Setup] dialog box and the [Print] dialog box.

Printing from Macintosh applications

1 Open a file and select [Page Setup] from the [File] menu of the application.

2 Select the name of the equipment in the [Format For] box and specify the Page Setup 
settings for your print job.

Setting the Page Setup varies depending on how you want to print a document.
 P.120 “Page Attributes”

3 Click [OK] to save the Page Setup settings.

4 Select [Print] from the [File] menu of the application.

5 In the dialog box that appears, make sure the name of the equipment is selected at the 
[Printer] box and specify the Print settings for your print job.

Setting the Print Setup varies depending on how you want to print a document.
 P.125 “Print dialog on Mac OS X 10.3.x to Mac OS X 10.7.x”
 P.150 “Print dialog on Mac OS X 10.2.x”

The [Print] dialog boxes vary depending on applications.

6 Click [Print] to print a document.

The content set in the [Print] dialog box can be saved as [Presets]. Select [Save as] in the [Presets] box and save it 
under the desired name. If you use this preset content as a default setting, select it in the [Presets] box.
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 Page Setup dialog on Mac OS X 10.2.4 to Mac OS X 10.7.x
The [Page Setup] dialog boxes can be displayed by selecting the [Page Setup] command from the [File] menu of the 
application.
In the [Page Setup] dialog boxes, you can specify the Page Attributes settings and manage the Custom Page Size 
settings.

The [Page Setup] dialog boxes vary depending on applications. In some applications, it is not included in the [File] 
menu, but in the [Print] dialog boxes.

 Page Attributes

1) Format For
This selects the printer to be used for printing.

2) Paper Size
This selects the size of a document to be printed.

 The default paper size is [US Letter] for the United States, and [A4] for the other countries.
 [305 x 457 mm], [12 x 18"], [320 x 450 mm], and [320 x 460 mm] is enabled only when the ES9460 MFP/

ES9470 MFP/CX3535 MFP/CX4545 MFP is used.
 [Env-Com10 (4 1/8 x 9 1/2")], [Env-Mornarch (3 7/8 x 7 1/2")], [Envelope DL (110 x 220 mm)], [Envelope Cho-3 

(120 x 235 mm)], and [Envelope You-4 (105 x 235 mm)] is enabled only when the ES9160 MFP/ES9170 MFP is 
used.

3) Orientation
This sets the paper printing direction.
- Portrait — The document is printed in the portrait direction.
- Landscape (90 degree) — The document is printed in the landscape direction from left.
- Landscape (270 degree) — The document is printed in the landscape direction from right. This is selectable only 

for Mac OS X 10.2.x to Mac OS X 10.4.x.

Available original paper sizes are listed below:

 A3
 A4
 A5
 A6
 JB4
 JB5
 Ledger
 US Legal
 US Letter
 Statement (5 1/2 x 8 1/2")
 Folio
 Computer (10 1/8 x 14")
 13"LG (8 1/2 x 13")

 8.5"SQ (8 1/2 x 8 1/2")
 12 x 18"
 305 x 457 mm
 8K (270 x 390 mm)
 16K (195 x 270 mm)
 320 x 450 mm
 320 x 460 mm
 Env-Com10 (4 1/8 x 9 1/2")
 Env-Mornarch (3 7/8 x 7 1/2")
 Envelope DL (110 x 220 mm)
 Envelope Cho-3 (120 x 235 mm)
 Envelope You-4 (105 x 235 mm)
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4) Scale
This changes the size of the printed image on the page. Enter the zoom ratio to enlarge or reduce an image. You can 
set any integer from 1 to 10000(%) for the zoom ratio. For Mac OS X 10.2.4 to Mac OS X 10.4.x, the acceptable range 
for zoom ratio is from 25% to 400%.

Custom Page Sizes
The PPD file for this equipment supports the Custom Page Sizes.
The procedure to create the Custom Page Size varies between the Mac OS X 10.4.x to Mac OS X 10.7.x and Mac OS X 
10.2.4 to Mac OS X 10.3.x.

 When you print on paper larger than standard sizes, print one sheet at a time.
 P.111 “Printing on paper larger than standard sizes”

 The paper sizes that can be set for the Custom Paper Size differ depending on the model to be used.

Creating Custom Page Size on Mac OS X 10.4.x to Mac OS X 10.7.x

1 Select [Manage Custom Sizes] in the [Paper Size] box.

The [Custom Page Sizes] dialog box appears. If Mac OS X 10.6.x to 10.7.x is used, the [Custom Paper Size] dialog 
box appears.

2 Click [+].

A new custom page size name is added to the list.

If you want to create a new custom page size by duplicating an existing custom page size, select the custom 
page size name on the list and click [Duplicate].
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3 Double-click the added custom page size name on the list and rename the custom page 
size.

4 Enter the width and height in the [Paper Size] boxes, and select the printer name of this 
equipment in the [Printer Margins] box.

 If Mac OS X 10.6.x to 10.7.x is used, enter the width and height in the [Paper Sizes] box, and then select 
your printer name in the [Non-Printable Area] box.

 Please use the margin settings that are automatically entered by selecting the printer name in the [Printer 
Margins] box.

 You can delete the created custom page size by clicking [-].

5 Click [OK].
The Custom Page Size is saved and it can be selected in the [Paper Size] box in the Page Attributes menu.
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Creating Custom Page Size on Mac OS X 10.2.4 to Mac OS X 10.3.x

1 Select [Custom Paper Size] in the [Settings] box.

The Custom Paper Size menu is displayed.

2 Click [New].

A new custom page size name is added to the list.

If you want to create a new custom page size by duplicating an existing custom page size, select the custom 
page size name on the list and click [Duplicate].

3 Rename the custom page size.



3 PRINTING FROM Macintosh

124    Printing From Application on Mac OS X 10.2.4 to Mac OS X 10.7.x

4 Enter the height and width in the [Page Size] boxes, and enter the printer margins in the 
[Printer Margins] boxes.

 In the [Printer Margins] box, please enter “0.17” inch.
 You can delete the created custom page size by clicking [Delete].

5 Click [Save] and click [OK].

The Custom Page Size is saved and it can be selected in the [Paper Size] box in the Page Attributes menu.
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 Print dialog on Mac OS X 10.3.x to Mac OS X 10.7.x
The [Print] dialog boxes can be displayed by selecting the [Print] command from the [File] menu of the application.

The [Print] dialog boxes are different between Mac OS X 10.2.x and Mac OS X 10.3.x to Mac OS X 10.7.x. Please see 
the following section for the descriptions of the [Print] dialog boxes for Mac OS X 10.2.x.
 P.150 “Print dialog on Mac OS X 10.2.x”

 The [Page Setup] dialog boxes varies depending on applications. In some applications, [Page Setup] may not be 
included in the [File] menu, but in the [Print] dialog boxes.

 The layout of the setting items may vary depending on the type of your Mac OS.

Copies & Pages
In the Copies & Pages menu, you can set general print options such as the number of copies, and sort printing.

1) Copies
This sets the number of printed copies.

2) Collated
Select this check box for sort-printing (1, 2, 3... 1, 2, 3...)

3) Pages
This sets the range of pages to be printed.
- All — Select this to print all pages.
- From/to — Select this to specify the pages to be printed. Enter the page range in the From and to box.

4) Two-Sided
This sets two-sided printing. When you select this check box, [Long-Edge binding] is automatically selected in the 
[Two-Sided] box in the Layout menu. This is selectable only for Mac OS X 10.5.x to Mac OS X 10.7.x.

1
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 Layout
In the Layout menu, you can set N-up printing (multiple pages per sheet).

1) Pages per Sheet
This sets the number of multiple pages printed on one sheet. The pages are reduced to fit the selected paper size 
automatically and are printed.
- 1 — Select this if you do not wish to enable N-up printing.
- 2 — Select this to print images from 2 pages arranged on one sheet.
- 4 — Select this to print images from 4 pages arranged on one sheet.
- 6 — Select this to print images from 6 pages arranged on one sheet.
- 9 — Select this to print images from 9 pages arranged on one sheet.
- 16 — Select this to print images from 16 pages arranged on one sheet.

2) Layout Direction
This sets how pages are arranged on one sheet. This is available only when N-up printing (printing multiple pages on 
one sheet) is set.
- Across Left to Right Before Down — Pages arranged horizontally from left to right and then top to bottom on one 

sheet.
- Across Right to Left Before Down — Pages arranged horizontally from right to left and then top to bottom on one 

sheet.
- Down Before Across Left to Right — Pages arranged vertically from top to down and then left to right on one 

sheet.
- Down Before Across Right to Left — Pages arranged vertically from top to down and then right to left on one 

sheet.

3) Border
Select if a border line is to be drawn on each page.
- None — Select this if no border line is to be drawn.
- Single Hairline — Select this to draw a single hairline for the border.
- Single Thin Line — Select this to draw a single thin line for the border.
- Double Hairline — Select this to draw a double hairline for the border.
- Double Thin Line — Select this to draw a double thin line for the border.
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4) Two-Sided
This sets whether or not you want to print on both sides of the paper.
- Off — Select this when you do not want to print on both sides of the paper.
- Long-Edge binding — Select this to bind along the long edge side of the paper. The direction to be printed on the 

back side of the paper differs depending on the orientation.

- Short-Edge binding — Select this to bind along the short edge side of the paper. The direction to be printed on the 
back side of the paper differs depending on the orientation.

5) Reverse page orientation
This sets the paper exit orientation. When the orientation of the paper is reversed with this setting, the top of the paper 
comes to the control panel side. This is selectable only for Mac OS X 10.5.x to Mac OS X 10.7.x.

6) Flip horizontally
Select this check box to perform mirror printing of a page.
This check box is displayed only for the Mac OS X 10.6.x to 10.7.x.

Output Options
In the Output Options menu, you can save a print job as a file.

This menu is displayed only for Mac OS X 10.3.x.

1) Save as File
Select this check box to save a print job as a file. When this box is selected, select the file type at the [Format] box.

2) Format
This sets the format of a file to be saved.
- PDF — Select this to save a print job as a PDF file.
- PostScript — Select this to save a print job as a PS file.
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 Scheduler
In the Scheduler menu, you can set when a print job will be sent to the equipment.

1) Print Document
This sets when a print job will be sent to the equipment.
- Now — Select this to send a print job now.
- At — Select this to specify the time to send a print job. Set the time to send the print job. The print job will be held 

in the queue on Mac OS X until the specified time or until you resume the print job to be sent from the queue on 
Mac OS X.

- On hold — Select this to hold a print job in the queue on Mac OS X. When you select this, the print job will be held 
in the queue on Mac OS X until you resume the print job to be sent from the queue on Mac OS X.

2) Priority
Select the priority of a print job. If there are many print jobs, printing is performed from the job with the highest priority. 
Four levels of priority are available: [Urgent], [High], [Medium] and [Low].

 Paper Handling
In the Paper Handling menu, you can set Reverse page order printing and Odd or Even numbered page printing.
The screens in the Paper Handling menu vary between Mac OS X 10.3.x and Mac OS X 10.4.x.

Mac OS X 10.3.x

1) Reverse page order
Select this check box when you want to print a document beginning with the last page.

2) Print
Select whether all pages will be printed or only odd or even pages will be printed.
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Mac OS X 10.4.x

1) Page Order
Select the page order for printing.

2) Print
Select whether to print all pages or only odd/even-numbered pages.

3) Destination Paper Size
Select the output paper size.
- Use documents paper size — Select this to print on the same-sized paper as the document size.
- Scale to fit paper size — Select this to perform enlarge/reduce printing. Selected, select the output paper size in 

the box. If you do not want to enlarge the document images when a larger paper size is selected, select the [Scale 
down only] check box.

Mac OS X 10.5.x

1) Pages to Print
Select whether all pages will be printed or only odd/even-numbered pages will be printed.

2) Destination Paper Size
Select the output paper size. The paper size selected in the [Page Setup] dialog box appears as a default setting.
- Scale to fit paper size — Select this check box to perform enlarge/reduce printing. When this is selected, select 

the output paper size in the box. If you do not want to enlarge the document images when a larger paper size is 
selected, select the [Scale down only] check box.

3) Page Order
Select the page order for printing.
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Mac OS X 10.6.x to 10.7.x

1) Pages to Print
Select whether all pages will be printed or only odd or even pages will be printed.

2) Page Order
Select the page order for printing.

3) Destination Paper Size
Select the output paper size. The paper size selected in the [Page Setup] dialog box appears as a default setting.
- Scale to fit paper size — Select this check box to perform enlarge/reduce printing. When this is selected, select 

the output paper size in the box. If you do not want to enlarge the document images when a larger paper size is 
selected, select the [Scale down only] check box.

ColorSync
In the ColorSync menu you can adjust colors on the printouts.

This menu is displayed only for Mac OS X 10.3.x to Mac OS X 10.4.x.

1) Color Conversion
Select the method for color management.
- Standard — Select this if you want the application you are using to control the color management of the printouts.
- In Printer — Select this if you want the printer you are using to control the color management of the printouts.

2) Quartz Filter
Select the presence of the Quartz Filter.
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Color Matching
In the Color Matching menu you can adjust the colors on the printouts.

This menu is displayed only for Mac OS X 10.5.x to Mac OS X 10.7.x.

1) ColorSync
Select this if you want the application you are using to control the color management of the printouts.

2) In Printer
Select this if you want the printer you are using to control the color management of the printouts.

3) Profile
Select a color profile to be applied if you selected [ColorSync].

1 2
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Cover Page
In the Cover Page menu, you can set whether to send a print job with a banner page. The banner page includes 
information about the job owner, job name, application name, date and time, and printer name.

1) Print Cover Page
You can set how to insert a banner page.
- None — Select this to print without a banner page.
- Before document — Select this to print a banner page before the document.
- After document — Select this to print a banner page after the document.

2) Cover Page Type
Select the type of the cover page.

3) Billing Info
Enter the billing information to have it appear on the banner page.

Due to Mac OS limitations, text input into the [Billing Info] box will only be displayed up to the length of the field.
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 Error Handling

This menu is displayed only for Mac OS X 10.3.x to Mac OS X 10.4.x.

In the Error Handling menu, you can set how to report a PostScript error.

1) PostScript Errors
This sets whether to print a PostScript error report.
- No special reporting — Select this if you do not want to print PostScript error information.
- Print detailed report — Select this to print PostScript error information.

2) Tray Switching
This is not supported by this equipment.

 Paper Feed
In the Paper Feed menu, you can set the paper source.

1) All pages from
Select this when you want to use the same paper source for all pages. When this is selected, select the paper source 
or paper type to be used at the box.

2) First Page From
Select this when you want to specify different paper sources for the first page and remaining pages. When this is 
selected, specify the paper source or paper type to be used for the first page at the box.

3) Remaining From
Select the paper source or paper type to be used for remaining pages in the box. This can be selected only when you 
choose the [First Page From] option button.
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Color Settings
In the Color Settings 1 and Color Settings 2 menus, you can adjust the color settings for printing.

This option is available only when your equipment is a multifunctional digital color system. 

Color Settings 1
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Color Settings 1 (Mac OS X 10.3.x)

Color Settings 2

1

8

3

5

7

2

9

4

10

11



3 PRINTING FROM Macintosh

136    Printing From Application on Mac OS X 10.2.4 to Mac OS X 10.7.x

1) Color Type
This sets whether to print a job in the color mode or the black mode.
- Auto — Select this to determine the color mode automatically. When a print job is a black and white document, the 

system automatically prints the document in the black mode. When a print job is a color document, it prints the 
document in the color mode.

- Color — Select this to print a document in the color mode.
- Mono — Select this to print a document in the black mode.
- Black and Red — Select this to print a document in the twin color mode with red. When this is selected, the black 

parts of the document are printed in black and the color parts of the document are printed in red.
- Black and Green — Select this to print a document in the twin color mode with green. When this is selected, the 

black parts of the document are printed in black and the color parts of the document are printed in green.
- Black and Blue — Select this to print a document in the twin color mode with blue. When this is selected, the black 

parts of the document are printed in black and the color parts of the document are printed in blue.
- Black and Cyan — Select this to print a document in the twin color mode with cyan. When this is selected, the 

black parts of the document are printed in black and the color parts of the document are printed in cyan.
- Black and Magenta — Select this to print a document in the twin color mode with magenta. When this is selected, 

the black parts of the document are printed in black and the color parts of the document are printed in magenta.
- Black and Yellow — Select this to print a document in the twin color mode with yellow. When this is selected, the 

black parts of the document are printed in black and the color parts of the document are printed in yellow.
- Black and White — Select this to print a document in the twin color mode with white. When this is selected, the 

black parts of the document are printed in black and the color parts of the document are not printed.

2) Halftone
This sets how halftones are printed.
- Auto — Select this to print with proper halftone automatically depending on the contents in the document.
- Detail — Select this to print halftone in detail.
- Smooth — Select this to print halftone smoothly.

3) Toner Save
Select this check box to print in the save mode.

4) Image Type
This sets how colors are printed by selecting the job type. The printer driver automatically applies the proper image 
quality to the selected job type.
- General — Select this when printing a general color document.
- Photo — Select this when printing photos.
- Presentation — Select this when printing a vivid document.
- Line Art — Select this when printing a document that contains a lot of characters or line art.
- Advanced Color Settings — Select this to apply a profile which can adjust the color space. For details, see the 

following page:
 P.138 “Advanced Color Settings”

5) Black Overprint
This set when to print background content that has black text overlaid on it. If this is enabled, the gap between the text 
and the background is minimized and color deviation is prevented.
- Off — Select this so as not to print the background of the black content.
- Text — Select this to print all the full-color background and then the black text on a color background.
- Text and Graphics — Select this to print all the full-color background and then the black text and graphics on a 

color background.

6) PostScript Overprint
Select this to overprint an object that has been set so on an application.

This option is selectable only when [Color] is selected in the [Color Type] box in the Color Settings 1 menu.
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7) Pure Black and Gray
Select whether to print the black and gray scale contents in a document using black toner.
- Off — Select this to print the document in the color mode.
- Black - Auto — Select this to automatically select areas to be printed using black toner when you want to print the 

black contents using its toner. When this option is selected, the appropriate areas are printed using black toner 
according to the Image Type option.

- Black - Text — Select this to print the black text using black toner.
- Black - Text and Graphic — Select this to print the black text and graphics using black toner.
- Black - Text, Graphic and Image — Select this to print the black text, graphics and images using black toner.
- Black and Gray - Auto — Select this to automatically select areas to be printed using black toner when you want 

to print the black and gray scale contents using its toner. When this option is selected, appropriate areas are 
printed using black toner according to the Image Type option.

- Black and Gray - Text — Select this to print the black and gray scale text using black toner.
- Black and Gray - Text and Graphic — Select this to print the black and gray scale text and graphics using black 

toner.
- Black and Gray - Text, Graphic and Image — Select this to print the black and gray scale text, graphics, and 

images using black toner.

8) Resolution
600 dpi (Fixed)

9) Distinguish Thin Lines
Select this check box to print thin lines clearly.
This check box is displayed only for Mac OS X 10.3.x.

10) Color Balance
Adjusts the density of each color for printing. You can set from -4 to 4.

This option is selectable only when [Auto], [Color], or [Black and Red / Green / Blue / Cyan / Magenta / Yellow / 
White] is selected in the [Color Type] box in the Color Settings 1 menu.

11) Image Attribute
This sets the sharpness, brightness, contrast, saturation and background adjustment for printing.
- Sharpness

Adjusts the sharpness for printing. You can set from -4 (softest) to 4 (sharpest) by moving the scroll bar when the 
[Use Sharpness Filter] check box is selected.

- Brightness
Adjusts the brightness for printing. You can set from -4 (darkest) to 4 (lightest) by moving the scroll bar.

- Contrast
Adjusts the contrast for printing. You can set from -4 (lowest) to 4 (highest) by moving the scroll bar.

- Saturation
Adjusts the saturation for printing. You can set from -4 (low clear) to 4 (high clear) by moving the scroll bar.

- Background Adjustment
Adjusts the density level of the background. You can set from -4 (lightest) to 4 (darkest) by moving the scroll bar.
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Advanced Color Settings

The Advanced Color Settings menu is displayed when [Advanced Color Settings] is selected for the [Image Type] option in 
the Color Settings 1 menu.

 This option is available only when your equipment is a multifunctional digital color system. 
 The Advanced Color Settings menu is displayed when Mac OS X 10.4 to 10.7.x is used.

Advanced Color Settings can be set from the TopAccess menu. For detailed instructions on how to set Advanced Color 
Settings from the TopAccess menu, refer to the TopAccess Guide.

1) RGB Source profiles
This selects RGB source profile. When you obtained color profile data from this equipment, its RGB source profile data 
appear.

2) CMYK Source profiles
This selects CMYK source profile. When you obtained color profile data from this equipment, its CMYK source profile 
data appear.

3) Apply to Device Color only
Select this check box when you give priority to color profiles embedded in the image.

4) Destination profiles
This selects destination profile. When you obtained color profile data from this equipment, its destination profile data 
appear.
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5) Rendering Intent
This selects an image processing method for color space conversion when you print.
- Perceptual — This is recommended for photo images.
- Relative colorimetric — More original colors can be retained than those when you select [Perceptual].
- Saturation — This is recommended when the vividness of colors is more important than their correct reproduction. 

It is useful for graphic charts.
- Absolute colorimetric — Original colors can be retained even on colored paper.

6) [Revert to defaults]
Click this to return the Advanced Color Settings to the defaults.

7) [Use these settings]
Click this to save the color profile data set for this equipment and return to the Color Settings 1 menu.

 Print Mode
In the Print Mode menu, you can set the way this equipment handles the print job. This menu allows you to enable various 
job types such as Private Print, Proof Print and Hold Print.

1) Department Code
Select whether the entry of a department code is required or not for printing. Select this check box to enable this option 
if this equipment is managed under department codes. When you do this, enter a department code in the box on the 
right. For your department code, ask the administrator.

 For Mac OS X 10.3.x, enter the department code in a 5-digit number. 
 For Mac OS X 10.4.x to Mac OS X 10.7.x, enter the department code using up to 63 characters.
 A department code must consist of one-byte characters such as numbers from 0 to 9, letters of the alphabet 

from A to Z (in both capital and small ones), a hyphen (-), an underscore (_), and a period (.).
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2) Print Mode
This sets the type of print job.
- Normal — Select this to print a job normally.
- Proof — Select this to print the first copy of a multicopy job and then wait for approval before printing the remaining 

copies. If a print job is sent as a proof job, one copy of the job is printed and the remaining copies are saved in the 
proof job queue on this equipment, which are not printed until you activate printing from the touch panel display. 
This option allows you to check the job’s output before printing the remaining copies and thereby reduce paper 
waste.

- Private — Select this to print a private job.   When this is selected, specify the 5-digit password in the field next to 
the box. The print job is saved in the private job queue on this equipment, and not printed until you activate printing 
from the touch panel display of this equipment. This option is useful when you want to print a confidential document 
secured with a password. The user has to enter the password to print the private job when activating printing from 
the touch panel display.

- Hold — Select this option to print a hold job. The print job, sent as a hold job, is saved in the hold job queue on this 
equipment. To perform printing, select the desired job on the touch panel display and press [PRINT]. This option is 
useful to prevent you from forgetting to remove printed sheets.

3) Distinguish Thin Lines
Select this check box to print thin lines clearly.
This check box is displayed only for Mac OS X 10.4.x to Mac OS X 10.7.x.

4) Do not Print Blank Pages
Select whether you require blank pages to be printed.

 When more than 2 is selected at the [Page per Sheet] option in the Layout menu, the blank pages will be 
printed.

 Pages with a header or footer will be printed even if the content is blank.
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 Printer Features
In the Printer Features menu, you can set special printing features.

Finishing

In the Finishing menu, you can set the destination, hole punching and stapling.

1) Destination
This selects the destination tray.
- Printer’s Default — Select this to set the output to the default tray (that is set as such for raw jobs in the Printer 

setting page of TopAccess Administrator’s page).
- Exit Tray — Select this to set the output to the exit tray of this equipment.
- Upper Exit Tray — Select this to set the output to the upper exit tray of this equipment.
- Side Exit Tray — Select this to set the output to the side exit tray of this equipment.
- Job Separator Upper — Select this to route the upper exit tray of the Job Separator (optional).
- Job Separator Lower — Select this to route the lower exit tray of the Job Separator (optional).
- Tray 1 — Select this to set the output to the upper tray of the Finisher (optional).
- Tray 2 — Select this to set the output to the lower tray of the Finisher (optional).

 Destinations selectable differ depending on the model and the option configuration.
 Depending on the type of Finisher (optional) installed and destination settings, stapling and hole punching may 

not be performed.
 Depending on the equipment settings, the paper may be delivered to a tray that cannot carry out stapling or 

hole punching when [Printer’s Default] is selected as the [Destination] option.
 [Tray 1] and [Tray 2] can be selected when the Finisher (optional) or Saddle Stitch Finisher (optional) are 

installed.
 [Side Exit Tray] can be selected only when neither of the Finisher (optional) and the Saddle Stitch Finisher 

(optional) is installed.
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2) Hole Punch
This sets whether or not a print job is hole punched.
- Off — Select this to print without hole punches.
- Long Edge Punch without rotation — Select this to create holes on the left side for a portrait document, or on the 

top for a landscape document.

- Short Edge Punch without rotation — Select this to create holes on the top for a portrait document, or on the 
right for a landscape document.

- Long Edge Punch with 180 degree rotation — Select this to create holes on the right side for a portrait 
document, or on the bottom for a landscape document.

- Short Edge Punch with 180 degree rotation — Select this to create holes on the bottom for a portrait document, 
or on the left for a landscape document.

This option cannot be selected if a Hole Punch Unit (optional) is not installed.

3) Stapling
This sets whether a print job is stapled.
- Off — Select this to print without stapling.
- Upper Left (Portrait) / Upper Right (Landscape) — Select this to staple on the upper left for a portrait document, 

or on the upper right for a landscape document.

- Middle Left (Portrait) / Middle Top (Landscape) — Select this to double-staple on the left for a portrait document, 
or on the top for a landscape document.
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- Lower Left (Portrait) / Upper Left (Landscape) — Select this to staple on the lower left for a portrait document, or 
on the upper left for a landscape document.

- Upper Right (Portrait) / Lower Right (Landscape) — Select this to staple on the upper right for a portrait 
document, or on the lower right for a landscape document.

- Middle Right (Portrait) / Middle Bottom (Landscape) — Select this to double-staple on the right for a portrait 
document, or on the bottom for a landscape document.

- Lower Right (Portrait) / Lower Left (Landscape) — Select this to staple on the lower right for a portrait 
document, or on the lower left for a landscape document.

- Middle Top (Portrait) / Middle Right (Landscape) — Select this to double-staple on the top for a portrait 
document, or on the right for a landscape document.

- Middle Bottom (Portrait) / Middle Left (Landscape) — Select this to double-staple on the bottom for a portrait 
document, or on the left for a landscape document.

- Saddle Stitch (Portrait) / Saddle Stitch (Landscape) — Select this to double-staple in the center for a booklet to 
be printed. Select this only when booklet printing is performed.
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 This option cannot be selected if a Finisher (optional) is not installed.
 [Saddle Stitch (Portrait) / Saddle Stitch (Landscape)] can be selected only when the Saddle Stitch Finisher 

(optional) is installed.

4) Folding
Select this check box to have paper folded at its center when it exits after data are printed according to the set print 
options.

The Folding option is available only when the Saddle Stitch Finisher (optional) is installed in either the ES9460 
MFP/ES9470 MFP/CX3535 MFP/CX4545 MFP, or the Saddle Stitch Finisher MJ-1106 (optional) is installed in the 
ES9160 MFP/ES9170 MFP.

Booklet

In the Booklet menu, you can set booklet printing.

1) Booklet Paper Size
Select a paper size for the booklet. Both sides of a sheet are printed as two pages. The booklet size will be half the 
size of the paper size that you specify.

2) Left to Right Page Layout
Select this check box to create a booklet that can be read from left to right.

3) Booklet Center Margin
Select the width of the margin added to the center.

4) Booklet Outer Margin
Select the width of the margin added to the short edge side of a sheet.
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Cover Pages

In the Cover Pages menu, you can set Front Cover printing and Back Cover printing.

This option menu cannot be set when the Cover Page option for sending a print job with a banner page is enabled.

1) Use Front Cover
This sets front cover printing which allows you to insert or print a cover on a sheet fed from a different drawer or the 
bypass tray.
To enable cover printing, select this check box and select the location from where a cover sheet is to be fed and the 
print style to be used.

Source
Select from where the cover sheet is to be fed. When [Auto (Default)] is selected, the paper is automatically selected 
according to the printed document size.

The selectable values in the [Source] box vary depending on the optional devices installed on this equipment and 
their configuration on the Paper Feed menu.

Print Style
This selects how to print the cover.
- Do not print on page — Select this to insert a blank cover.
- Print on page — Select this to print the first page image on the front side of a cover. When the Two-Sided Printing 

option is enabled in the Layout menu, the first two page images are printed on both sides of a cover.
- Print on 1 side of the page — Select this to print the first page image on the front side of a cover. This is available 

only when the Two-Sided Printing option is enabled in the Layout menu.

2) Use Back Cover
This sets back cover printing which allows you to insert or print a back cover on a sheet fed from a different drawer or 
the bypass tray.
To enable back cover printing, select this check box and select the location from where a back cover sheet is to be fed 
and the print style to be used.

Source
Select from where the cover sheet is to be fed. When [Auto (Default)] is selected, the paper is automatically selected 
according to the printed document size.
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The selectable values in the [Source] box vary depending on the optional devices installed on this equipment and 
their configuration on the Paper Feed menu.

Print Style
This selects how you want to print a back cover.
- Do not print on page — Select this to insert a blank back cover.
- Print on page — Select this to print the last page image on the front side of a back cover. When the Two-Sided 

Printing option is enabled in the Layout menu, the last two page images are printed on both sides of a back cover.
- Print on 1 side of the page — Select this to print the last page image on the front side of a back cover. This is 

available only when the Two-Sided Printing option is enabled in the Layout menu.

Quality

In the Quality menu, you can specify various image quality features.

This option is available only when your equipment is a multifunctional digital system. 

1) Halftone
This sets how to print halftones.
- Auto — Select this to print with proper halftone depending on the contents in the document automatically.
- Detail — Select this to print halftone in detail.
- Smooth — Select this to print halftone smoothly.

2) Smoothing
Select this check box to print texts and graphics smoothly.

3) Toner Save
Select this check box to print in the toner save mode.

When the toner save mode is enabled, printing may become light.
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 e-Filing
In the e-Filing menu, you can send and store print jobs from your application to e-Filing on this equipment (hard disk). The 
jobs stored to e-Filing can then be printed using the touch panel. You can select either a public or user box in which to 
store print jobs. You can also specify a folder in which the print jobs are to be stored in these boxes. The public box is 
shared by all users who can view the jobs stored in this box. User boxes are ones that users can create as desired. 
Access to user boxes can be restricted with a password.

The e-Filing menu is displayed when the Plug-in file is installed in Mac OS X 10.4.x to Mac OS X 10.7.x. For 
instructions on how to install the Plug-in file, refer to the Software Installation Guide.

1) Store this document to e-Filing
To store a print job in e-Filing, select this check box.

2) Print the document
If you want to print the job as well as saving it to a box, select this check box.

3) Destination
Select either the public box or a user box in which to store print jobs.

5-digit password
If a password is set in the user box, enter the 5-digit password.

Destination folder
When you specify a folder in which the print job is to be stored in a public or a user box, enter the folder name.

 Enter the folder name within 64 characters.
 If the number of folders has reached 100, you cannot create any more.

1
2

3



3 PRINTING FROM Macintosh

148    Printing From Application on Mac OS X 10.2.4 to Mac OS X 10.7.x

Watermark
In the watermark menu, you can overprint the document with useful information, such as [Confidential], [Draft], [Proof] and 
[Top Secret]. You can choose from several predefined watermarks or you can create and save your own custom 
watermarks. Watermarks consist of text only.

The watermark menu is displayed when the Plug-in file is installed in Mac OS X 10.4.x to Mac OS X 10.7.x. For 
instructions on how to install the Plug-in file, refer to the Software Installation Guide.

1) Text
Select the watermark. You can create a new watermark if there is none you want to apply on the box.

You can enter up to 63 alphanumeric characters. If too many characters are entered, the watermark may not be printed 
correctly.

2) Font
Select the font to be used for the watermark text.

3) Size
Enter the font size for the watermark text.
The font size can be set from 6 to 300 pt in units of 1 pt. You can also set the font size by moving the scroll bar.

4) Angle
Enter the degree of the angle for rotating the watermark text. The angle can be set from 0 to 360 degrees in units of 1 
degree. You can also set the degree of the angle by moving the scroll bar.

5) Color
Select the color of the watermark text.

When [Mono] is selected at the [Color Type] box in the Color Settings 1, the documents are printed with a shading of 
gray instead of the selected color.

6) Print over the document
Select this to print the watermark text placed above everything.
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7) Print under the document
Select this to print the watermark text placed below everything.

8) Position
Adjust the position of the watermark by moving the scroll bars.

 Supply Levels
In the Supply Levels menu, the remaining toner and paper can be checked.
This menu is displayed when Mac OS X 10.4 to 10.7.x is used.

 Summary
In the Summary menu, you can confirm the current settings for printing.
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 Print dialog on Mac OS X 10.2.x
The [Print] dialog boxes can be displayed by selecting the [Print] command from the [File] menu of the application.

The [Print] dialog boxes are different between Mac OS X 10.2.x and Mac OS X 10.3.x to Mac OS X 10.7.x. Please see 
the following section for the descriptions of the [Print] dialog box for Mac OS X 10.3.x to Mac OS X 10.7.x.
 P.125 “Print dialog on Mac OS X 10.3.x to Mac OS X 10.7.x”

The [Print] dialog boxes vary across applications.

Copies & Pages
In the Copies & Pages menu, you can set the general print options such as number of copies and sort printing.

1) Copies
This sets the number of printed copies.

2) Collated
Select this check box for sort printing (1, 2, 3... 1, 2, 3...)

3) Pages
This sets the pages to be printed.
- All — Select this to print all pages.

- From/to — Select this to specify the pages to be printed. Enter the page range in the From and to box.

1 2
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 Layout
In the Layout menu, you can set N-up printing (multiple pages per sheets). The items in the Layout menu vary depending 
on the Mac OS X version.

1) Pages per Sheet
This sets the number of multiple pages to be printed on one sheet. The pages are reduced to fit the selected paper size 
automatically and are printed.
- 1 — Select this if you do not wish to perform N-up printing.
- 2 — Select this to print images from 2 pages arranged on one sheet.
- 4 — Select this to print images from 4 pages arranged on one sheet.
- 6 — Select this to print images from 6 pages arranged on one sheet.
- 9 — Select this to print images from 9 pages arranged on one sheet.
- 16 — Select this to print images from 16 pages arranged on one sheet.

2) Layout Direction
This sets how pages are arranged on one sheet. This is available only when the N-up printing (printing multiple sheets 
on a page) is set.
- Across Left to Right Before Down — Pages are arranged horizontally from left to right and then top to bottom on 

one sheet.
- Across Right to Left Before Down — Pages are arranged horizontally from right to left and then top to bottom on 

one sheet.
- Down Before Across Left to Right — Pages are arranged vertically from top to bottom and then left to right on 

one sheet.
- Down Before Across Right to Left — Pages are arranged vertically from top to bottom and then right to left on 

one sheet.

3) Border
Select if a border line is to be drawn on each page.
- None — Select this if no border line is to be drawn.
- Single hairline — Select this to draw a single hairline for the border.
- Single thin line — Select this to draw a single thin line for the border.
- Double hairline — Select this to draw a double hairline for the border.
- Double thin line — Select this to draw a double thin line for the border.
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Duplex
In the Duplex menu, you can set Two-Sided printing (printing on both sides of a sheet).

1) Print on Both Sides
Select this check box to print on both sides of the paper. When this box is selected, select the binding direction at the 
[Binding] option.

2) Binding
This sets the type of binding for Two-sided printed pages.
- Long-Edge Binding — Select this to bind along the long edge side of paper. The direction to be printed on the 

back side of the paper differs depending on the orientation.

- Short-Edge Binding — Select this to bind along the short edge side of paper. The direction to be printed on the 
back side of the paper differs depending on the orientation.

Output Options
In the Output Options menu, you can save a print job as a file.

1) Save as File
Select this check box to save a print job as a file. When this box is selected, select the file type at the [Format] box.

2) Format
This sets the format to save a file.
- PDF — Select this to save a print job as a PDF file.
- PostScript — Select this to save a print job as a PS file.

1 2
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 Error Handling
In the Error Handling menu, you can set how to report a PostScript error.

1) PostScript Errors
This sets whether to print a PostScript error report.
- No special reporting — Select this if you do not want to print PostScript error information.
- Print detailed report — Select this to print PostScript error information.

2) Tray Switching
This is not supported by this equipment.

 Paper Feed
In the Paper Feed menu, you can select the paper source or media type.

1) All pages from
Select the option button when you want to use the same paper source for all pages. When this is selected, specify the 
paper source or paper type to be used at the box.

2) First page from
Select the option button when you want to specify a different paper source for a first page and remaining pages. When 
this is selected, specify the paper source or paper type to be used for a first page at the box.

3) Remaining from
Select the paper source or paper type to be used for the remaining pages in the box. This can be selected only when 
you choose the option button of the [First page from] option.

1

2

1

2

3



3 PRINTING FROM Macintosh

154    Printing From Application on Mac OS X 10.2.4 to Mac OS X 10.7.x

 Printer Features
In the Printer Features menu, you can set special printing features.
 P.154 “Booklet”
 P.155 “Color Settings 1”
 P.156 “Color Settings 2”
 P.157 “Color Settings 3”
 P.158 “Color Settings 4 5”
 P.159 “Color Settings 4 6”
 P.159 “Finishing”
 P.163 “Printing Modes”
 P.164 “Printing Modes DC”
 P.165 “Private Document Password”
 P.166 “Quality”

Do not use the Cover Pages menu.

Booklet

In the Booklet menu, you can set booklet printing.

1) Booklet Paper Size
Select a paper size for the booklet. Both sides of a sheet are printed as two pages. The booklet size will be the half 
size of the paper size that you specify.

2) Left to Right Page Layout
Select this check box to create a booklet that can be read from left to right.

3) Booklet Center Margin
Select the width of space added to the center.

4) Booklet Outer Margin
Select the width of space added to the short edge side of a sheet.
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Color Settings 1

In the Color Settings 1, you can set special features for printing.

This option is available only when your equipment is a multifunctional digital color system. 

1) Color Type
This sets whether to print a job in the color mode or black mode.
- Auto — Select this to determine the color mode automatically. When a print job is a black and white document, the 

system automatically prints the document in the black mode. When a print job is a color document, it prints the 
document in color mode.

- Color — Select this to print a document in the color mode.
- Mono — Select this to print a document in the black mode.
- Black and Red — Select this to print a document in the twin color mode with red. When this is selected, the black 

parts of the document are printed in black and the color parts of the document are printed in red.
- Black and Green — Select this to print a document in the twin color mode with green. When this is selected, the 

black parts of the document are printed in black and the color parts of the document are printed in green.
- Black and Blue — Select this to print a document in the twin color mode with blue. When this is selected, the black 

parts of the document are printed in black and the color parts of the document are printed in blue.
- Black and Cyan — Select this to print a document in the twin color mode with cyan. When this is selected, the 

black parts of the document are printed in black and the color parts of the document are printed in cyan.
- Black and Magenta — Select this to print a document in the twin color mode with magenta. When this is selected, 

the black parts of the document are printed in black and the color parts of the document are printed in magenta.
- Black and Yellow — Select this to print a document in the twin color mode with yellow. When this is selected, the 

black parts of the document are printed in black and the color parts of the document are printed in yellow.
- Black and White — Select this to print a document in the twin color mode with white. When this is selected, the 

black parts of the document are printed in black and the color parts of the document are not printed.

2) Resolution
600 dpi (Fixed)

3) Halftone
This sets how to print halftones.
- Auto — Select this to print with proper halftone depending on the contents in the document automatically.
- Detail — Select this to print halftone in detail.
- Smooth — Select this to print halftone smoothly.

4) Distinguish Thin Lines
Select this check box to print thin lines clearly.
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Color Settings 2

In the Color Settings 2, you can set image quality for printing.

This option is available only when your equipment is a multifunctional digital color system. 

1) Image Type
This sets how colors are printed by selecting the job type. The printer driver automatically applies proper image quality 
for selected job type.
- General — Select this when printing a general color document.
- Photo — Select this when printing photos.
- Presentation — Select this when printing a vivid document.
- Line Art — Select this when printing a document containing a lot of characters or line art.

Other than [General] cannot be selected when [Mono] is selected at the [Color Type] box in the Color Settings 1 
menu.

2) Black Overprint
This set when printing background content that has black text overlaid on it. If this is enabled, the gap between the text 
and the background is minimized and color deviation is prevented.
- Off— Select this so as not to print the background of the black content.
- Text — Select this to print all the full-color background and then print the black text on a color background.
- Text and Graphics — Select this to print all the full-color background and then print the black text and graphics on 

a color background.

3) PostScript Overprint
Select this to overprint an object that has been set so on an application.

This option is selectable only when [Color] is selected in the [Color Type] box in the Color Settings 1 menu.
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4) Pure Black and Gray
Select whether to print the black and gray scale contents in a document using black toner.
- Off — Select this to print the document in the color mode.
- Black - Auto — Select this to automatically select areas to be printed using black toner when you want to print the 

black contents using its toner. When this option is selected, appropriate areas are printed using black toner 
according to the Image Type option.

- Black - Text — Select this to print the black text using black toner.
- Black - Text and Graphic — Select this to print the black text and graphics using black toner.
- Black - Text, Graphic and Image — Select this to print the black text, graphics and images using black toner.
- Black and Gray - Auto — Select this to automatically select areas to be printed using black toner when you want 

to print the black and gray scale contents using its toner. When this option is selected, appropriate areas are 
printed using black toner according to the Image Type option.

- Black and Gray - Text — Select this to print the black and gray scale text using black toner.
- Black and Gray - Text and Graphic — Select this to print the black and gray scale text and graphics using black 

toner.
- Black and Gray - Text, Graphic and Image — Select this to print the black and gray scale text, graphics, and 

images using black toner.

Color Settings 3

In the Color Settings 3, you can set color balance for printing.

This option is available only when your equipment is a multifunctional digital color system. 

1) Color Balance - Cyan
Adjusts the density of cyan for printing. You can set from -4 to 4.

2) Color Balance - Magenta
Adjusts the density of magenta for printing. You can set from -4 to 4.

3) Color Balance - Yellow
Adjusts the density of yellow for printing. You can set from -4 to 4.

4) Color Balance - Black
Adjusts the density of black for printing. You can set from -4 to 4.
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Color Settings 4 5

In the Color Settings 4 5, you can set image attributes for printing.

This option is available only when your equipment is a multifunctional digital color system. 

1) Use Sharpness Filter
Select this check box when you use a sharpness filter.

2) Contrast
Adjusts the contrast for printing. You can set from -4 (lowest) to 4 (highest).

3) Sharpness
Adjusts the sharpness for printing. You can set from -4 (softest) to 4 (sharpest) by moving the scroll bar when the [Use 
Sharpness Filter] check box is selected.

4) Brightness
Adjusts the brightness for printing. You can set from -4 (darkest) to 4 (lightest).

5) Saturation
Adjusts the saturation for printing. You can set from -4 (low clear) to 4 (high clear).
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Color Settings 4 6

In the Color Settings 4 6, you can set image attributes for printing.

This option is available only when your equipment is a multifunctional digital color system. 

1) Background Adjustment
Adjusts the density level of the background. You can set from -4 (lightest) to 4 (darkest).

Finishing

In the Finishing menu, you can set the destination, hole punching and stapling.

1) Destination
This selects the destination tray.
- Printer’s Default — Select this to route the output to the default tray (that is set as the default tray for raw jobs in 

the Printer setting page of the TopAccess Administrator’s page).
- Exit Tray — Select this to set the output to the exit tray of this equipment.
- Upper Exit Tray — Select this to set the output to the upper exit tray of this equipment.
- Side Exit Tray — Select this to set the output to the side exit tray of this equipment.
- Job Separator Upper — Select this to route the upper exit tray of the Job Separator (optional).
- Job Separator Lower — Select this to route the lower exit tray of the Job Separator (optional).
- Tray 1 — Select this to set the output to the upper tray of the Finisher (optional).
- Tray 2 — Select this to set the output to the lower tray of the Finisher (optional).
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 Destinations selectable differ depending on the model and the option configuration.
 Depending on the type of Finisher (optional) installed and destination settings, stapling and hole punching may 

not be performed.
 Depending on the equipment settings, the paper may be delivered to a tray that cannot carry out stapling or 

hole punching when [Printer’s Default] is selected as the [Destination] option.
 [Tray 1] and [Tray 2] can be enabled when the Finisher (optional) or Saddle Stitch Finisher (optional) is 

installed.
 [Side Exit Tray] can be enabled only when neither of the Finisher (optional) and the Saddle Stitch Finisher 

(optional) is installed.

2) Hole Punch
This sets whether or not a print job is hole punched.
- Off — Select this to print without hole punches.
- Long Edge Punch without rotation — Select this to create holes on the left side for a portrait document, or on the 

top for a landscape document.

- Short Edge Punch without rotation — Select this to create holes on the top for a portrait document, or on the 
right for a landscape document.

- Long Edge Punch with 180 degree rotation — Select this to create holes on the right side for a portrait 
document, or on the bottom for a landscape document.

- Short Edge Punch with 180 degree rotation — Select this to create holes on the bottom for a portrait document, 
or on the left for a landscape document.

This option cannot be selected if a Hole Punch Unit (optional) is not installed.

3) Stapling
This option sets whether a print job is stapled.
- Off — Select this to print without stapling.
- Upper Left (Portrait) / Upper Right (Landscape) — Select this to staple on the upper left for a portrait document, 

or on the upper right for a landscape document.
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- Middle Left (Portrait) / Middle Top (Landscape) — Select this to double-staple in the left for a portrait document, 
or on the top for a landscape document.

- Lower Left (Portrait) / Upper Left (Landscape) — Select this to staple on the lower left for a portrait document, or 
on the upper left for a landscape document.

- Upper Right (Portrait) / Lower Right (Landscape) — Select this to staple on the upper right for a portrait 
document, or on the lower right for a landscape document.

- Middle Right (Portrait) / Middle Bottom (Landscape) — Select this to double-staple on the right for a portrait 
document, or on the bottom for a landscape document.

- Lower Right (Portrait) / Lower Left (Landscape) — Select this to staple on the lower right for a portrait 
document, or on the lower left for a landscape document.

- Middle Top (Portrait) / Middle Right (Landscape) — Select this to double-staple on the top for a portrait 
document, or on the right for a landscape document.

- Middle Bottom (Portrait) / Middle Left (Landscape) — Select this to double-staple on the bottom for a portrait 
document, or on the left for a landscape document.
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- Saddle Stitch (Portrait) / Saddle Stitch (Landscape) — Select this to double-staple on the center for a booklet to 
be printed. Select this only when booklet printing is performed.

 This option cannot be enabled if a Finisher (optional) is not installed.
 [Saddle Stitch (Portrait) / Saddle Stitch (Landscape)] can be selected only when the Saddle Stitch Finisher 

(optional) is installed.

4) Folding
Select this check box to have paper folded at its center when it exits after data are printed according to the set print 
options.

The Folding option is available only when the Saddle Stitch Finisher (optional) is installed in either the ES9460 
MFP/ES9470 MFP/CX3535 MFP/CX4545 MFP, or the Saddle Stitch Finisher MJ-1106 (optional) is installed in the 
ES9160 MFP/ES9170 MFP.
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Printing Modes

In the Printing Modes menu, you can set the way this equipment handles the print job. This menu allows you to enable 
various job types such as Private Print and Proof Print.

1) Print Mode
This sets the type of print job.
- Normal — Select this to print a job normally.
- Hold — Select this option to print a hold job. The print job, sent as a hold job, is saved in the hold job queue on this 

equipment. To perform printing, select the desired job on the touch panel display and press [PRINT]. This option is 
useful to prevent you forgetting to remove printed sheets.
For detailed instructions on how to use the touch panel display, see the following page:
 P.198 “Hold Print jobs”

- Proof — Select this option to print the first copy of a multicopy job and then wait for approval before printing the 
remaining copies. If a print job is sent as a proof job, one copy of the job is printed and the remaining copies are 
saved in the proof job queue on this equipment, which are not printed until you activate printing from the touch 
panel display. This option allows you to check a job’s output before printing the remaining copies and thereby 
reduce paper waste.
For detailed instructions on how to use the touch panel display, see the following page:
 P.191 “Proof Print jobs”

- Private - Password — Select this to print a private job.   When this is selected, specify the 5-digit password in the 
Private Document Password menu. The print job is saved in the private job queue on this equipment, and not 
printed until you activate printing from the touch panel display of this equipment. This option is useful when you 
want to print a confidential document secured with a password. The user has to enter the password to print the 
private job when activating printing from the touch panel display.

2) Department Code
Select this check box if a department code is required for printing. When this is enabled, specify the department code 
in the DC menu.
Enabling the department code depends on whether this equipment is managed with department codes or not. Please 
ask your administrator for your department code.
 P.164 “Printing Modes DC”

3) Toner Save
Select this check box to print in the toner save mode.

When the toner save mode is enabled, printing may become light.

4) Do not Print Blank Pages
Select this check box to ignore blank pages for printing.

 When more than 2 is selected at the [Page per Sheet] option in the Layout menu, the blank pages will be 
printed.

 The pages with header or footer will be printed even if the content is blank.
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Printing Modes DC

In the Printing Modes DC menu, you can specify your department code, if this equipment is so enabled. Before specifying 
the department code, you must check the Department Code option in the Printing Modes menu. Then specify the 
department code in this menu.

How the equipment performs printing for an invalid department code print job, for which an invalid department code is 
specified, varies depending on the Invalid Department Code Print Job setting that can be set in the TopAccess 
Administrator mode and whether SNMP communication is enabled or not. 
- When the Invalid Department Code Print Job is set to [Store to Invalid Job list], the invalid department code print 

job will be stored in invalid list without printing.
- When SNMP communication is disabled and Invalid Department Code Print Job is set to [Store to invalid job list], 

the invalid department code print job will be stored in the invalid department code print job list without printing. 
- When the Invalid Department Code Print Job is set to [Print], the invalid department code print job will be printed.
- When the Invalid Department Code Print Job is set to [Delete], the invalid department code print job will be deleted. 

1) Department Code (DC) - Digit 1
Select the first digit of the department code.

2) Department Code (DC) - Digit 2
Select the second digit of the department code.

3) Department Code (DC) - Digit 3
Select the third digit of the department code.

4) Department Code (DC) - Digit 4
Select the fourth digit of the department code.

5) Department Code (DC) - Digit 5
Select the fifth digit of the department code.
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Private Document Password

In the Private Document Password menu, you can specify the Document ID number for the private job. It is recommended 
to specify the Private Document Password when you select to print a private job. If you do not specify the Private 
Document Password, the private job uses default Private Document Password “00000”.

1) Password - Digit 1
Select the first digit of the Document ID.

2) Password - Digit 2
Select the second digit of the Document ID.

3) Password - Digit 3
Select the third digit of the Document ID.

4) Password - Digit 4
Select the fourth digit of the Document ID.

5) Password - Digit 5
Select the fifth digit of the Document ID.
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Quality

In the Quality menu, you can specify various image quality features.

This option is available only when your equipment is a multifunctional digital system. 

1) Halftone
This sets how to print halftones.
- Auto — Select this to print with proper halftone depending on the contents in the document automatically.
- Detail — Select this to print halftone in detail.
- Smooth — Select this to print halftone smoothly.

2) Smoothing
Select this check box to print texts and graphics smoothly.

3) Toner Save
Select this check box to print in the toner save mode.

When the toner save mode is enabled, printing may become light.

 Summary
In the Summary menu, you can confirm the current settings for printing.
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Printing From Application

This section describes how to print from a UNIX/Linux workstation.

 When the User Management setting is enabled, a print job sent from UNIX/Linux workstations is processed as an 
invalid job according to the User Authentication Enforcement setting. For more information about the User 
Authentication Enforcement setting, refer to the TopAccess Guide.

 Before attempting to print from a UNIX/Linux workstation, make sure all the UNIX/Linux Filters are installed in your 
workstation.

For instructions on how to install or set CUPS, refer to the Software Installation Guide.

Considerations and limitations
 This equipment acts only as a filter and not as a complete driver. The size and order of the printed pages cannot be 

modified.
 The UNIX/Linux filters do not support the following engine-supplied features:

- Enlarge/Reduce printing
- Rotate Sort
- N-up printing
- Watermarks
- Cover Sheets
- Sheet Insertion
- Scheduled Print
- Print to Overlay File
- Store to e-Filing
- Use Overlay Image

 Linux uses the lptap command to send a file to this equipment.
Since lp is not supported in all versions of Linux, the lptap command should be used instead.

 AIX supports printing using the qdaemon. This can be invoked by the user with the commands lp, lpr or qprt. In order 
to use the filter, either lp or qprt should be used.

 Printing using lp command
Use the lp command (lptap in Linux) to send a file to this equipment for printing. This command specifies various printer-
specific options using the -o option parameter on the command line. The lp command also sets other print options using 
various other parameters. Use the “man net_estcolor” command to display the online document that describes the various 
options and parameters that can be set to configure printed output.
All the options are sent to this equipment at the start of a print job so, if the print file contains its own commands, they may 
override the lp options.

Generic “lp” and “lptap” options

How to print files
Enter the following “Ip” command to print files with the specified printer:
lp -d <queuename> <filename>

Copies
The number of copies of a print job is specified using the “-n <value>” parameter with the “lp” command. The default value 
is determined by the “lp” command and it is always 1. The copies are always collated.

 Title
The title that is printed on the banner page can be specified using the “-t <title>” parameter with the “lp” command. The 
default value is determined by the “lp” command and it is often the name of the print file. If multiple files are printed using 
the same “lp” command the default title is set to the name of the first file by the “lp” command.
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General options
Options below apply to all print jobs of the ES9160 MFP/ES9170 MFP/ES9460 MFP/ES9470 MFP/CX3535 MFP/CX4545 
MFP.

 Option commands are case sensitive and must be entered exactly as shown.
 Some printing functions may be disabled depending on the combinations of option commands because priority is 

given to the specifications of this equipment over option commands.

 Print Language
The “net_estcolor” program needs to know what printer language is used in each of the files that it is printing so that it can 
issue the correct commands to select various options. The following options are valid for the print languages.

All PCL5e jobs automatically send the “<esc>&k2G” command to convert the line-feed character into a carriage-return - 
line-feed sequence. If the PCL5e job contains some of its own escape sequences it may override this setting.
The default print language is “auto”.
Example: The command to specify that a file is PostScript is “lp -o ps <filename>”.

Option Value Alternate Value Description

auto Each file to be printed is examined to see if it starts with 
the “%!” sequence. If it does, then it is assumed that it is 
a PostScript file, otherwise it assumes that it is a plain 
text or a PCL6 file.

pcl The print file is always treated as a plain text or a PCL6 
file.

postscript ps The file is always treated as a PostScript file.

raw The file is treated as a fully formatted file that already 
contains all the necessary commands. The file is sent to 
the printer without any modifications. In this mode no 
other options are valid and a banner page is not printed.
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 Stapling
This sets whether a print job is printed with staples. When the optional Finisher is installed it can be activated using the 
following option.

If this option is not specified, the printer’s default value will be used.
Example: The command to staple in the upper left corner of a long edge feed portrait page is “lp -o staple=1 <filename>”.
The value for the stapling position depends on the paper size, the paper feed direction, and the print direction. This 
function is not available for all paper sizes and the users should refer to the Copying Guide for a list of compatible paper 
sizes. In particular, A5, A6 and statement paper sizes will not work with this function.

Select [Tray 2] for stapling with the Finisher (optional) or the Saddle Stitch Finisher (optional).

 Folding
This sets whether the Folding feature is enabled or not using the following options:

If the Saddle Stitch Finisher (optional) is not installed or it is not specified, the default value of “folding=off” is used.
Example: The command to enable the Folding feature is “lp -o folding=on <filename>”.

Option Value Alternate Value Description

staple=0 Stapling is turned off.

staple=1 Staple in the top left corner of a portrait page and the 
upper right corner of a landscape page.

staple=2 Put two staples on the left side of a portrait page or the 
top side of a landscape page printed on long-edge-feed 
paper. This command has no effect when the paper is 
fed from the short-edge side.

staple=3 Staple in the bottom left corner of a portrait page and 
the upper left corner of a landscape page.

staple=4 Staple in the top right corner of a portrait page and the 
bottom right corner of a landscape page.

staple=5 Put 2 staples on the right side of a portrait page or the 
bottom side of a landscape page printed on long-edge-
feed paper. This command has no effect when the 
paper is fed from the short-edge side.

staple=6 Staple in the bottom right corner of a portrait page and 
the lower left corner of a landscape page.

staple=7 Put 2 staples on the top side of a portrait page or the 
right side of a landscape page printed on short-edge-
feed large format (A3/Ledger) paper. This command 
has no effect when the paper is fed from the long-edge 
side or small paper size.

staple=8 Put 2 staples on the bottom side of a portrait page or 
the left side of a landscape page printed on short-edge-
feed large format (A3/Ledger) paper. This command 
has no effect when the paper is fed from the long-edge 
side or small paper size.

staple=9 Put 2 staples in the middle of a landscape page and fold 
the paper in half vertically along the staple line (saddle 
stitching). This command works in conjunction with 
booklet printing. This command has no effect when the 
paper is fed from the long-edge side.

Option Value Alternate Value Description

folding=off OFF Folding is disabled.

folding=on ON Folding is enabled.
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Output Bin
The output bin can be specified using the following options.

If the Finisher (optional) is not installed on the equipment, the default output tray will be used (inner). If the Finisher 
(optional) is installed on the equipment, the default output tray will be used (bin2).
Example: The command to specify output bin 1 is “lp -o bin1 <filename>”.

Hole Punching
This sets whether a print job is printed with hole punches. When the hole punch option is installed it can be activated using 
the following option.

If this option is not specified, the default value of “nopunch” will be used.
This function is not available for all paper sizes and the users should refer to the Copying Guide for a list of compatible 
paper sizes. In particular, A5, A6 and statement paper sizes will not work with this function.
Example: The command to hole punch the long edge feed portrait page is “lp -o punch=1 <filename>”.

Media Type
The paper source can also be selected using the media type using the following option.

In PostScript Deferred Media Selection is always turned on so the paper size has priority over the media type and the 
paper source.
In PCL5e the paper size always has priority over the media type and the paper source.
If this option is not specified, the default value will be used.
Example: The command to specify Thick1 media type is “lp -o mtype=Thick1 <filename>”.

Option Value Alternate Value Description

inner Select the inner tray.

bin1 Select the upper output tray of the Finisher (optional).

bin2 Select the lower output tray of the Finisher (optional).

Option Value Alternate Value Description

punch=0 nopunch Hole punching is turned off.

punch=1 Hole punch on long edge without rotation.

punch=2 Hole punch on short edge without rotation.

punch=3 Hole punch on long edge with 180 degree rotation.

punch=4 Hole punch on short edge with 180 degree rotation.

Option Value Alternate Value Description

mtype=Plain A paper source that contains Plain paper is requested.

mtype=
Transparency

A paper source that contains transparency slides is 
requested.

mtype=Thick1 A paper source that contains Thick1 paper is 
requested.

mtype=Thick2 A paper source that contains Thick2 paper is 
requested.

mtype=Thick3 A paper source that contains Thick3 paper is 
requested.
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 Paper Source
The paper source can be selected using the following options.

In PostScript Deferred Media Selection is always turned on so the paper size has priority over the paper source. In PCL5e 
the paper size always has priority over the paper source.
If this option is not specified the command will not be sent so the printer’s default value will be used.
Example: The command to specify the Large Capacity Feeder (optional) paper source is “lp - o lcf <filename>”.

The 3rd and 4th drawers are optional.

Duplexing
The current duplex mode can be specified using the following options.

If this option is not specified, the default value “simplex” will be used.
It is not necessary to specify duplexing for Booklet Mode (sduplex). Setting duplexing separately can override the booklet 
mode setting for duplexing.
Example: The command to specify long edge duplexing is “lp -o duplex <filename>”.

Option Value Alternate Value Description

auto-source Select auto paper tray selection.

manual Select Bypass Tray.

drawer1 upper
cas1

Select the 1st drawer.

drawer2 lower
cas2

Select the 2nd drawer.

drawer3 pedupper
cas3

Select the 3rd drawer (optional).

drawer4 pedlower
cas4

Select the 4th drawer (optional).

LCF lcf Select the Large Capacity Feeder (optional). The Large 
Capacity Feeder (optional) is not available for some 
countries or regions.

Option Value Alternate Value Description

simplex Turn duplexing off.

duplex lduplex
duplex_long
duplex=long
hduplex

Turn duplexing on with long edge binding.

sduplex duplex_short
duplex=short
vduplex

Turn duplexing on with short edge binding.
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 Paper Size
The current paper size can be specified using the following options.

If this option is not specified, the printer’s default value will be used.
Example: The command to specify the A4 paper size is “lp -o a4 <filename>”.

 Printing Modes
The printing mode can be selected using the following options.

If this option is not specified, the printer’s default value will be used.
A private printing job requires the user to enter a maximum number of 63 character long string.
Character lengths longer than 63 will be clipped to 63.
The following characters are invalid, but no type checking is carried out.
” & ’ ( ) ; < > ˆ ` | ~ @ # % * !

Option Value Alternate Value Description

letter lt
LT

Select Letter size paper.

A4 a4 Select A4 size paper.

legal lg
LG

Select Legal size paper.

statement st
ST

Select Statement size paper.

ledger ld
LD

Select Ledger size paper.

ledgerwide ldwide
LDWIDE

Select Ledger wide size paper.

folio folio-japan Select Folio size paper.

A3 a3 Select A3 size paper.

A3WIDE a3wide Select A3-Wide size paper.

A5 a5 Select A5 size paper.

A6 a6 Select A6 size paper.

B4 b4
b4-jis
B4-JIS

Select JIS B4 size paper.

B5 b5
b5-jis
B5-JIS

Select JIS B5 size paper.

computer co
CO

Select Computer size paper.

legal13 lg13
LG13

Select LG13inch size paper.

sq85 letter-square Select SQ8.5inch size paper.

postcard Select Postcard size paper.

8K 8k Select 8K size paper.

16K 16k Select 16K size paper.

Option Value Alternate Value Description

normal Process as a normal print job.

hold Process as a hold print job.

proof Process as a proof print job.

private=din Process as a private print job. The din is up to a 63-digit 
(between 1 to 63) password.
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Department Code
The department code can be set using the following option.

A department code is specified within 63 characters. 
If the entered department code is longer than 63 characters, it is clipped to 63 characters when a job is sent. 
The following characters are invalid for department codes: 
" & ' ( ) ; < > ^ ` | ~ @ # % * !

Enther the department code in a 5-digit number.

 How the equipment performs printing for an invalid department code print job, for which an invalid department code 
is specified, varies depending on the Invalid Department Code Print Job setting that can be set in the TopAccess 
Administrator mode and whether SNMP communication is enabled or not. 
- When SNMP communication is enabled and Invalid Department Code Print Job is set to [Store to invalid job 

list], an error message will be displayed when an invalid department code is entered. 
- When SNMP communication is disabled and Invalid Department Code Print Job is set to [Store to invalid job 

list], the invalid department code print job will be stored in the invalid department code print job list without 
printing. 

- When the Invalid Department Code Print Job is set to [Print], the invalid department code print job will be 
printed.

- When the Invalid Department Code Print Job is set to [Delete], the invalid department code print job will be 
deleted. 

 For the appropriate department code, ask your system administrator.

 Smoothing
This sets whether to print text and graphics smoothly. This mode can be set using the following option.

Example: The command to set the smoothing mode is “lp -o smoothing=on <filename>”.

This option is available only when you have either the ES9160 MFP/ES9170 MFP.

Option Value Alternate Value Description

dept=code Set the department code. A department code within 63 
characters comes in [code].

Option Value Alternate Value Description

smoothing=on ON Set the smoothing mode.

smoothing=off OFF Cancel the smoothing mode.
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Distinguish Thin Lines
This sets whether to distinguish thin lines or not. This mode can be set using the following option.

Example: The command to set the thin line limit mode is “lp -o thinlinelimit=on <filename>”.

Do Not Print Blank Pages
This sets whether or not a blank page is printed. This mode can be selected using the following option.

Example: The command to set the blank page mode is “lp -o blankpage=0 <filename>”.

 Toner Save
The toner save mode can be set using the following option.

Example: The command to set the toner save mode is “lp -o tonersave=on <filename>”.

Option Value Alternate Value Description

thinlinelimit=on ON Set the thin line limit mode.

thinlinelimit=off OFF Cancel the thin line limit mode.

Option Value Alternate Value Description

blankpage=0 Set the blank page mode (disable Do not Print Blank 
Pages).

blankpage=1 Cancel the blank page mode (enable Do not Print Blank 
Pages).

Option Value Alternate Value Description

tonersave=on ON Set the toner save mode.

tonersave=off OFF Cancel the toner save mode.



4 PRINTING FROM UNIX/Linux

176    Printing From Application

Booklet Modes
The booklet mode can be selected using the following options.

The booklet mode applies only for the PostScript data. Performing the booklet printing using the PCL data is invalid.

In a job, if this value is LT, and in PDL too the data are for LT paper size, this will result in a scaled booklet on Letter paper. 
In a job, if this value is A3, and in PDL the data are for A4 paper size, this will result in a tiled booklet on A3 paper.
When the Booklet Mode options is selected, the paper size is automatically set to the same size as for Booklet Mode. This 
function is only available for A3, A4, B4, Letter and Ledger paper sizes.
If the booklet mode is selected, then duplexing is also selected automatically (sduplex). Setting duplexing separately can 
override the booklet mode setting for duplexing.
Example: The command to select Letter size paper for the booklet printing mode is “lp –o booklet=letter <filename>”.

Option Value Alternate Value Description

booklet=letter lt
LT

Select Letter size paper for the booklet printing mode.

booklet=A4 a4 Select A4 size paper for the booklet printing mode.

booklet=legal lg
LG

Select Legal size paper for the booklet printing mode.

booklet=
statement

st
ST

Select Statement size paper for the booklet printing 
mode.

booklet=ledger ld
LD

Select Ledger size paper for the booklet printing mode.

booklet=folio folio-japan Select Folio size paper for the booklet printing mode.

booklet=A3 a3 Select A3 size paper for the booklet printing mode.

booklet=A5 a5 Select A5 size paper for the booklet printing mode.

booklet=B4 b4
B4-JIS
b4-jis

Select JIS B4 size paper for the booklet printing mode.

booklet=B5 b5
B5-JIS
b5-jis

Select JIS B5 size paper for the booklet printing mode.

booklet=
computer

co
CO

Select Computer size paper for the booklet printing 
mode.

booklet=legal13 lg13
LG13

Select Legal-13 size paper for the booklet printing 
mode.

booklet=SQ85 sq85
letter-square

Select 8.5 inch square size paper for the booklet 
printing mode.

booklet=8K 8k Select 8K size paper for the booklet printing mode.

booklet=16K 16k Select 16K size paper for the booklet printing mode.
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 Page Layout
The booklet mode page layout can be selected using the following options.

If left2right=off then long edge binding is selected, otherwise if left2right=on then short edge binding is used.
Example: The command to select left to right page layout for the booklet printing mode is “lp -o left2right=on <filename>”.

Center Margin
The booklet mode center margin can be selected using the following options.

Example: The command to select the center margin value for the booklet printing mode is “lp -o centermargin=value 
<filename>”.

Outer Margin
The booklet mode outer margin can be selected using the following options.

Example: The command to select the outer margin value for the booklet printing mode is “lp -o outermargin=value 
<filename>”.

Option Value Alternate Value Description

left2right=off OFF Select right to left page layout for the booklet printing 
mode.
This value decides the layout of the pages in the 
booklet.
If this value is OFF then the layout of pages is Right to 
Left as shown in the figure below.

left2right=on ON Select left to right page layout for the booklet printing 
mode.
This is the default setting.
If the value is ON then the layout of the pages is from 
Left to Right as shown in the figure below.

Option Value Alternate Value Description

centermargin
=value

Select the center margin value for the booklet printing 
mode.
This value specifies in pixels the Center Margin or the 
“Gutter”. This is in addition to the center margin already 
specified by the application. The valid range for value is 
0 - 300. Default is 0.

Option Value Alternate Value Description

outermargin
=value

Select the outer margin value for the booklet printing 
mode.
This value specifies in pixels the Outer Margin or the 
“Creep” per page, which should take place while 
printing a booklet. The valid range for value is 0 - 600. 
Default is 0.
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Collate
The collate option can be selected using the following options.

f this option is not specified, the default value of “collate=on” will be used.
Example: The command to select collate off is “lp -o collate=off <filename>”.

Orientation
The following orientation options are available.

If this option is not specified the command will not be sent so the printer’s default value will be used.
Example: The command to specify landscape orientation is “lp -o landscape <filename>”.

 Font Pitch
If the pitch is specified the net_estcolor program will always select the Courier font; otherwise the default font is used. The 
following options are used to select the font pitch.

In all the cases shown above the Courier font will also be selected. When the pitch is changed, the font size will 
automatically be scaled to the appropriate size.
If this option is not specified, the default pitch and font will be used.
Example: The command to specify 8 characters per inch is “lp -o pitch=8 <filename>”.

 Page Length
The number of lines to print on a page can be specified with the following option.

As this equipment is a page printer we cannot change the physical length of a piece of paper so the actual effect of this 
command is to after the value for lines per inch so that the requested number of lines is printed on the page. The actual 
page length may differ from this value if the top margin or the text length option is used.
If this option is not specified the PJL command will not be sent so the printer’s default value will be used. The minimum 
page length allowable is 5. If value is less than 5, the page length is set to 5.
The command to specify 66 lines per page is “lp -o pl=66 <filename>”.

Option Value Alternate Value Description

collate=off OFF Cancel the collate printing mode.

collate=on ON Set the collate printing mode.

Option Value Alternate Value Description

portrait Print the document in portrait orientation.

landscape Print the document in landscape orientation.

Option Value Alternate Value Description

c pitch=16.67 Set the character pitch to 16.67 characters per inch.

10 pitch=10 Set the character pitch to 10 characters per inch.

12 pitch=12 Set the character pitch to 12 characters per inch.

pitch=value Set the character pitch to value characters per inch.

Option Value Alternate Value Description

pl=value Set the lines per page to value.
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Color Mode
This sets whether a print job is printed in color, mono, or twin color. The color mode for printing mode can be selected 
using the following options.

Example: The command to set the color mode for the print job is “lp -o colormode=COLOR <filename>”

This option is available only when you have either the ES9460 MFP/ES9470 MFP/CX3535 MFP/CX4545 MFP.

 Pure Black and Pure Gray
This sets whether printing the black and gray scale contents in a document using the black toner. This mode can be 
selected using the following options.

Example: The command to set the pure black and pure gray mode for the print job is “lp -o pureblackgray=1 <filename>”

This option is available only when you have either the ES9460 MFP/ES9470 MFP/CX3535 MFP/CX4545 MFP.

Option Value Alternate Value Description

colormode=
COLOR

color Set color mode printing for the print mode.

colormode=
GRAYSCALE

grayscale Set grayscale mode printing for the print mode.

colormode=
AUTO

auto Set auto color mode printing for the print mode.

colormode=
2KR

2kr Set twin color mode (Black and Red) printing for the 
print mode.

colormode=
2KG

2kg Set twin color mode (Black and Green) printing for the 
print mode.

colormode=
2KB

2kb Set twin color mode (Black and Blue) printing for the 
print mode.

colormode=
2KC

2kc Set twin color mode (Black and Cyan) printing for the 
print mode.

colormode=
2KM

2km Set twin color mode (Black and Magenta) printing for 
the print mode.

colormode=
2KY

2ky Set twin color mode (Black and Yellow) printing for the 
print mode.

colormode=
2KW

2kw Set twin color mode (Black and White) printing for the 
print mode.

Option Value Alternate Value Description

pureblackgray=0 Disable the black toner printing of the black and gray 
scale contents.

pureblackgray=1 Enable the black toner printing of the black contents.

pureblackgray=2 Enable the black toner printing of the black and gray 
scale contents.
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 Image Quality Type
The Image Quality Type can be selected using the following options.

Example: The command to set the normal quality type for the print job is “lp -o iqnormal <filename>”

This option is available only when you have either the ES9460 MFP/ES9470 MFP/CX3535 MFP/CX4545 MFP.

Halftone
This sets the appropriate processing on halftone images. The halftone can be selected using the following options.

Example: The command to set the auto halftone for the print job is “lp -o halftone=AUTO <filename>”

Black Overprint
This sets whether to print background content that has black text overlaid on it. If this is enabled, the gap between the text 
and the background is minimized and color deviation is prevented. This mode can be selected using the following options.

Example: The command to set the black overprint mode for the print job is “lp -o blackoverprint=1 <filename>”

This option is available only when you have either the ES9460 MFP/ES9470 MFP/CX3535 MFP/CX4545 MFP.

Option Value Alternate Value Description

iqnormal Set the proper image quality for printing a general color 
document.

iqphoto Set the proper image quality for printing photos.

iqpresen Set the proper image quality for printing a vivid 
document.

iqlineart Set the proper image quality for printing a document 
containing a lot of characters or line art.

Option Value Alternate Value Description

halftone=AUTO Set the proper halftone depending on the contents in 
the document automatically.

halftone=DETAIL Set the halftone in detail.

halftone=
SMOOTH

Set the halftone smoothly.

Option Value Alternate Value Description

blackoverprint=0 Disable the black over print mode.

blackoverprint=1 Enable the black over print mode.
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Color Balance
The Color Balance can be selected using the following options.

Example: The command to set “1” to the color balance for black toner for the print job is “lp -o CBK=1 <filename>”

This option is available only when you have either the ES9460 MFP/ES9470 MFP/CX3535 MFP/CX4545 MFP.

 Image Attributes
The Image Attributes can be selected using the following options.

Example: The command to set “1” to the brightness for the print job is “lp -o brightness=1 <filename>”

This option is available only when you have either the ES9460 MFP/ES9470 MFP/CX3535 MFP/CX4545 MFP.

Option Value Alternate Value Description

CBC=value Specify the color density of cyan toner. You can specify 
the following values:
-4, -3, -2, -1, 0, 1, 2, 3, 4

CBM=value Specify the color density of magenta toner. You can 
specify the following values:
-4, -3, -2, -1, 0, 1, 2, 3, 4

CBY=value Specify the color density of yellow toner. You can 
specify the following values:
-4, -3, -2, -1, 0, 1, 2, 3, 4

CBK=value Specify the color density of black toner. You can specify 
the following values:
-4, -3, -2, -1, 0, 1, 2, 3, 4

Option Value Alternate Value Description

brightness=value Specify the brightness. You can specify the following 
values:
-4, -3, -2, -1, 0, 1, 2, 3, 4

contrast=value Specify the contrast. You can specify the following 
values:
-4, -3, -2, -1, 0, 1, 2, 3, 4

saturation=value Specify the saturation. You can specify the following 
values:
-4, -3, -2, -1, 0, 1, 2, 3, 4

sharpness=value Specify the sharpness. You can specify the following 
values:
-4, -3, -2, -1, 0, 1, 2, 3, 4

backgroundadjus
tment=value

Specify the background adjustment. You can specify 
the following values:
-4, -3, -2, -1, 0, 1, 2, 3, 4



4 PRINTING FROM UNIX/Linux

182    Printing From Application

 PCL5e specific options
Some of the options only apply to plain text or PCL5e files.

 Text Wrapping
The following options control text wrapping when it reaches the right margin.

If this option is not specified, the command will not be sent so the printer’s default value will be used.
Example: The command to specify wrapping is “lp -o wrap <filename>”.

 Left Margin
The left margin position can be specified with the following option.

If the left margin is set to the right of the right margin it will be ignored.
If this option is not specified, the command will not be sent so the printer’s default value will be used.
Example: The command to set the left margin to five columns is “lp -o lm=5 <filename>”.

Right Margin
The right margin position can be specified with the following option.

If the right margin is set to the left of the left margin, or if it is set to a position wider than the logical page, it will be ignored. 
The right margin is specified in columns from the left margin. A negative value will be ignored.
If this option is not specified, the command will not be sent so the printer’s default value will be used.
Example: The command to set the right margin to fifty columns is “lp -o rm=50 <filename>”.

 Top Margin
The top margin position can be specified with the following option.

If the top margin is set too high or too low, part of the text may not appear due to the printer’s unprintable region. The top 
margin will be ignored if it is set to a value greater than the printer’s logical page length. Setting this value may affect the 
number of lines specified using the page length option.
If this option is not specified, the command will not be sent so the printer’s default value will be used.
Example: The command to set the top margin to ten lines is “lp -o tm=10 <filename>”.

 Text Length
The text length can be specified using the following options.

If the text length is set too high, part of the text may not appear due to the printer’s unprintable area. The text length will be 
ignored if it is set to a value greater than the printer’s logical page length minus the top margin. The text length is specified 
in rows from the top margin. Setting this value may affect the number of lines specified using the page length option.
If this option is not specified, the command will not be sent so the printer’s default value will be used.
Example: The command to set the text length to 40 lines is “lp -o tl=40 <filename>”.

Option Value Alternate Value Description

wrap Enable automatic text wrapping.

nowrap Disable automatic text wrapping.

Option Value Alternate Value Description

lm=value Set the left margin to value columns.

Option Value Alternate Value Description

rm=value Set the right margin to value columns.

Option Value Alternate Value Description

tm=value Set the top margin to value lines.

Option Value Alternate Value Description

tl=value Set the length to value lines.
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Banner Page
A banner page is automatically generated for each file in each job. The banner page is always sent as a PCL5e job, 
including the following items.
  Name of the user who performed printing
 Job ID number and workstation name from which the job was sent
 Job title (This can be specified using the “-t” option. The same title controlled by the “lp” command is normally applied 

to each job.)
 Option specified when printing was performed
 Number of printed sheets
 Name of the printer and its IP address
 Date and time

Only one copy of the banner page is printed for each file, even if a number of copies of the job are requested. The banner 
page is sent to the equipment as a separate sub-job so that it is never stapled to the document.
The banner page is printed with the following settings.
 Copies = 1.
 Stapling off.
 Hole punching off.
 Orientation = portrait.
 Duplex off.
 Paper size as requested by the “-o” parameter or the printer’s default value.
 The paper source and the media type for the banner page can be set to different values than the job’s paper source 

and media type.
 Auto paper source selection or the requested banner page source or media type.
 Output bin as requested by the “-o” parameter or the printer default value.
 6 lines per inch
 Auto-wrap on.
 Automatic carriage-return when a line-feed is sent.

 The banner page is designed to fit the paper bigger than Statement / A5.
The banner page uses the default paper size if paper is set to:
- Statement
- A5
- A6
- B5
- Postcard

 The default is that the banner page is printed before the job so that it is in the correct stacking order.
 When the language is set to “raw” the banner is always disabled.
 The paper source and the media type for the banner page can be set to values different than the job’s paper source 

and media type. If a banner paper source is not specified then the auto source command is sent. If a banner media 
type is not specified, then no banner media type command is sent, so the printer’s default value will be used.

 If the file being printed specifies the paper destination or the paper size internally, the banner page may printed to 
the wrong output or on an incorrect paper size.

 Hole punching cannot be applied to banner pages.
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Banner Options

The banner page can be printed using the following options.

The default value for this option is that the banner page is printed first.
Example: The command to printing the banner page after the job is “lp -o banner=last <filename>”.

Banner Paper Source

The banner paper source can be specified using the following option.

If the banner paper source is not specified the PCL5e auto paper source command “<esc>&l7H” will be sent. The banner 
page source cannot be set to manual feed. The paper size always has priority over the paper source.
Example: The command to specify that the banner page paper source is the Large Capacity Feeder (optional) is “lp -o blcf 
<filename>”.

Banner Media Type

The banner page paper source can also be selected using the media type using the following option.

The paper size always has priority over the media type and the paper source.
If this option is not specified, the command will not be sent so the printer’s default value will be used to print the banner 
page.
The command to specify that the banner page should be printed on a media type is “lp -o bmtype=Plain1 <filename>”.

Option Value Alternate Value Description

banner=last Print the banner page after the job so that it will be 
physically on top of the job in the output tray.

banner=first banner Print the banner page before the job so that it will be 
physically under the job in the output tray.

nobanner nb Do not print a banner. The ability to specify the 
“nobanner” option can be disabled by the system 
administrator to force all jobs to print with a banner.

Option Value Alternate Value Description

bauto-source Select the auto paper tray selection.

bdrawer1 bupper
bcas1

Select the 1st drawer.

bdrawer2 blower
bcas2

Select the 2nd drawer.

bdrawer3 bpedupper
bcas3

Select the 3rd drawer (optional).

bdrawer4 bpedlower
bcas4

Select the 4th drawer (optional).

blcf BLCF Select the Large Capacity Feeder (optional). The Large 
Capacity Feeder (optional) is not available for some 
countries or regions.

Option Value Alternate Value Description

bmtype=Plain A paper source that contains Plain paper is requested.

bmtype=
Transparency

A paper source that contains transparency slides is 
requested.

bmtype=Thick1 A paper source that contains Thick1 paper is 
requested.

bmtype=Thick2 A paper source that contains Thick2 paper is 
requested.

bmtype=Thick3 A paper source that contains Thick3 paper is 
requested.
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Monitoring the Print Job Status

Your print jobs can be monitored on the equipment’s touch panel. The types of print jobs you can monitor include Normal 
Print, Scheduled Print, Private Print, Hold Print and Proof Print. If the Department Management feature is enabled, the 
equipment can also display the Invalid jobs, which are held without being printed. You can view the status, as well as 
release, delete, pause/resume, and change the order of these jobs. Connecting a USB storage device to the equipment 
allows you to print PDF, encrypted PDF, XPS, JPEG, PRN and PS files contained in the media directly from the touch 
panel without using a client computer (USB Direct Printing).

If the equipment is managed by the User Management feature, you need to enter the user information, such as the 
user name and password.

 P.186 “Normal Print / Scheduled Print jobs”
 P.191 “Proof Print jobs”
 P.194 “Private Print jobs”
 P.198 “Hold Print jobs”
 P.202 “Invalid jobs”
 P.205 “Printing files from USB media (USB Direct Printing)”

Only when the Fax received print function is enabled, will the following be possible. Hold Print jobs for faxes stored in 
the equipment after they have been received can be displayed in the list, which appears when you press the [PRINT] 
button on the control panel and then [HOLD (FAX)]. For details of the Fax received print function, contact your service 
technician.

Normal Print / Scheduled Print jobs
When you press [JOB STATUS] on the touch panel, the [JOBS] tab of the JOB STATUS screen appears. On the [JOBS] 
tab, Normal Print and Scheduled Print jobs are listed together with copy jobs. You can check the user name, date and time 
of registration, paper size, number of pages, number of copies, and current status of each job. You can also delete, pause 
or resume each job, and change the order of the jobs on the list.
When the Job Skip function is enabled, a job fails due to lack of paper or such is automatically skipped and the next job is 
processed. For instructions on how to set the Job Skip function, refer to the MFP Management Guide.

For the Scheduled Print jobs, “Scheduled” is indicated in the “Status” column.

Up to 1000 jobs can be listed. To display the previous or next page, press  or . The number of jobs displayed on a 
page may vary depending on the equipment used.

To exit from the JOB STATUS screen, press [CLOSE].

 On the [JOBS] tab, you can select the desired mode for monitoring the status by pressing [PRINT], [FAX], or 
[SCAN]. For details on the scan or Internet fax job status, refer to the Scanning Guide. For details on the fax job 
status, refer to the GD-1250/GD-1260 Operator’s Manual for FAX Unit (optional).

 Besides the Job Skip function, this equipment prevents the process of a print job from being paused with some 
setting changes. When paper has run out during printing, for example, you can continue printing with Automatic 
Change of Paper Source (a function that feeds paper in the same size from another drawer when paper in the 
specified drawer has run out). Also when staples have run out or when the hole punch dust bin has become full, 
you can continue printing without stapling or hole punching. For the details, refer to the MFP Management Guide.
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Deleting jobs
Follow the procedure below when you want to delete unnecessary Normal Print / Scheduled Print jobs.

1 On the [JOBS] tab listing the print jobs ( P.186), select the job that you want to delete, 
and then press [DELETE]. You can select more than one job.

2 When “Delete OK?” appears, press [DELETE].

The selected job is deleted.
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 Pausing/Resuming jobs
Jobs whose status is “Wait” can be held in the queue (Pausing).

Pausing jobs
On the [JOBS] tab listing the print jobs ( P.186), select the job that you want to pause and then press [PAUSE].

The selected job is paused. When a job is paused, the subsequent jobs on the list will be released earlier.

Resuming paused jobs
Select the job that you want to resume and then press [RESUME].



5.MANAGING PRINT JOBS FROM THE CONTROL PANEL

Monitoring the Print Job Status    189

5 MANAGING PRINT JOBS FROM THE CONTROL PANEL

Changing the job order
You can change the order of the jobs by moving them within the list.

You can only move jobs from and to those whose status is “Wait”.

1 On the [JOBS] tab listing the print jobs ( P.186), select the job that you want to move 
in the list, and then press [MOVE].

If the target job is not displayed on the page, use  and  to change between pages.

2 Specify the new position of the job. (The job will be moved under the job selected here.)
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Confirming the information of a skipped job
You can confirm the information of a job skipped by the Job Skip function.

1 On the [JOBS] tab listing the print jobs ( P.186), confirm the information of the 
skipped job.
1) Select the skipped job. 
2) Press [RECOVERY INFORMATION].

2 Resolve the cause of the skip following the instructions on the screen.

If multiple causes exist, the second cause is displayed after you resolve the first one. Resolve all causes 
accordingly.
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 Proof Print jobs
Proof Print refers to the function to print only a single copy as a sample and suspend the rest of the job when you print 
multiple copies from a computer on the network.
After viewing the first copy, you can decide, on the Proof Print job list, whether to print out the remaining copies or cancel 
the job to change the settings. If you select to print the remaining copies, you can change the number of copies to print.
For detailed instructions on Proof Print, see the following page:
 P.82 “Printing proof print jobs”

Displaying the Proof Print job list
Follow the procedure below when you want to display the list of Proof Print jobs.

2 Select [PROOF].

The Proof Print jobs are listed on the screen.

1 On the control panel, press the [PRINT] button.
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 Printing remaining copies
Follow the procedure below if you have checked the first copy and want to print the remaining copies.

1 On the Proof Print job list ( P.191), select the job for printing.

If the target job is not displayed on the screen, use  and  to change between pages.

2 Press [PRINT].

The remaining copies are printed out.
The job in progress can be monitored on the [JOBS] tab listing the Normal Print jobs ( P.186).

To change the number of copies to print, press [EDIT] and enter the number of copies. Pressing [PRINT] starts 
the job.
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Deleting Proof Print jobs
Follow the procedure below to delete Proof Print jobs.

1 On the Proof Print job list ( P.191), select the job that you want to delete, and then 
press [DELETE]. 

If the target job is not displayed on the screen, use  and  to change between pages.

2 When “Delete OK?” appears, press [DELETE].

The selected job is deleted.
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 Private Print jobs
Private Print refers to the function to print a document from a computer on the network only when a set password is keyed 
in to the equipment’s control panel. This function is useful when you want to print confidential documents and prevent 
them from being seen by others. Private Print jobs can be released or deleted from the Private Print job list.
For detailed instructions on Private Print, see the following page:
 P.80 “Printing private print jobs”

Displaying the Private Print job list
Follow the procedure below to display the list of Private Print jobs.

2 On the Private Print job list, select the desired user name and then press [OK].

 When you enter the nickname for [User name (Alias)] box on the [Others] tab on a Windows computer, and 
send the job to the equipment, its nickname will be displayed on the Private Print job list. If not, the user 
name that is entered to log in to your computer will be displayed on the Private Print job list.

 If you perform the operation as the administrator, press [ADMIN. PASSWORD] instead of selecting a user 
name. The on-screen keyboard appears, with which you can enter the 6-to-64-digit administrator password. 
In this case, the jobs can be deleted but are not allowed to be printed.

1 On the control panel, press the [PRINT] button.

If the Private print job list is not displayed, select [PRIVATE] from 
the box of the job types.
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3 Enter the password for the Private Print job, which has previously been set via the 
computer, and then press [OK].

The Private Print jobs are listed on the screen.

 When the Private Print job is sent from a Windows computer:
- When the user name that is entered to log in to your computer is used for [User name (Alias)], the 

displayed list contains the Private Print jobs for which the same password has been set.
- When the nickname is entered for [User name (Alias)], the displayed list contains the Private Print jobs 

for which the same nickname and the same password have been set.
 When the Private Print job is sent from a Macintosh computer or a UNIX/Linux workstation:

- The displayed list contains the Private Print jobs for which the same password has been set.
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 Printing Private Print jobs
Follow the procedure below to release your Private Print jobs from the control panel.

1 On the Private Print job list ( P.194), select a job for printing. You can select more 
than one job.

 If the target job is not displayed on the screen, use  and  to change between pages.
 If you want to select all the jobs displayed on the screen, press [SELECT ALL]. To cancel the selection, press 

[ALL CLEAR].

2 Press [PRINT].

The equipment starts printing.
The job in progress can be monitored on the [JOBS] tab listing the Normal Print jobs ( P.186).
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Deleting Private Print jobs
Follow the procedure below to delete a Private Print job.

1 On the Private Print job list ( P.194), select the job that you want to delete, and then 
press [DELETE]. You can select more than one job.

 If the target job is not displayed on the screen, use  and  to change between pages.
 If you want to select all the jobs displayed on the screen, press [SELECT ALL]. To cancel the selection, press 

[ALL CLEAR].

2 When “Delete OK?” appears, press [DELETE].

The selected job is deleted.
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Hold Print jobs
Hold Print refers to the function to retain a document from a computer on the network until a user performs printing from 
the equipment’s touch panel. This function is useful to prevent you forgetting to remove printed sheets. Hold Print jobs can 
be released or deleted from the Hold Print job list.
For the detailed instructions on Hold Print, see the following page:
 P.81 “Printing hold print jobs”

Displaying the Hold Print job list
Follow the procedure below to display the list of Hold Print jobs.

2 Select [HOLD].

The Hold Print jobs are listed on the screen.

1 On the control panel, press the [PRINT] button.
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3 On the Hold Print job list, select the desired user name.

The displayed list contains the Hold Print jobs stored in the Hold Print queue.

 When you enter the nickname for [User name (Alias)] box on the [Others] tab on a Windows computer, and 
send the job to the equipment, its nickname will be displayed on the Hold Print job list. If not, the user name 
that is entered to log in to your computer will be displayed on the Hold Print job list.

 If you perform the operation as an administrator, press [ADMIN. PASSWORD] instead of selecting a user 
name. The on-screen keyboard appears, with which you can enter the 6-to-64-digit administrator password. 
In this case, the jobs can be deleted but are not allowed to be printed.

 When the Hold Print job is sent from a Windows computer:
- When the user name that is entered to log in to your computer is used for [User name (Alias)], the 

displayed list contains the Hold Print jobs which have been registered by the selected user.
- When the nickname is entered for [User name (Alias)], the displayed list contains all the Hold Print jobs 

which have been registered by users having the same nickname.
 When the Hold Print job is sent from a Macintosh computer or a UNIX/Linux workstation:

- The displayed list contains the Hold Print jobs which have been registered by the selected user.
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 Printing Hold Print jobs
Follow the procedure below to process your Hold Print jobs from the control panel.

1 On the Hold Print job list ( P.198), select a job for printing. You can select more than 
one job.

 If the target job is not displayed on the screen, use  and  to change between pages.
 If you want to select all the jobs displayed on the screen, press [SELECT ALL]. To cancel the selection, press 

[ALL CLEAR].

2 Press [PRINT].

The equipment starts printing.
The job in progress can be monitored on the [JOBS] tab listing the Normal Print jobs ( P.186).

The printed job will be deleted from the Hold Print job list.
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Deleting Hold Print jobs
Follow the procedure below to delete a Hold Print job.

1 On the Hold Print job list ( P.198), select the job that you want to delete, and then 
press [DELETE]. You can select more than one job.

 If the target job is not displayed on the screen, use  and  to change between pages.
 If you want to select all the jobs displayed on the screen, press [SELECT ALL]. To cancel the selection, press 

[ALL CLEAR].

2 When “Delete OK?” appears, press [DELETE].

The selected job is deleted.
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 Invalid jobs
An Invalid job refers to a job being held due to an incorrect or no department code being entered for performing the job. If 
the equipment is managed by the Department Management feature with the SNMP network services disabled, entering an 
incorrect department code for printing from a computer on the network causes the job to be held as an invalid job and 
stored in the Invalid job queue. To release the job from the queue, enter the correct department code on the [JOBS] tab 
listing the Invalid jobs.

A print job whose number of copies to print exceeds the limit specified for a particular department code cannot be 
printed out. In this case, ask the administrator for help.

Displaying the Invalid job list
Follow the procedure below to display the list of Invalid jobs.

Displaying the Invalid job list

2 Enter the correct department code with the on-screen keyboard and digital keys, and 
then press [OK].

1 On the control panel, press the [PRINT] button.
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3 Select [INVALID].

The Invalid jobs are listed on the screen.

 Printing Invalid jobs
If you have entered an incorrect department code for printing, you need to re-enter the correct one. Follow the procedure 
below.

1 On the Invalid job list ( P.202), select the job for printing.

If the target job is not displayed on the screen, use  and  to change between pages.
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2 Press [PRINT].

Printing starts.
The job in progress can be monitored from the [JOBS] tab listing the Normal Print jobs ( P.186).

Deleting Invalid jobs
Follow the procedure below to delete an Invalid job.

1 On the Invalid job list ( P.202), select the job that you want to delete, and then press 
[DELETE].

If the target job is not displayed on the screen, use  and  to change between pages.

2 When “Delete OK?” appears, press [DELETE].

The selected job is deleted.
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 Printing files from USB media (USB Direct Printing)
USB Direct Printing refers to the printing of files saved in a USB storage device that is connected to the USB port on the 
equipment. With this feature, you can print PDF, encrypted PDF (file extension: “.pdf”), XPS (file extension: “.xps”), JPEG 
(file extension: “.jpg” or “.jpeg”), PRN (file extension: “.prn”), and PS (file extension: “.ps”) files.

 USB Direct Printing requires the USB Direct Print setting to be enabled on TopAccess. For details, refer to the 
TopAccess Guide.

 You cannot specify which page(s) of the selected file to print. All pages are to be printed.
 USB Direct Printing supports the printing of PDF files whose versions are from 1.3 to 1.7.
 With this feature, the equipment can print encrypted PDF files whose encryption level is either “40-bit RC4” or “128-

bit RC4.”
 The feature does not support encrypted PDF files whose encryption level is [128bit AES], and some files of other 

encryption levels may not be printable as well. In these cases, print these files from a client computer.
 For printing the PRN files, the page description languages supported by USB Direct Printing are PostScript 3, 

PCL5e, PCL5c, PCL6 and XPS.
 Do not turn on the equipment when a USB storage device is connected to the port.
 The USB storage device should meet the following requirements:

- FAT16 and FAT32 formats
- Single-partition (USB media with multiple partitions are not supported.)

However, some of the devices may not be used in this equipment, even though these requirements have been met.

1 Connect your USB storage device to the USB port on 
the equipment.
In a few seconds, “Found USB DEVICE” appears at the lower left of 
the screen.

Do not disconnect the USB storage device when “USB DEVICE in 
use Do not remove USB DEVICE” is displayed on the screen. 
Removing the device while the message is displayed could destroy 
the data in the device or cause a malfunction of the equipment.

2 On the control panel, press the [PRINT] button.
 If the equipment is not managed by department codes, proceed to 

Step 4.
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3 Enter the department code using the on-screen keyboard and digital keys, and then 
press [OK].

The above screen will not be displayed when the equipment is not managed by department codes. Proceed to 
the next step.

4 Select [USB].

Do not disconnect the USB storage device when “USB DEVICE in use Do not remove USB DEVICE” is 
displayed on the screen. Removing the device while the message is displayed could destroy the data in the 
device or cause a malfunction of the equipment.
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5 In the list of files, select the file that you want to print. Select the files you want to print 
from the list.

 If the target file is not displayed on the screen, use  and  to change between pages.
 To select a file contained in a folder, select the folder and press [OPEN]. In the list of files that appears, select 

the desired file to print.
 If you select an encrypted PDF file for which a password has been set, the password entry screen is displayed. 

Proceed to Step 6.
 If you change the paper size, stapling position, 2-Sided Printing setting or PDF Overprint setting, proceed to 

Step 9. If you start printing without changing any of them, proceed to Step 10.

Do not disconnect the USB storage device when “USB DEVICE in use Do not remove USB DEVICE” is 
displayed on the screen. Removing the device while the message is displayed could destroy the data in the 
device or cause a malfunction of the equipment.

6 If you select an encrypted PDF file for which a password has been set, press 
[PASSWORD].
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7 Using the on-screen keyboard and the digital keys, enter the user or master password 
for the encrypted PDF file, and then press [OK].

 If the selected encrypted PDF file was created on Adobe Acrobat 6.0 or later, enter the document open 
password or permissions password.

 To print an encrypted PDF file for which “Low Resolution (150 dpi)” is set on Adobe Acrobat, you must enter 
the permissions password that was set for the file when it was created.

8 Press [OK].

 If you change the paper size, stapling position, 2-Sided Printing setting or PDF Overprint setting, proceed to 
Step 9. If you start printing without changing any of them, proceed to Step 10.
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9 Press [SETTINGS] and then select the setting items as required.

 To print a JPEG file, you can set [SIZE].
 To print a PDF file, you can set [FINISHING], [2-SIDED] and [PDF Overprint].

1) Press any of [SIZE], [FINISHING], [2-SIDED] and [PDF Overprint].
2) Select the desired item.
3) Press [OK] when you finish the setting.

 SIZE
Set the paper size.

 FINISHING
Set the position of stapling.

NON-STAPLE — Select this not to staple.
UPPER LEFT — Select this to staple at the upper left corner.
UPPER RIGHT — Select this to staple at the upper right corner.
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 2-SIDED
Set 2-Sided Printing.

1 SIDE — Select this to print only one side.
BOOK — Select this to print on both sides by setting a vertical binding margin. Pages are turned over from right to 
left.
TABLET — Select this to print on both sides by setting a horizontal binding margin. Pages are turned over from 
bottom to top.

 PDF Overprint
If a PDF file contains an overprint, this is also overprinted on a print job when this option is enabled.

OFF — Select this not to overprint the job.
ON — Select this to enable overprint the job.
ON (PDF/X ONLY) — Select this to enable overprint the job only when the original PDF file is complied with PDF/X 
specifications.

 The paper size can be set only when you print a JPEG file. (If you print more than one JPEG file 
continuously, the paper size you set for the first file in this step is applied to the second and the following.)

 The PDF Overprint setting is applied only to objects overprinted in the original PDF file. If you want to 
preview the effect of overprint in the PDF file, you can do it with the Overprint Preview mode of Adobe 
Reader by switching the preview screen.



5.MANAGING PRINT JOBS FROM THE CONTROL PANEL

Monitoring the Print Job Status    211

5 MANAGING PRINT JOBS FROM THE CONTROL PANEL

10 Press [PRINT].

 The equipment starts printing. The printouts are directed to the receiving tray.
 The job in progress can be monitored from the [JOBS] tab listing the Normal Print jobs.

Before Disconnecting the USB Storage Device:
Make sure that “USB DEVICE in use. Do not remove USB DEVICE.” is not displayed on the touch panel. If it is, do 
not disconnect the USB storage device; removing the device while the message is displayed could destroy the data 
in the device or cause a malfunction of the equipment.
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Viewing the Print Job Log

You can view the log of print jobs on the touch panel.

Viewing the print job log

1 On the touch panel, press [JOB STATUS].

2 Press [LOG] to display the [LOG] tab.
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3 Press [PRINT].

The Print Log is displayed.

On the Print Log, each job’s user name, date and time of the job, paper size, the number of pages and the number 
of copies are displayed.

Up to 120 jobs can be listed on the log. To display the previous or next page, press  or . The number of jobs 
displayed on a page may vary depending on the equipment used.

To exit from the Print Log screen, press [CLOSE].

If the equipment encounters an error while printing, it records and displays an error code in the User Name 
column. For details on print job errors and error codes, refer to the Troubleshooting Guide.
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Checking Supplies

 Viewing the drawer status
When the equipment is idle, pressing [JOB STATUS] > [SUPPLY] displays the [SUPPLY] tab. From this tab, you can view 
the paper size setting selected for each drawer. If you press [SUPPLY] when printing is in progress, the drawer from which 
paper is being fed is highlighted.

If you try to print a document from a client computer and specify a paper size while none of the drawers or bypass tray on 
the equipment has the specified size of paper, a printing error occurs, and [JOB STATUS] blinks. In this case, pressing 
[JOB STATUS] displays the [SUPPLY] tab, from which you can learn which drawer needs additional sheets of paper. For 
further instructions on how to clear a printing error, refer to the Troubleshooting Guide.

Checking remaining toner levels
Pressing [JOB STATUS] > [TONER] displays the [TONER] tab from which you can check the approximate amount of toner 
remaining in the toner cartridges.

If any of the toner cartridges is running out, be sure to get a new cartridge ready. For more information about replacing 
toner cartridges, refer to the Quick Start Guide or the Troubleshooting Guide.
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FTP Printing

FTP printing is available when the FTP print service is enabled on this equipment.
You can print a document by sending the print file to this equipment using the FTP. This equipment can accept the 
following files for printing:
 PCL file
 PS file
 Text file

When the User Management setting is enabled, a print job sent in FTP printing is processed as an invalid job 
according to the User Authentication Enforcement setting. For more information about the User Authentication 
Enforcement setting, refer to the TopAccess Guide.

 In Windows, you can create the PCL file and PS file using the printer driver. To create the PCL file or PS file, 
change the printer port of the printer driver to “FILE:” port and print a document using the printer driver. For more 
information about printing to a file, refer to the Windows documentation.

 In Macintosh, you can create the PS file using the printer driver. To create the PS file, select “File” at the 
[Destination] box in the Print dialog box to print. For more information about printing to a file, refer to the Macintosh 
documentation.

Printing a file using the FTP command

The procedure below describes the example of printing using the FTP command with the MS-DOS Prompt.

1 Launch the MS-DOS Prompt.

2 Change the current directory to that in which the print file is located.

3 Type following command and press the [Enter] key:
ftp <IP Address>

In the <IP Address> section, enter the IP address of this equipment.

4 If it prompts you to enter the user name, enter the FTP Print User Name and press the 
[Enter] key.

It prompts you to enter the user name if the FTP Print User Name is assigned by an administrator. Ask your 
administrator for the FTP Print User Name.

5 If it prompts you to enter the password, enter the FTP Print Password and press the 
[Enter] key.

 It prompts you to enter the password if the FTP Print User Name is assigned by an administrator. Ask your 
administrator for the FTP Print Password.

 If the FTP Print User Name has been assigned but the FTP Print Password is blank, do not enter when it 
prompts you to enter the password and press the [Enter] key.

6 Type the following command and press the [Enter] key:
put <file name>

For example, if the print file name is “sample.ps”:
put sample.ps

7 The file is sent to this equipment and spooled in the queue.
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Email Printing

Email printing is available when enabled on this equipment.
You can print a document by sending the print file, as an email attachment, to this equipment using the mail client 
software. This equipment can accept only TIFF-FX (Profile S), TIFF-FX (Profile F) and TIFF-FX (Profile J) files for printing:

 When the User Management setting is enabled, a print job sent by Email is processed as an invalid job according 
to the User Authentication Enforcement setting. For more information about the User Authentication Enforcement 
setting, refer to the TopAccess Guide.

 An Email print job has two printing types, Discard Printing and RX Reduction Printing, that can be set by pressing 
the [RX PRINT] button in [FAX] of the ADMIN menu on the control panel.
When Discard Printing is ON, the part of the print image that exceeds the paper printing area is discarded if the 
print image is up to 10 mm larger than the printing area. If the print image is 10 mm larger or more than the printing 
area, the print image is printed on the largest sheet of paper.
When Discard Printing is OFF, the print image is printed on the largest sheet of paper if its length exceeds the 
paper printing area.
When RX Reduction Printing is ON, it will be vertically reduced to fit on the paper if the print image is longer than 
the paper. When the print image cannot fit in the paper even if the print image is reduced, the print image is printed 
on the largest sheet of paper.
When RX Reduction Printing is OFF, the print image is printed on the largest sheet of paper if its length exceeds 
the paper printing area.

Printing a file using the email client

The procedure below gives an example of printing using Microsoft Outlook Express.

When you send an email message to this equipment to print a file, send it in plain text format. If you send an email 
message in HTML format, this equipment prints the HTML source code of the message.

1 Open your email application and create a new mail message.

2 Enter the email address of the equipment in the To: line.

3 Enter text in the Subject line or leave the Subject line blank.

4 Enter text in the body field.

5 Attach the file you want to print.

6 Send the email.

The header and body of the email will be printed only when the “Print Header” and “Print Message Body” for the 
Email print service are enabled on this equipment.
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Internal Fonts List

The following fonts are included in this equipment.

 Internal PCL fonts list

*1 These fonts can be added when the optional Unicode Font Enabler is installed.

0 Courier 42 Helvetica-Narrow-Bold

1 CG-Times 43 Helvetica-Narrow-Oblique

2 CG-Times Bold 44 Helvetica-Narrow-BoldOblique

3 CG-Times Italic 45 Palatino-Roman

4 CG-Times Bold Italic 46 Palatino-Bold

5 CG Omega 47 Palatino-Italic

6 CG Omega Bold 48 Palatino-BoldItalic

7 CG Omega Italic 49 ITC AvantGarde-Book

8 CG Omega Bold Italic 50 ITC AvantGarde-BookOblique

9 Coronet 51 ITC AvantGarde-Demi

10 Clarendon Condensed 52 ITC AvantGarde-DemiOblique

11 Univers Medium 53 ITC Bookman-Light

12 Univers Bold 54 ITC Bookman-LightItalic

13 Univers Italic 55 ITC Bookman-Demi

14 Univers Bold Italic 56 ITC Bookman-DemiItalic

15 Univers Medium Condensed 57 NewCenturySchlbk-Roman

16 Univers Condensed Bold 58 NewCenturySchlbk-Bold

17 Univers Medium Condensed Italic 59 NewCenturySchlbk-Italic

18 Univers Condensed Bold Italic 60 NewCenturySchlbk-BoldItalic

19 Antique Olive 61 Times-Roman

20 Antique Olive Bold 62 Times-Bold

21 Antique Olive Italic 63 Times-Italic

22 Garamond Antiqua 64 Times-BoldItalic

23 Garamond Halbfett 65 ITCZapfChancery-MediumItalic

24 Garamond Kursiv 66 Symbol

25 Garamond Kursiv Halbfett 67 Symbol PS

26 Mrigold 68 Wingdings

27 Albertus Medium 69 ITCZapfDingbats

28 Albertus Extra Bold 70 Courier Bold

29 Arial 71 Courier Italic

30 Arial Bold 72 Courier Bold Italic

31 Arial Italic 73 Letter Gothic Regular

32 Arial Bold Italic 74 Letter Gothic Bold

33 Times New Roman 75 Letter Gothic Italic

34 Times New Roman Bold 76 CourierPS

35 Times New Roman Italic 77 CourierPS Oblique

36 Times New Roman Bold Italic 78 CourierPS Bold

37 Helvetica 79 CourierPS BoldOblique

38 Helvetica-Bold 80 AndaleMonoWTJ *1

39 Helvetica-Oblique 81 AndaleMonoWTK *1

40 Helvetica-BoldOblique 82 AndaleMonoWTT *1

41 Helvetica-Narrow 83 AndaleMonoWTS *1
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 Internal PS fonts list

AlbertusMT-Light Eurostile-ExtendedTwo

AlbertusMT Eurostile-BoldExtendedTwo

AlbertusMT-Italic Geneva

AntiqueOlive-Roman GillSans-Light

AntiqueOlive-Italic GillSans-LightItalic

AntiqueOlive-Bold GillSans

AntiqueOlive-Compact GillSans-Italic

Apple-Chancery GillSans-Bold

ArialMT GillSans-BoldItalic

Arial-ItalicMT GillSans-ExtraBold

Arial-BoldMT GillSans-BoldCondensed

Arial-BoldItalicMT GillSans-Condensed

AvantGarde-Book Goudy

AvantGarde-BookOblique Goudy-Italic

AvantGarde-Demi Goudy-Bold

AvantGarde-DemiOblique Goudy-BoldItalic

Bodoni Goudy-ExtraBold

Bodoni-Italic Helvetica

Bodoni-Bold Helvetica-Oblique

Bodoni-BoldItalic Helvetica-Bold

Bodoni-Poster Helvetica-BoldOblique

Bodoni-PosterCompressed Helvetica-Condensed

Bookman-Light Helvetica-Condensed-Oblique

Bookman-LightItalic Helvetica-Condensed-Bold

Bookman-Demi Helvetica-Condensed-BoldObl

Bookman-DemiItalic Helvetica-Narrow

Candid Helvetica-Narrow-Oblique

Chicago Helvetica-Narrow-Bold

Clarendon-Light Helvetica-Narrow-BoldOblique

Clarendon HoeflerText-Regular

Clarendon-Bold HoeflerText-Italic

CooperBlack HoeflerText-Black

CooperBlack-Italic HoeflerText-BlackItalic

Copperplate-ThirtyTwoBC HoeflerText-Ornaments

Copperplate-ThirtyThreeBC JoannaMT

Coronet-Regular JoannaMT-Italic

Courier JoannaMT-Bold

Courier-Oblique JoannaMT-BoldItalic

Courier-Bold LetterGothic

Courier-BoldOblique LetterGothic-Slanted

Eurostile LetterGothic-Bold

Eurostile-Bold LetterGothic-BoldSlanted

LubalinGraph-Book Univers-CondensedBold

LubalinGraph-BookOblique Univers-CondensedBoldOblique

LubalinGraph-Demi Univers-Extended

LubalinGraph-DemiOblique Univers-ExtendedObl

Marigold Univers-BoldExt

Monaco Univers-BoldExtObl

MonaLisa-Recut Wingdings-Regular

NewCenturySchlbk-Roman ZapfChancery-MediumItalic
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NewCenturySchlbk-Italic ZapfDingbats

NewCenturySchlbk-Bold IPAexGothic

NewCenturySchlbk-BoldItalic IPAexMincho

NewYork

Optima

Optima-Italic

Optima-Bold

Optima-BoldItalic

Oxford

Palatino-Roman

Palatino-Italic

Palatino-Bold

Palatino-BoldItalic

StempelGaramond-Roman

StempelGaramond-Italic

StempelGaramond-Bold

StempelGaramond-BoldItalic

Symbol

Taffy

Times-Roman

Times-Italic

Times-Bold

Times-BoldItalic

TimesNewRomanPSMT

TimesNewRomanPS-ItalicMT

TimesNewRomanPS-BoldMT

TimesNewRomanPS-BoldItalicMT

Univers-Light

Univers-LightOblique

Univers

Univers-Oblique

Univers-Bold

Univers-BoldOblique

Univers-Condensed

Univers-CondensedOblique
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